Limcon V3
User Manual
Engineering Systems
COPYRIGHT NOTICE
(C) Copyright Engineering Systems Pty Limited 1992-2012. All rights are reserved. The copyright applies to this manual and to the corresponding software (together referred to herein as the “licensed material”).

DISCLAIMER
Subject to limitations imposed by law, Engineering Systems makes no warranty of any kind in connection with the licensed material. Neither Engineering Systems nor its agents shall be liable for any errors contained in the licensed material nor for any incidental or consequential damages resulting from the furnishing or use of the licensed material. Engineering Systems and its agents are not engaging in the provision of consulting services in supplying or supporting the licensed material. Users of the licensed material are advised that output from computer software should be subjected to independent checks. Engineering Systems reserves the right to revise and otherwise change the licensed material from time to time without notification or provision of revised material.

SOFTWARE LICENCE
The software is supplied to the user under licence. It may be installed on as many computers as required but the number of concurrent users must not exceed the number of licences held. For network licences, use is permitted only in the country for which the licence was supplied. The software may not be sub-licensed, rented, or leased to another party. The licence can only be transferred to another party on payment of a transfer charge determined by Engineering Systems.

Engineering Systems Pty Ltd
14 Eastern Road
PO Box 85
Turramurra NSW 2074
Australia

Tel: (02) 9488 9622
Fax: (02) 9488 7883
E-mail: support@steel-connections.com
Web: www.steel-connections.com

June, 2012
Preface

Limcon first appeared in 1992 as a DOS program, companion to the Australian Steel Institute (ASI) publication *Design of Structural Connections – 4th Edition*. This was the principal reference for design of steel connections to the new limit states code for steel design, AS 4100-1990. Major enhancements were introduced in 2001 with Limcon V2. The conversion for Windows transformed the user interface and there were many additions, including virtual reality views of connections and integrated detailing with DXF output. Hollow section and other connections were added in Limcon V3 in 2003, together with support for the US, Canadian, and British codes.

Limcon V3.5 included support for the ANSI/AISC 360-05 design specification, which unifies the LRFD and ASD design methods. Although it has been integrated with the ProSteel CAD system ([www.strucsoftsolutions.com](http://www.strucsoftsolutions.com)) for some time, V3.5 is the first version of Limcon capable of integration with structural analysis programs, such as Microstran ([www.microstran.com.au](http://www.microstran.com.au)). This is possible by virtue of support for multiple load cases in many connections. Other additions in Limcon V3.5 were the implementation of the moment base plate according to the AISC publication, *Design Guide 1: Base Plate and Anchor Rod Design, Second Edition* and seismic design capability for some moment connections.

In 2008 the ASI began publishing its revised *Connections Series*, comprising design guides and design capacity tables. Limcon V3.55 incorporates the ASI 2008 models, many of which are closely related to AISC models detailed in the *Steel Construction Manual – 13th Edition* and AISC Design Guides. There are some additions to the ASI design models, including axial force in shear connections – see Chapter 4 for details. Support for Eurocode 3, BS EN 1993 : 2005 was added in 2009. Limcon does not implement the component method design models in EC3 but does apply EC3 rules to the existing AISC/ASI models.

Limcon V3.6 includes updates for ANSI/AISC 360-10 and CSA S16-09.

If the file Readme.txt is present in the Limcon folder after installation, you should read it for information that became available after this manual was printed. The file is automatically displayed during installation but it may be displayed in Notepad at any time by double-clicking the file in Windows Explorer.

The first version of Limcon fully compatible with this manual is V3.60.
# Contents

**Preface**                                                                                                                                                   iii

**1: Introduction**                                                                                                                                                        1

- Connection Types                                                                                                                                             1
  - Simple (Shear) Connections                                                                                                                                    1
  - Moment Connections                                                                                                                                            2
  - Splices                                                                                                                                                        3
  - Base Plates                                                                                                                                                   4
  - Bracing Connections                                                                                                                                          4
  - Hollow Structural Section (HSS) Connections                                                                                                                  5
  - Miscellaneous Connections                                                                                                                                     6
- Design Code                                                                                                                                                       6
- The Limcon Window                                                                                                                                                 7
- Connection Dialog Boxes                                                                                                                                          8
- Virtual Reality (VR) Viewer                                                                                                                                       10
- Listing All Connections in a Job                                                                                                                                    12
- Section Properties                                                                                                                                              13
- Steel Grades                                                                                                                                                     13
- Computer Requirements                                                                                                                                            14

**2: Getting Started**                                                                                                                                         15

- Installing Limcon                                                                                                                                               15
- Hardware Lock                                                                                                                                                   16
- Starting Limcon                                                                                                                                                 16
- Font                                                                                                                                                             16
- How to Make a Shortcut on the Desktop                                                                             17
- Launch with Double-Click                                                                                                                                       17
- Configuration                                                                                                                                                   17
- Limcon Commands                                                                                                                                                 21
- Units                                                                                                                                                            21
- Modifying the Steel Section Library                                                                                                                                 22
- Printing in Limcon                                                                                                                                               22
  - Print and Print Preview Commands                                                                                                                                22
  - Printing Reports and VR Images                                                                                                                                 22
  - The Page Setup Dialog Box                                                                                                                                        23
  - The Windows Print Dialog Box                                                                                                                                    23
- Configurable User Graphic on Reports                                                                                                                             24
3: Menus & Toolbars

File Menu ................................................................. 31
Edit Menu ................................................................. 32
View Menu ................................................................. 32
Job Menu ................................................................. 34
Connections Menu .................................................. 34
Connections List Menu ........................................... 35
Help Menu ............................................................... 35
Main Toolbar ............................................................ 36
Pop-Up Menu ........................................................... 37

4: Technical Notes

Default Data .......................................................... 39
Steel Grades ............................................................ 39
Bolts ........................................................................ 41
Bolt Bearing ............................................................ 42
Friction Bolts ............................................................ 43
Welds ....................................................................... 45
Multiple Load Cases ............................................... 47
LRFD and ASD ......................................................... 48
Minimum Design Actions ....................................... 50
Shear Connections ................................................... 52
Single Plate / Shear Tab / Fin Plate / Web Side Plate (WSP) Connection ........................................... 53
Rigid Connections .................................................... 54
Analysis Method ....................................................... 54
Web Fillet Welds ....................................................... 55
Section Bending/Axial Check .................................... 55
Bolted Splice (BSPL) .................................................. 56
ASI Bolted Moment End Plate Connection (BMEP, HBEP) ................................................................. 57
AISC Moment End Plate Connection (MEPC) ................................................................. 59
Column-Side Checks ............................................... 60
Column Web Doubler Plates ..................................... 61
Column Flange Doubler Plates .................................. 62
RHS Bolted Moment End Plate (TMEP) ..................... 62
Hollow Structural Section Chord/Column Face Yielding ................................................................. 64
Single Brace Connection (BRAC) ................................ 65
KT Gusset Plate Truss Connection (KGT) ..................... 69
Uniform Force Bracing Connection (UFBR) ................ 73
Hollow Structural Section (HSS) Truss Connections ................................................................. 76
Base Plate (BASE) ..................................................... 78
Bolt Group (BGP) ...................................................... 79
Weld Group (WGP) .................................................... 80
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower and Upper Bound Theorems</td>
<td>81</td>
</tr>
<tr>
<td>The Lower Bound Theorem</td>
<td>81</td>
</tr>
<tr>
<td>The Upper Bound Theorem</td>
<td>81</td>
</tr>
<tr>
<td>Seismic Checks</td>
<td>82</td>
</tr>
<tr>
<td>Additional Checks</td>
<td>83</td>
</tr>
<tr>
<td>Output References</td>
<td>84</td>
</tr>
<tr>
<td>References</td>
<td>85</td>
</tr>
</tbody>
</table>

### 5: DXF Output

- General | 89
- The Header DXF | 89
- DXF Setup | 90

### 6: Editing the Section Library

- General | 91
- Section Library | 91
- Section Library Manager | 94
- Compiling a Library | 96

### 7: Examples

- Web Side Plate / Single Plate / Fin Plate Connection | 97
- Flexible End Plate Connection | 101
- Bolted Flange Plate Connection | 105
- Bolted Moment End Plate Connection | 109
- Multiple Row Flush End Plate Moment Connection | 113
- 4-Bolt RHS Moment End Plate Connection | 117
- 8-Bolt RHS Moment End Plate Connection | 120
- Bolted Splice | 123
- Bracing Cleat | 127
- Pinned Base Plate | 130
- Moment Base Plate | 133
- HSS Cap Plate Connection | 136
- HSS Mitred Knee | 138
- HSS Y or T Connection | 141
- HSS X Connection | 143
- HSS T or K Gap Connection | 145
- HSS T or K Overlap Connection | 148

### A: Appendix

- User-Defined Steel Grades | 151
- User-Defined Bolt Categories | 152

### Index

- 153
## 1: Introduction

### Connection Types

#### Simple (Shear) Connections

<table>
<thead>
<tr>
<th>Connection Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **WSP** | Web Side Plate  
Also known as fin plate, shear tab, or single plate connection.  
Extended plate available. |
<p>| <strong>FEP</strong> | Flexible End Plate |
| <strong>ACLT</strong> | Angle Cleat |
| <strong>BAS</strong> | Bolted Angle Seat |
| <strong>WAS</strong> | Welded Angle Seat |</p>
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Connection Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BPAD</td>
<td>Bearing Pad</td>
<td></td>
</tr>
<tr>
<td>WBC</td>
<td>Welded Beam/Column</td>
<td>Beam on one or both sides of column. With or without stiffeners or column web doubler plates.</td>
</tr>
<tr>
<td>BMEP A</td>
<td>Bolted Moment End Plate</td>
<td>Beam on one or both sides of column. With or without stiffeners, column web doubler plates, and column flange doubler plates.</td>
</tr>
<tr>
<td>BMEP B</td>
<td>Bolted Moment End Plate</td>
<td>Inclined beam on one or both sides of column. With or without stiffeners, column web doubler plates, and column flange doubler plates.</td>
</tr>
<tr>
<td>BMEP C</td>
<td>Bolted Moment End Plate</td>
<td>Matching mitred end plates, apex connection in rigid frame, or end plate splice.</td>
</tr>
<tr>
<td>HBEP</td>
<td>Haunched Beam End Plate</td>
<td>Rafter horizontal or inclined. Beam on one or both sides of column. With or without stiffeners, column web doubler plates, and column flange doubler plates.</td>
</tr>
<tr>
<td>MEPC F</td>
<td>Flush Moment End Plate</td>
<td>One or two rows of bolts inside tension flange. Available for restricted range of I sections. May be used as splice.</td>
</tr>
</tbody>
</table>
### Extended Moment End Plate
One, two, or three rows of bolts inside tension flange – stiffeners available with one and three interior rows. May be used as splice. Seismic checking available for 4E and 4ES connections.

### Welded Flange Plate
Shear tab welded or bolted. Seismic checking available for fully welded connection.

### Bolted Flange Plate
Fully bolted. Seismic checking available.

### Welded Splice
Allocation of bending moment between flanges and web determined by analysis method, either elastic, plastic, or simplified.

### Bolted Splice
Allocation of bending moment between flanges and web determined by analysis method, either simplified, elastic, or plastic.
# Base Plates

<table>
<thead>
<tr>
<th>Base Plate</th>
<th>Description</th>
</tr>
</thead>
</table>
| BASE M     | Moment Base Plate  
Moment connection for I section column. |

# Bracing Connections

<table>
<thead>
<tr>
<th>Bracing Connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BRAC Single Brace</td>
<td>20 types of bracing connection. Bracing member may be single or double angle, rod, flattened CHS, hollow section with cleat or tee plate, or rolled section.</td>
</tr>
<tr>
<td>KTG KT Gusset Plate</td>
<td>This is a compound bracing connection with two or three members connected to a gusset plate, which is welded to a beam, column, or truss chord. Each branch connection may be any one of the available single brace connection types. (Available only with maintenance.)</td>
</tr>
<tr>
<td>UFBR Uniform Force Bracing Connection</td>
<td>This is a compound bracing connection with one or two bracing members, each of which is connected to a gusset plate welded to a beam and bolted to a column. Each bracing connection may be any one of the available single brace connection types. (Available only with maintenance.)</td>
</tr>
</tbody>
</table>
## Hollow Structural Section (HSS) Connections

<table>
<thead>
<tr>
<th>TCAP</th>
<th>HSS Cap Plate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pinned connection. Design for tension.</td>
</tr>
<tr>
<td>KNEE</td>
<td>HSS Mitred Knee</td>
</tr>
<tr>
<td></td>
<td>For RHS or SHS with width of both members the same. With or without stiffening plate.</td>
</tr>
<tr>
<td>TYT</td>
<td>HSS Y/T</td>
</tr>
<tr>
<td></td>
<td>Chord may be RHS, SHS, CHS, or rolled section; brace may be RHS, SHS or CHS.</td>
</tr>
<tr>
<td>TX</td>
<td>HSS X</td>
</tr>
<tr>
<td></td>
<td>Chord may be RHS, SHS, CHS, or rolled section; brace may be RHS, SHS or CHS.</td>
</tr>
<tr>
<td>TKNG</td>
<td>HSS K/N Gap</td>
</tr>
<tr>
<td></td>
<td>Chord may be RHS, SHS, CHS, or rolled section; brace may be RHS, SHS or CHS.</td>
</tr>
<tr>
<td>TKNO</td>
<td>HSS K/N Overlap</td>
</tr>
<tr>
<td></td>
<td>Chord may be RHS, SHS, CHS, or rolled section; brace may be RHS, SHS or CHS.</td>
</tr>
<tr>
<td>TMEP 4</td>
<td>4-Bolt RHS Bolted Moment End Plate</td>
</tr>
<tr>
<td></td>
<td>For compact RHS or SHS only. This is a bending moment model – large axial forces are not permitted.</td>
</tr>
</tbody>
</table>
8-Bolt RHS Bolted Moment End Plate
For compact RHS or SHS only. This is a bending moment model – large axial forces are not permitted.

**Miscellaneous Connections**

<table>
<thead>
<tr>
<th><strong>SEAT</strong></th>
<th><strong>BGP</strong></th>
<th><strong>WGP</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Stiff Seat</td>
<td>Bolt Group</td>
<td>Weld Group</td>
</tr>
<tr>
<td>End or internal support. With or without seat plate. With or without stiffeners.</td>
<td>Rectangular array of bolts in gusset of specified grade and thickness. May be analysed by either elastic or instantaneous center method.</td>
<td>Many different configurations of fillet weld with in-plane and out of plane loading. Analysed by elastic method.</td>
</tr>
</tbody>
</table>

**Design Code**

Limcon is supplied configured for one of the following design codes:

- ANSI/AISC 360 (Ref. 1)
- CAN/CSA-S16 (Ref. 2)
- BS 5950-1:2000 (Ref. 3)
- BS EN 1993-1-8:2005 (Ref. 47)
- AS 4100-1998 (Ref. 4)
- NZS 3404:Part 1:1997 (Ref. 5)

Each connection design model is essentially defined by the cited references but the relevant provisions of the configured design code take precedence where any difference occurs.
The **File > Configure > General** command permits the country and the section library to be changed. The country determines which steel grades may be used for plate components and the section library determines availability of steel sections and their grades.

---

**The Limcon Window**

Right-clicking on a thumbnail displays a menu offering commands to show the connection at full size, edit, copy, delete, or print the connection.

![THE LIMCON WINDOW](image)

The Limcon window is a multi-cell view with the main menu and toolbar at the top. Each connection in the current job is shown in miniature as a thumbnail in a cell. A *data tip* appears when the cursor passes over a cell containing a connection. Double-clicking on a thumbnail displays a dialog box with the connection data.

The main menu is the principal command interface. Each main menu item gives access to a drop-down menu of commands. In general, each toolbar button corresponds to a menu item. See Chapter 3 – “Menus & Toolbars” for a description of the drop-down menus.

You may right-click on a thumbnail to show a pop-up menu offering commands relevant to the thumbnail connection – see “Pop-Up Menu” on p. 37. The Notes commands allows you to enter notes for the connection that are added to the data tip (above).
Connection Dialog Boxes

Double-clicking on a thumbnail or selecting a command on the Connections menu displays a dialog box for the selected connection.

The connection name is shown in the box at the top left of the connection dialog box. This name, which must be unique within a job, is limited to 20 characters and must not contain space or tab characters or any of the characters shown below:

/ * ? :

While the **Detail** option button is selected, the window on the left shows the current configuration of the connection as a dimensioned detail diagram. Selecting the **Key diagram** option button replaces the detail diagram with a key diagram showing parameters and the sign convention for applied loads. The small buttons at the top of the detail diagram allow you to change the scale and positioning of the diagram within the cell.

The parameters defining the connection are shown in boxes on the right and an adjacent **Edit** or “…” button permits editing of any of the enclosed parameters. The **output window** at the bottom of the dialog box displays the results of the most recent check operation.

For some connection types there may be **Size** and **Design** buttons. The **Size** button sets plate dimensions to roughly match the section size, while the **Design** button initiates an automatic operation in which any item shown in red may change in order to make the capacity of the connection adequate for the applied loads. For some connections the **Size** button is split – the main part of the button completely changes the connection elements to fit the sections, while the small part of the button resizes connection elements without changing any bolt details.
Clicking the View button displays a new window containing an OpenGL “virtual reality” view of the connection. The Print button prints a report containing a detail diagram and the current results, while the DXF button creates an AutoCAD format drawing exchange file containing a detail of the current connection.

The Expand button enlarges the output window, filling the entire dialog box, to show more of the results. Clicking the X button closes the expanded output window and returns to the dialog box.

The check operation, which is performed automatically, reports the capacity of the current connection configuration for all failure modes specified in the connection model. Where available, the design function uses an iterative method, automatically changing some connection parameters while seeking an optimum connection configuration for the design load. You may specify some connection parameters (e.g. bolt diameter) which are not changed during design. Parameters that may be modified by the design procedure cannot be specified and are displayed in red when design mode is selected.

Note: An exclamation mark shown on a connection detail indicates that the connection has failed at least one of the requirements of the design model. Check the connection output to see which condition has failed.
Clicking the View button in a connection dialog box displays a new window containing an OpenGL virtual reality view of the connection. This view provides a useful visual check of arrangement and clearances. It is not available on displays with less than 16-bit color. Initially, the connection is shown rotating in the window. You may drag the mouse to rotate the view (left button depressed) or pan it (right button depressed). Keyboard arrow keys also rotate the view. Zoom by pressing the PageUp / Page Down keys or scrolling the mouse wheel. Double-click any point on the connection to make it the new center of rotation.

**Colors Used**

Different colors are used for different components. These are usually:

- Light grey – main members.
- Red – plates.
- Blue – stiffeners.
- Yellow – cover plates, flange doubler plates, shear keys.
- Green – web doubler plates.
- Magenta – welds.
- Cyan – nuts and bolts.
- Dark grey – washers.
- Translucent green – support members.
- Translucent blue – attached plates.
See “Configuration” on p. 17 for important information about the OpenGL pixel format.

The OpenGL window has these menus:

**File Menu**
The File menu offers commands to save a .JPG image and to print the image. Keyboard shortcuts for these commands are “J” and “P”, respectively.

**View Menu**
On the View menu you may select various fixed views, including a plan and elevation.

**Modify Menu**
The Modify menu offers commands to size (“S”) or design (“D”) the connection. These commands have the same effect as clicking the Size and Design buttons, if available, in the connection dialog box. There are also commands to locate the gusset plate on the other side of the member (“B”) and to reverse the bolts (“R”). Reversing the bolts is only for display purposes – the bolt direction is not a stored connection property.

**Help Menu**
This menu gives help on colors used and keyboard and mouse commands and access to OpenGL information.
Listing All Connections in a Job

Select the View > List > All command to display all connections in the job in a tabular format. This command is also available on the pop-up menu that appears when you right-click on a connection thumbnail image. The right-most column shows the strength ratio or load factor for each connection. Values less than 1.0 indicate connections that are not satisfactory.

The View > List > Passed command shows only connections for which the strength ratio is 1.0 or greater while the View > List > Failed command displays only those for which the ratio is less than 1.0.

You may double-click on any line to display the corresponding connection dialog box.
Section Properties

Section properties are extracted from a library file containing standard steel sections. You can determine which library is used with the File > Configure > Section Library command.

CHOOSING A SECTION

A number of libraries are available for sections originating in countries including Australia, UK, US, Japan, and New Zealand. You may change any library or create a new one using Section Library Manager (see “Section Library Manager” on p. 94).

When you create a new connection default initial sections are used. The country configuration determines these default sections. For example, when configured for the US the default beam for the FEP connection is a W16X36. When configured for the UK it is a UB406X178X54 and when configured for Australia it is a 410UB53.7.

Steel Grades

Section Grades

The section library contains information about steel grades available for each section. When you choose a section you must also choose a steel grade from those available. If the grade required is not shown in the grade list box you can easily add it by editing the section library.

Plate Component Grades

Plates are available in certain grades depending on the country setting. For example, the usual plate grade in the US is A36, it is S275 in the UK, and in Australia it is 250 (AS/NZS 3678). For more detailed information on grades of plate components, see “Steel Grades” on p. 39.
Computer Requirements

Recommended

- Windows XP or later.
- 1024 x 768 resolution or higher.
- 32-bit color.
- Color printer.

Virtual Reality Graphics

The View button in Limcon connection dialog boxes displays an OpenGL virtual reality representation of the connection. Virtual reality is only available on displays with 65535 or more colors. To see the color capability of your display, go to the Settings page of Display Properties in the Windows Control Panel. The necessary minimum color depth is High Color (16 bit). Display adapter memory and screen resolution are the main factors affecting the color depth available. If your display has the necessary color depth and virtual reality graphics is still not available, you may need to set the OpenGL pixel format – see “Configuration” on p. 17.
2: Getting Started

Installing Limcon

The Setup program will install Limcon on your computer. You must have Administrator privileges to install Limcon.

Place the Limcon CD-ROM into your drive and the installation will start automatically. Setup will guide you through the installation process, prompting you as required.

A number of folders will be established under the specified Limcon folder. If you use the default name the folders as displayed in Windows Explorer will look like this:

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limcon</td>
<td>Limcon folder – you can choose this name during installation. The default is Limcon.</td>
</tr>
<tr>
<td>.....Data</td>
<td>Default data folder – you can open Limcon files in other folders if you wish.</td>
</tr>
<tr>
<td>.....Lib</td>
<td>Library files, design parameter files, and template files.</td>
</tr>
<tr>
<td>.....PDF</td>
<td>Adobe Acrobat PDFs.</td>
</tr>
<tr>
<td>.....Program</td>
<td>All Limcon program files and Help files.</td>
</tr>
</tbody>
</table>
Hardware Lock

Limcon is normally supplied with a hardware lock that must be attached to a USB port before you can start the program. Any drivers required for the hardware lock will be installed automatically when you install Limcon. Additional set-up procedures are required for systems with a network lock. These are described on data sheet supplied with the software.

Starting Limcon

The Setup program creates a Limcon icon on the Windows All Programs menu. Select Start > All Programs > Limcon to start Limcon.

Note the following help features, which make it easier for you to use Limcon:

- There are tooltips on all toolbar buttons. Move the mouse cursor over the button for a moment and a little pop-up window displays the function of the button.
- There is a prompt displayed on the left side of the status bar (at the bottom of the Limcon window) whenever the cursor is positioned over a toolbar button or a menu item.
- Context-sensitive (pop-up) help is available in most dialog boxes. Some items in dialog boxes also have tooltips.

Use the Help > Limcon Help Topics command to display the Help Topics dialog box. With this, you can browse the table of contents, look through an index, or search all help topic keywords.

Font

Limcon requires the font MS LineDraw. During installation this font is installed automatically using the file Linedraw.ttf on the distribution CD. When setting up Limcon on a workstation without installing from the CD you must ensure that MS LineDraw is installed.

If unusual characters are seen in Print Preview it could mean that MS LineDraw is not properly installed or the system has not been rebooted after installation of the font.
How to Make a Shortcut on the Desktop

To make a shortcut to Limcon on your desktop (the background that is visible when no programs are running), right-click on the desktop, select New > Shortcut, and in the Create Shortcut dialog box browse to the Lmc3.exe file in the Limcon \Program folder. Set the “Start in” folder to the data folder. Enter Limcon for the name of the shortcut, and click the Finish button. Alternatively, drag the Limcon icon from the Start menu to the desktop with the mouse while pressing the Ctrl key.

Launch with Double-Click

Limcon job files (Job.lmc, where “Job” is the job name) should be identified in Explorer with the Limcon icon. It is convenient to be able to double-click on one of these files in Explorer to start Limcon with the job. To do this, the LMC file type must be associated with Limcon. The association between Limcon and the LMC file type may be established when Limcon is installed. You may also establish the association with the procedure set out below.

These are the steps necessary to make Limcon launch with a double-click:

• In Explorer select the View > Folder Options or View > Options command.
• Select the File Types tab.
• In the list box search for the Limcon job file type, which may be shown as “LMC File” or “Limcon Job File”. If found, select this file type and click the Remove button. Close the dialog box.
• In Explorer browse to the Limcon data folder and double-click on any Limcon job file (if the file name extension “lmc” is not visible you may see it by right-clicking and displaying the properties of the file).
• The Open With dialog box appears. Click on the Other button and browse to the Limcon \Program folder and select Lmc3.exe.
• In the Description box type “Limcon Job File” and click OK.
Now, check that you have successfully set up your system by browsing to a Limcon job file and double-clicking.

Configuration

The File > Configure command allows you to set the default library file, edit library files, set text size, and set OpenGL parameters. Configuration settings are saved from run to run, for each user.
Configuration settings are saved in the Windows registry under the HKEY_CURRENT_USER key. When you start a new job configuration settings remain as they were at the last run. You may reset configuration settings to their default values by running the LmcReset.exe in the Limcon \Program folder.

The File > Configure > General command displays the dialog box below. In this you may change settings that affect the way Limcon works.

**GENERAL CONFIGURATION**

Configuration items are:

**Country**
This determines plate grades, bolt diameters, bolt categories, and weld grades available. SI metric units are used unless the country setting is US and either the “kip-in” or “kip-ft” box is checked.

**Design code**
Rules for checking a connection are determined by this setting. When Limcon is supplied it is validated for design to one or more design codes. Only validated design codes are enabled. The connection design model may vary with the selected design code.

When AISC 360 is selected either LRFD or ASD may also be selected. With the “Back color” box checked the background of the connection view is lightly colored blue or green, respectively, for LRFD and ASD.

When CSA-S16 is selected the “+2mm” box may be checked to allow an additional 2mm for the diameter of bolt holes, as required by Cl. 12.3.2 when holes are not drilled.

With EC3 selected the associated button permits the input of gamma values, which may depend on the EC3 national annex in effect. Default values are those specified in the UK national annexes.
Section library file
The currently selected section library file.

Section library files
A list of all available section library files. See “Folders” for the location of the library folder.

Section analysis method
The method used for determining the distribution of forces between flanges and web in moment connections and splices. See “Rigid Connections” on p. 54.

Splice outer bolt row check
When the shear force in a bolted splice is large there may be a significant increase in bending moment from the center of the splice to the outer bolt row, where flange and plate net section checks are performed. Checking this box lets you take this into account automatically. See “Bolted Splice (BSPL)” on p. 56.

Bolt group analysis method
The method used for determining the in-plane strength of an eccentrically loaded bolt group. See “Bolt Group (BGP)” on p. 79.

Utilization %
With this item checked the report gives the percentage utilization (or demand/capacity ratio) for each limit state checked. Otherwise, the report shows a strength ratio, the reciprocal of the utilization ratio.

Plate yield/ultimate stress
With this item checked you will be able to specify yield and ultimate stresses for the plate material. This will be required when the necessary plate grade is not available in a pull-down list.

AS/NZS plate grades
Checking this item makes available plate grades additional to the normal Australian 250 and 300+ grades.

International
Checking this item allows you to choose any known international grade for sections and plates. Section grades can otherwise be chosen only from the grades nominated for each section in the library. This setting also allows you to choose any international bolting category.

Extra bolts
By checking this item you may include M22 and M27 bolts, which are not preferred sizes, and bolts larger than M36 in bolt size pull-down lists. Bolts larger than M36 may be required for base plates.

Auto check
With this box checked Limcon automatically attempts to check from the internet whether the main executable file is the latest available. This check occurs only on the first run for any day. With this box checked
Limcon may also attempt to check from the internet whether maintenance is current.

**Output detail level**

To facilitate checking of results Limcon can show additional output, which includes input parameters and intermediate results. You may select a level from 1 to 3 to determine how much additional output is shown for each connection. Level 0 indicates a normal output without any additional detail.

**Cell aspect ratio**

Limcon’s main view is sub-divided into multiple cells, each of which may contain a connection thumbnail image. You may change the aspect ratio of the cells using this item. The default value is 4:3 (landscape). Other values between 1:2 and 2:1 are available in the combo box.

**Screen graphics**

Windows screen graphics is based on GDI, the Graphics Device Interface. GDI+, released in Windows XP, is an optional enhancement that provides higher quality screen graphics than previously attainable.

**GDI+**

Check this box to use GDI+. This option may not work properly on older computers. The Delay control may be set if you experience problems with GDI+.

**Delay**

This control is only required if screen graphics does not work properly with GDI+. If screen images are incomplete select the minimum value that fixes the problem.

**OpenGL graphics**

OpenGL is the graphics system used in Windows for display of virtual reality (VR) images.

**Background color**

Background color may be black, sky blue, or white.

**OpenGL pixel format**

On computers supporting OpenGL there are 24 or more pixel formats, only some of which are suitable for Limcon’s virtual reality viewer. When the pixel format in the OpenGL Configuration dialog box is set to zero a suitable pixel format is chosen automatically. If your display has the necessary color depth and the virtual reality viewer does not work, you may need to set the pixel format. Contact Limcon support if you need help choosing an appropriate pixel format.

**WARNING:** Use of an inappropriate value may crash your system.

**Display member mark**

With this item checked Limcon virtual reality views show the mark and name of steel sections.
Initially maximized
With this item checked the OpenGL VR window fills the whole screen.

Output window
The text size for the output window in connection dialog boxes – normal size is 11 or 12. This does not affect the size of printed text, which is determined in Page Setup – see “The Page Setup Dialog Box” on p. 23.

Expand ht.
The initial height of the output window may be increased by selecting a non-zero value in this box.

Limcon Commands
Limcon commands are available from:
- The main menu.
- Toolbar buttons.
- The context menu.

All program commands are available on the main menu and commonly used commands are also available on toolbar buttons or the context menu for added convenience. Commands selected from the main menu are referred to as shown in this example:

File > Print Preview
Commands selected by clicking a toolbar button are referred to by the name of the button, as shown in the tooltip.

Units
Limcon can be configured to use SI metric units or US customary units (see “Configuration” on p. 17). The units used are:

<table>
<thead>
<tr>
<th>Item</th>
<th>SI Metric</th>
<th>US Customary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension</td>
<td>mm</td>
<td>in.</td>
</tr>
<tr>
<td>Force</td>
<td>kN</td>
<td>kip</td>
</tr>
<tr>
<td>Moment</td>
<td>kN.m</td>
<td>kip-in or kip-ft</td>
</tr>
<tr>
<td>Stress</td>
<td>MPa (N/mm²)</td>
<td>ksi</td>
</tr>
<tr>
<td>Force per unit length</td>
<td>kN/mm</td>
<td>kip/in</td>
</tr>
<tr>
<td>Angle</td>
<td>degree</td>
<td>degree</td>
</tr>
<tr>
<td>Rotation</td>
<td>radian</td>
<td>radian</td>
</tr>
</tbody>
</table>
When the country setting is US the lists of available bolt sizes and plate thicknesses will include US customary sizes, regardless of the units setting. Metric bolt sizes and plate thicknesses are only available for the US country setting when US customary units are not used.

The units used in section libraries are those customarily used in the country of origin. When using Section Library Manager to modify a library or make a new one, the library units are used.

---

**Modifying the Steel Section Library**

A source file is supplied with each steel section library. The source file is a text file with the file name extension “asc” and the corresponding library file has a file name extension of “lib” (e.g. Uk2000.asc, Uk2000.lib). Use the **File > Configure > Section Library Manager** command to modify a library. It is recommended that you do not modify the standard library supplied with Limcon – it is preferable to copy the library to a new one with a different name and then modify that.

See Chapter 6 for more information on Section Library Manager.

---

**Printing in Limcon**

**Print and Print Preview Commands**

Limcon has a Print command on the File menu (**File > Print**). This is for printing connection details – either multiple connections, or just one connection at a large scale.

The **File > Print Preview** command is for previewing the picture that would be printed by the **File > Print** command. The preview shows exactly what the printed page will look like* so you can check margins and page orientation without wasting paper.

* If the preview shows a logo but it is not printed, there may be a problem with the printer driver.

**Printing Reports and VR Images**

In addition to the Print command on the File menu there is also a Print button on each connection dialog box that is used for printing a report, including a diagram, for the current connection.

Each connection dialog box has a 3D View button, which displays a virtual reality image of the connection. This image may be printed using the Print Image command on the File menu at the top of the VR image.

Print previews are not available for connection reports or VR images.
The Page Setup Dialog Box

The Page Setup dialog box allows you to change settings affecting the layout of graphical output or reports.

The current printer, shown in the Page Setup dialog box, is initially the Windows default printer and remains so until a different printer is selected. A new current printer may be selected in the Windows Print Setup dialog box that is shown when you click the Change button. You may also change the current printer in the Windows Print dialog box, shown when you select the **File > Print** command from the main menu.

Text Size

The text size, in points, for reports. There are 72 points to the inch. The default value is 8.

Logo

Check this box if you want Limcon to print a logo at the top of each page of printed output. When the box is checked you may choose one of the available bitmap files from the adjacent combo box. See “Configurable User Graphic on Reports” on p. 24.

The Windows Print Dialog Box

The **File > Print** command displays the Windows Print dialog box so you can change the target printer, the number of copies, or printer settings with the Properties button. When you click OK in this dialog
box the selected printer becomes the current printer. Clicking the Print button on the main toolbar initiates a graphics print without the display of the Windows Print dialog box. The view is printed immediately to the current printer – notice that the tooltip for the Print button shows the name of the current printer.

The Print button in each connection dialog box also displays the Windows Print dialog box before printing.

Note: Clicking the Properties button displays the printer properties dialog box. The page orientation setting in this dialog box is ignored as Limcon uses the orientation setting from the Page Setup dialog box for reports and landscape for graphics.

The Preview command, File > Print Preview, and the Preview button do not display the Windows Print dialog box. The preview is always for the current printer. When you see a print preview on the screen there is a Print button at the top left of the preview window. Clicking this will initiate printing on the current printer. If you want to change the current printer after seeing a preview, close the preview window and then select the File > Print command.

Configurable User Graphic on Reports

You may use this feature to place your company logo at the top of all printed output.

Limcon allows you to have a small graphic at the top of each page of printed output. Any valid Windows bitmap file existing in the 'Program folder may be selected in the Page Setup dialog box. Select the logo option to print the graphic on each page. If the option is not selected no graphic will be printed and no space will be allowed for it. On installation Limcon is configured to use the graphic shown below. You can unselect the option in Page Setup if you do not want a graphic.
**Limcon V3.6**

**DEFAULT GRAPHIC**

The specification of the bitmap is:
- Width – 1200 pixels
- Height – 200 pixels
- Colors – 256

Limcon prints the graphic in a space 50.8 mm wide and 8.5 mm high.

**Note:** The Windows drivers for some printers do not support the printing of bitmaps. In such cases the logo may be shown in the print preview without actually printing.

---

**Help Features**

Note the following help features, which make it easier for you to use Limcon:

**Command Help**

There is a prompt displayed on the left side of the status bar (at the bottom of the Limcon window) whenever the cursor is positioned over a toolbar button or a menu item.

**Tooltips in Dialog Boxes**

Dialog boxes have tooltips, which appear when the mouse cursor passes over some dialog box controls.
Context-Sensitive (Pop-Up) Help

Context-sensitive Help gives quick access to information about dialog box items simply by clicking the question-mark button in the title bar and then clicking the item. Many dialog boxes in Limcon have context-sensitive help, a typical example of which is shown below.

The Windows component necessary for pop-up help, WinHlp32.exe, is not included in Windows Vista and Windows 7. It may be downloaded from the Microsoft website, see: http://support.microsoft.com/kb/917607

Policy defaults on a domain based network may block the use of .hlp files over a network. The administrator can modify domain policy to permit this if required.

On-Line (HTML) Help

Limcon’s on-line help allows you to browse help topics, look through an index, or do a full-text search for any word or phrase. The entire Limcon User Manual is available through on-line help.

Windows security prevents HTML help files (.chm files) being accessible over a network. This means that if the Limcon \Program folder is on the network rather than a local disk HTML help will only be available if the Limcon3.chm file is on a local disk.
Licensed Options

Limcon is usually supplied for only one design code and capability for more design codes is available at additional charge. Click the Licensed Options button in the Help About Limcon dialog box to display the design codes that may be selected. Codes for which “Yes” is displayed may be selected in the General Configuration dialog box.

NOTE: The ASI 2008 option is relevant for AS 4100 and NZS 3404 only. When either of these is the configured code, available new ASI models will be used only if the ASI 2008 option is “Yes”.

Data from Earlier Versions

Limcon V3 reads data files created by Limcon V2.
Web Update

You may use the web update facility in Limcon to determine when an update is required. While your computer is connected to the internet, clicking the Check Version button in the Help About dialog box displays the dialog box shown below. This displays the dates of your Limcon software and dates of the current web downloads so you can see whether an update is required.

You can connect to the Limcon website by clicking the Downloads hot link in the Help About dialog box. Here, you will find the components you need to download. Each is an executable file – run it to unpack the update files. Please submit the form on the web page to obtain the necessary passwords.

A new CD may be purchased as an alternative to using the internet download facility.

New versions or major upgrades may not be downloaded from the Limcon website but may be purchased on CD when available.
Maintenance & Technical Support

Technical support is available to licensed users with maintenance. When Limcon is supplied maintenance is included for an initial period, which may vary from 6 to 12 months depending on local arrangements. Maintenance may be renewed when the maintenance period expires. *Apart from ensuring the availability of technical support, current maintenance also allows continued availability of some advanced features, including the UFBR connection, and recent developments.*

Use the Help > About Limcon command to display the serial number, the exact version number and configuration of your software, and the maintenance expiry date. This information is required when you ask for technical support. In addition, the Help About dialog box contains hot-links directly to the Limcon website on the internet and to e-mail Support.

**NOTE:** With “Auto check” enabled in general configuration Limcon can obtain up to date information about your maintenance status.
3: Menus & Toolbars

File Menu

The File menu offers the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create a new job.</td>
</tr>
<tr>
<td>Open</td>
<td>Open an existing job.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the current job using the same file name.</td>
</tr>
<tr>
<td>Save As</td>
<td>Save the current job to a specified file name and changes the name of the current job accordingly.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the current view.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Display the view as it would appear printed.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Change the printing options.</td>
</tr>
<tr>
<td>List/Edit Text File</td>
<td>Opens the selected text file with the MsEdit text editor for viewing or editing.</td>
</tr>
<tr>
<td>Import Text File</td>
<td>Reads data into Limcon from a suitable text file.</td>
</tr>
<tr>
<td>Export Text File</td>
<td>Writes Limcon data to a text file for input to another program.</td>
</tr>
</tbody>
</table>
Configure
Recent File
Exit

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Connection</td>
<td>Edit a connection. Click on a connection to select it for editing.</td>
</tr>
<tr>
<td>Copy Connection</td>
<td>Copy a connection. Click on a connection to select it for copying to a new connection. The new connection name is derived from that of the source connection.</td>
</tr>
</tbody>
</table>

**View Menu**

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Connection</td>
<td>Edit a connection. Click on a connection to select it for editing.</td>
</tr>
<tr>
<td>Copy Connection</td>
<td>Copy a connection. Click on a connection to select it for copying to a new connection. The new connection name is derived from that of the source connection.</td>
</tr>
<tr>
<td>Command</td>
<td>Action</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Shows the toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Shows the status bar.</td>
</tr>
<tr>
<td>Show &gt; All</td>
<td>Shows all connections in the current job, up to the number of cells in the view. You may increase the number of cells displayed with the View &gt; Make Smaller command.</td>
</tr>
<tr>
<td>Show &gt; Passed</td>
<td>Shows only connections whose strength ratio is 1.0 or greater.</td>
</tr>
<tr>
<td>Show &gt; Failed</td>
<td>Shows only connections whose strength ratio is less than 1.0.</td>
</tr>
<tr>
<td>Show &gt; Full Size</td>
<td>Permits selection of a connection to be shown filling the view. Use the Show &gt; All command, the Back button, or Esc to restore the view to its previous state.</td>
</tr>
<tr>
<td>List &gt; All</td>
<td>Lists all connections in the current job in a table. Connections are listed alphabetically by name with connection type, member mark and section, and strength ratio.</td>
</tr>
<tr>
<td>List &gt; Passed</td>
<td>Lists only connections whose strength ratio is 1.0 or greater.</td>
</tr>
<tr>
<td>List &gt; Failed</td>
<td>Lists only connections whose strength ratio is less than 1.0.</td>
</tr>
<tr>
<td>Make Smaller</td>
<td>Redraws the current view with an additional column. This reduces the scale at which connection thumbnails are shown. The number of rows is determined automatically according to the size of the main window.</td>
</tr>
<tr>
<td>Make Larger</td>
<td>Redraws the current view with one less column. This enlarges the scale at which connection thumbnails are shown.</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>Redraws the current view moving each row of connections up one cell (the top row disappears).</td>
</tr>
<tr>
<td>Scroll Up</td>
<td>Redraws the current view moving each row of connections down one cell (the bottom row may disappear).</td>
</tr>
<tr>
<td>Increase Text Size</td>
<td>Increases size of text in all connection diagrams – may cause overplotting.</td>
</tr>
<tr>
<td>Decrease Text Size</td>
<td>Reduces size of text in all connection diagrams – reduces overplotting in complex diagrams.</td>
</tr>
<tr>
<td>Section Flood Fill</td>
<td>Where a cross-section is shown, draws the steel shape filled with yellow.</td>
</tr>
</tbody>
</table>
Job Menu

The Job menu allows input of the job description.

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Allows input of the job name. When Limcon starts from a shortcut the initial job name is “Unnamed”. Select this command to change the job name.</td>
</tr>
<tr>
<td>Title</td>
<td>Allows input of the job description shown on printed output.</td>
</tr>
</tbody>
</table>

Connections Menu

This menu is in the form of a window with an image button for each connection type. Some connections are available in certain sub-types that may be selected in the connection dialog box. For example, the Angle Cleat button selects an angle cleat connection that is bolted to the beam and the support but you may change this to a welded type in the next dialog box to appear.

The Simple Brace button selects a slotted HSS bracing connection but clicking the small button at the top right of this button displays another
dialog box, shown below, that contains image buttons for each of the available types of simple bracing connection.

Connections List Menu

The Connections List menu is a hierarchical menu of all available connection types. The top menu level allows you to choose a general connection type while the second and third levels offer further subdivision of connection type.

Help Menu
The Help menu offers the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Display the Help Topics dialog box. This has three tabs, Contents, Index, and Search, so you can easily find help topics.</td>
</tr>
<tr>
<td>About Limcon</td>
<td>Display details about this copy of Limcon and system resources. Also contains links to the internet.</td>
</tr>
</tbody>
</table>

**Main Toolbar**

The Main toolbar offers the following commands:

- Open a new job.
- Open an existing job. Limcon displays the Open dialog box, in which you can locate and open the desired file. This command is for opening an existing job (one previously saved from Limcon).
- Save the job.
- Print the view; i.e. print a picture showing all thumbnail cells currently displayed. Use the **Print** button in each connection dialog box to print a report.
- Print preview; i.e. display exactly how the graphics will be printed.
- Back. Click this button to go back to the view of all connections after showing a connection at full size. Pressing **Esc** has the same effect.
- Remove column. Connections will be shown at a larger scale.
- Add column. Connections will be shown at a smaller scale to accommodate an extra column.
- Scroll down one row.
- Scroll up one row.
- Make text larger. Increases size of text in all connection diagrams – may cause overplotting.
- Make text smaller. Reduces size of text in all connection diagrams – reduces overplotting in complex diagrams.
- Help Topics – on-line Help contains all information in the manual.
- Help About Limcon.
### Pop-Up Menu

The pop-up menu appears when you right-click a connection thumbnail. It offers these commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Full Size</td>
<td>Fills the main view with the right-clicked connection.</td>
</tr>
<tr>
<td>Show All</td>
<td>Reverts to view of multiple connection thumbnails after selection of Show Full Size command.</td>
</tr>
<tr>
<td>List All</td>
<td>Shows a list of all connections in the job. See “Listing All Connections in a Job” on p. 12.</td>
</tr>
<tr>
<td>Edit</td>
<td>Displays the right-clicked connection in a dialog box for editing. Double-clicking the connection has the same effect.</td>
</tr>
<tr>
<td>Cut</td>
<td>Removes the right-clicked connection from the view and places it on the clipboard for pasting.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the clipboard connection before the right-clicked connection.</td>
</tr>
<tr>
<td>Notes</td>
<td>Displays a dialog box for entering notes for the right-clicked connection.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the right-clicked connection.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints a full-page diagram of the right-clicked connection.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Dismisses the pop-up menu.</td>
</tr>
</tbody>
</table>
4: Technical Notes

Default Data

When you select a new connection in Limcon default values will appear for each parameter so that no additional data input is required to define a complete connection. In many cases the default data corresponds to worked examples in the reference documents. Default sections change with the country setting so that they may be found in the usual section library for the particular country. For example, the default beam section for the FEP connection is W16X36 for US, W410X54 for Canada, UB406X178X54 for UK, IPE400A for Europe, and 410UB53.7 for Australia and New Zealand. These sections are found in the library files Aisc.lib, Cisc.lib, Uk2000.lib, Euro.lib, Asw.lib, respectively.

Steel Grades

Limcon permits the input of the grade of steel sections and plate components. The yield stress and ultimate stress are automatically determined by Limcon according to the applicable standard.

Section Grades

The section library contains the names of steel grades available for each section. When you choose a section you must also choose a steel grade from those available. You may change grade availability by editing the section library but only recognized grades should be used.

When the grade names contained in the library are not suitable, you may select International in the General Configuration dialog box. This allows you to choose any known grade, whether its name is in the library or not.
Plate Component Grades

Limcon offers different grades for plates depending on the country configuration setting. These grades are shown in the table below. As an alternative to selecting one of these grades you may specify the yield and ultimate stresses for the plate material, provided this option is enabled in the General Configuration dialog box. You may select International in this dialog box to enable selection of other plate grades.

International

When International is selected in the General Configuration dialog box a wide range of section and plate grades are available. These include all the grades in the table below plus several others, including the Japanese grades to JIS G 3101 and JIS G 3106, and the Chinese grades Q235 and Q345.

<table>
<thead>
<tr>
<th>Item</th>
<th>US Grades*</th>
<th>Canadian Grades</th>
<th>UK/Eurocode Grades</th>
<th>Aust./NZ Grades†</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welded sections</td>
<td></td>
<td>260W, 300W, 350W</td>
<td></td>
<td>250, 300, 350, 400, 450, 300M</td>
</tr>
</tbody>
</table>

* US Plate Grades
Grades 42 and 50 may be used instead of particular ASTM grades. Gr.42, referred to in Limcon as “US42” has a yield stress of 42 ksi and an ultimate tensile stress of 60 ksi. Gr.50, referred to as “US50” has a yield stress of 50 ksi and an ultimate tensile stress of 65 ksi.

† AS/NZS Plate Grades
Grades 250, 300, and 350 are to AS/NZS 3678 while 250+, 300+, and 350+ are to AS/NZS 3679.1. Usually, only grades 250 and 300+ are available but you can enable the extra grades by selecting the AS/NZS plate grades option in the General Configuration dialog box.
Bolts

Bolt Diameter

Metric bolts ranging from M12 to M36 are available in the bolt diameter list box for all country settings. The “Extra bolts” configuration item is provided to include M22 and M27 bolts, which are not preferred sizes, and the larger bolts that may be required in base plates. When the country setting is US or Canada, US customary sizes ranging from ½” to 1 ½” are added to the list box after the metric sizes. With “Extra bolts” selected, bolt sizes larger than 1 ½” are added.

Bolt Categories

Bolt categories are specified by design codes. Those recognized by Limcon are shown in the following table.

<table>
<thead>
<tr>
<th>Type</th>
<th>US/Canada</th>
<th>UK</th>
<th>Eurocode</th>
<th>Aust./NZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snug-tightened</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A307</td>
<td>4.6</td>
<td>4.6A</td>
<td>4.6/S</td>
<td>8.8/S</td>
</tr>
<tr>
<td>A325ST</td>
<td>8.8</td>
<td>5.6A</td>
<td>8.8A</td>
<td>8.8A</td>
</tr>
<tr>
<td>A490ST</td>
<td>10.9</td>
<td>10.9A</td>
<td>10.9A</td>
<td></td>
</tr>
<tr>
<td>Tensioned</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A325PT</td>
<td>FG/B</td>
<td>8.8E</td>
<td>8.8E</td>
<td>8.8/EB</td>
</tr>
<tr>
<td>A490PT</td>
<td>FH/B</td>
<td>10.9E</td>
<td>10.9E</td>
<td></td>
</tr>
<tr>
<td>Friction</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A325SC</td>
<td>FG/NSS</td>
<td>8.8B</td>
<td>8.8B</td>
<td>8.8/TF</td>
</tr>
<tr>
<td>A490SC</td>
<td>FG/NSF†</td>
<td>8.8C†</td>
<td>8.8C†</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FH/NSS</td>
<td>10.9B</td>
<td>10.9B</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FH/NSF†</td>
<td>10.9C†</td>
<td>10.9C†</td>
<td></td>
</tr>
</tbody>
</table>

* F10T is a grade 10.9 friction bolt category to Japanese standard JIS B 1186.
† Non-slip at ultimate.

The country setting and connection type determine which bolt categories are available.

Friction (i.e. slip critical) bolts are not available for all connection types. They may be selected for the bolted splice (BSPL), bolted flange plate connection (FPC), and the most common shear connections (WSP, FEP, ACLT).
When the bolt diameter exceeds 1 ½” selected ASTM bolt categories are automatically displayed in output as follows:

- A307 → A36
- A325 → A449
- A490 → A354BD

**International**
When International is selected in the General Configuration dialog box all bolt categories are available.

**Threads In the Shear Plane**
Select N when threads are included in the shear plane or X if they are excluded.

**Bolt Bearing**
Bolt bearing capacity as defined by design codes is the lesser of the bearing and tearing strengths of the ply or part. Limcon shows the capacities for bolt bearing and tearing separately and the lower value governs.

**ANSI/AISC 360**
In ANSI/AISC 360 equation J3-6a applies when “deformation of the bolt hole at service load is a design consideration” and equation J3-6b applies otherwise. By default, Limcon uses the more conservative equation J3-6a. There is an option in General Configuration to use equation equation J3-6b instead. Cl. J3.10 allows bearing resistance to be calculated as the sum of the bearing resistances of the individual bolts. This provision is
implemented for concentrically loaded bolt groups, e.g. BRAC, FEP, FPC, and BSPL flange splices.

**BS 5950**

Ply bearing must be checked for bolts that are “non-slip in service” but Cl. 6.4.1 permits an increase of 50% in the bearing capacity permitted by Cl. 6.3.3.3. Thus, bearing capacity in many connections can be increased by specifying this type of friction bolt.

According to the same clause, bolts that are “non-slip under factored loads” do not have to be checked for bearing at all. This type of friction bolt is checked for bearing in Limcon with a 100% increase in the bearing capacity permitted by Cl. 6.3.3.3.

**EC3**

This code, like ANSI/AISC 360, allows bolt bearing resistance to be calculated as the sum of the bearing resistances of the individual bolts, but only if the bearing resistance exceeds the bolt shear resistance for every bolt in the group. This provision is implemented for concentrically loaded bolt groups, e.g. BRAC, FEP, FPC, and BSPL flange splices.

**AS 4100 and NZS 3404**

The rules in AS 4100 and NZS 3404 allow much greater bolt bearing capacity than do other steel design codes. In order to mobilize the stated capacity unacceptable deformations may occur (Ref. 32). As a result, bolt groups with a single row of bolts loaded in tension may be designed unconservatively using the rules of AS 4100 or NZS 3404. Bracing cleat connections could fall into this category and accordingly, when checking single row bolt groups subject to tension in this connection type, Limcon uses a bolt bearing capacity factor of 0.75 instead of 0.9.

---

**Friction Bolts**

Friction (i.e. slip critical) bolts are available for the bolt group (BGP), bolted splice (BSPL), bolted flange plate connection (FPC), and the most common shear connections (WSP, FEP, and ACLT). When friction bolts are selected for one of these connection types Limcon automatically performs a slip check for each bolt group in the connection.

When you specify friction bolts for any connection you may also specify the bolt slip factor by clicking the adjacent Slip Check button. This will display the Bolt Slip Check dialog box shown below.
ANSI/AISC 360

Whether Limcon is configured for ASD or LRFD you may choose the serviceability or strength limit state. Limcon checks the slip resistance determined from the code against the input load effects, service loads for ASD and factored loads for LRFD.

BS 5950

BS 5950 has friction bolt categories that are either non-slip in service or non-slip at failure (NSF). In both cases, the check is performed using factored load effects. The serviceability limit state is presented as an ultimate limit state – the code specifies different strengths for the two conditions.

EC3

EC3 has friction bolt categories that are either “slip-resistant at serviceability” (B) or “slip-resistant at ultimate” (C). In both cases, the check is performed using factored load effects. The serviceability limit state is presented as an ultimate limit state – the code specifies different strengths for the two conditions.

CAN/CSA-S16

You may specify either the serviceability or strength limit state. For the serviceability limit state the load effects are determined from the strength/service load factor, which must be input. A typical value is 1.5.

AS 4100 and NZS 3404

Bolt slip is a serviceability limit state in these codes. The load effects are determined from the strength/service load factor, which must be input. A typical value is 1.5. Limcon also allows bolt slip to be checked as a strength limit state.

IC Method

Even though the IC method may be used for the strength check in eccentrically loaded bolt groups, bolt forces for the slip check are always determined using the elastic method.

Out of Plane Forces

The support bolt group in the flexible end plate (FEP) and angle cleat (ACLT) connections may be subject to both in-plane and out-of-plane forces. It is assumed that tension in the beam reduces the slip resistance of these bolt groups linearly to zero at the point where the bolt pretension is entirely counteracted by the axial tension (see Ref. 24, p. 341). Compression is assumed to have no effect on the slip resistance.
Welds

The dialog box below is used for choosing the welds in the welded beam/column connection (WBC) and is typical of many others.

**fu:**
The ultimate strength of the weld material, MPa or ksi. When the configured design code is EC3 this value is not used, the weld resistance being determined by the base metal strength.

**Quality:**
Usually all welds are “SP”. When AS 4100 or NZS 3404 is the design code “GP” may be chosen for a lower quality weld (fillet welds only).

**Size:**
A drop-down list box shows all available fillet weld sizes and an item for a full penetration butt weld (FPBW) or complete joint penetration groove weld (CJPGW).

When ANSI/AISC 360 is the design code complete joint penetration groove welds do not have to be checked because the strength of the joint is controlled by the base metal. The strength of a complete joint penetration groove weld should never govern.

**Directional Strength of Fillet Welds**
ANSI/AISC 360 and CAN/CSA-S16 permit a 50% strength increase for fillet welds loaded at right angles to the length of the weld. BS 5950 and EC3 permit a directional strength increase of 25% and 22%, respectively. When Limcon is configured for these codes the additional strength is used for fillet welds in some connections, e.g. for fillet welds between a beam flange or flange plate and a column flange. Limcon output always shows an advisory note when the directional strength increase is utilized.

Directional strength increase is not used when Limcon is configured for AS 4100 or NZS 3404.
Weld Matching
Limcon implements code provisions related to weld matching for fillet welds in some connections. For ANSI/AISC 360 weld leg shear yield and shear rupture are checked while for CAN/CSA-S16 only weld leg shear rupture is checked. For BS 5950 Limcon uses the Table 37 weld design strengths, which are limited for unmatched welds. EC3 does not specify weld metal strength checks because requirements for electrodes ensure that welds are matched. AS 4100 and NZS 3404 specify compliance with AS/NZS 1554.1, which has provisions ensuring that welds are matched.

HSS Welds
Welds are represented as accurately as possible in the virtual reality window. In the case of HSS truss connections, each weld element is represented diagrammatically as a sector of a cylinder, whose radius equals the throat dimension, centered on the outside edge of the intersecting HSS. The exact welding details for these connections may be quite complicated, varying around the perimeter of each HSS from a fillet weld to a full or partial penetration weld.

The design of welds in HSS truss connections is not straightforward. See References 25, 52, 53, and 54 for more information. In checking the welds in the overlapped K/N connection (TKNO), Limcon makes these simplifying assumptions:

- For brace 1 the effective length of the weld may be obtained by linear interpolation between the length for zero and the length for 100% overlap.
- For brace 2 the force on the weld may be obtained by linear interpolation between the force for zero and the force for 100% overlap.
Multiple Load Cases

From V3.5, Limcon permits multiple load cases for some connection types. These are the same connection types that may be used when Limcon is used in conjunction with a structural analysis program, such as Microstran. A dialog box for entering multiple load cases is shown below.

Minimum design actions may be set by right-clicking on a load component cell in any load case. The pop-up menu contains items for setting each type of minimum action. Limcon will not permit choice of an inappropriate action – e.g. you cannot choose minimum shear when you right-click in an axial force cell. The minimum action is set according to the values shown at the bottom of the dialog box. Clicking the “…” button gives immediate access to the File > Configure > Minimum Actions command.

Note: Limcon evaluates each load case in turn, displaying a table of applied loads with the corresponding strength ratio and utilization ratio. The critical load case, the one with the lowest strength ratio and highest utilization ratio, is identified in this table. The detailed Limcon output that follows the table applies only to the critical load case. If you wish to see detailed output for a non-critical load case you can make a copy of the connection and delete all cases except the one of interest.
LRFD and ASD

Limcon V3.6 supports the ANSI/AISC 360 steel design specification, which integrates the LRFD and ASD design methods. Earlier versions of Limcon support the LRFD design method as specified in the AISC LRFD 1999 edition.

Essentially, the difference in Limcon between LRFD and ASD is that loads for LRFD are factored loads while those for ASD are service loads (refer to ANSI/AISC 360 Cl. B2, where SEI/ASCE 7 Section 2.3 is specified for LRFD load combinations and Section 2.4 for ASD). Whether LRFD or ASD is used, Limcon computes an available strength for each limit state and compares it to the required strength.

**Note:** To express the result of each limit state check Limcon uses the strength ratio or load factor. This is the ratio of the available strength to the required strength and the minimum strength ratio for all limit states must not be less than 1.0. Limcon also uses the alternative utilization ratio, which is the reciprocal of the strength ratio and is usually expressed as a percentage. The maximum utilization ratio for all limit states must not exceed 100%. You may configure Limcon to your preference, to emphasize either the strength ratio or the utilization ratio in reports.

The first part of the strength check output for a shear end plate connection (FEP) is reproduced below for LRFD and ASD design methods. In both cases, the result of each limit state check is shown with a strength ratio. The design shear force is 50 kips for the LRFD design while the service shear force is 35 kips for the ASD design. As would be expected, the respective strength ratios, which depend on the relative values of the design load and the service load, are very similar for the two methods.

```
DESIGN STRENGTH CHECKS...

<table>
<thead>
<tr>
<th>CHECK 2 - Weld:</th>
<th>Strength ratio</th>
<th>Req'd strength</th>
<th>Design strength</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weld shear capacity</td>
<td>94.7 &gt; Vu    = 50.0</td>
<td>1.89</td>
<td>Pass</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHECK 3 - Bolts:</th>
<th>Strength ratio</th>
<th>Req'd strength</th>
<th>Design strength</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Bolt shear capacity</td>
<td>95.1 &gt; Vu    = 50.0</td>
<td>1.90</td>
<td>Pass</td>
<td></td>
</tr>
<tr>
<td>Plate ply bearing capacity</td>
<td>183.5 &gt; Vu    = 50.0</td>
<td>3.67</td>
<td>Pass</td>
<td></td>
</tr>
<tr>
<td>Plate ply tearing capacity</td>
<td>133.8 &gt; Vu    = 50.0</td>
<td>2.68</td>
<td>Pass</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHECK 4 - Plate:</th>
<th>Strength ratio</th>
<th>Req'd strength</th>
<th>Design strength</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>End plate shear capacity</td>
<td>91.1 &gt; Vu    = 50.0</td>
<td>1.82</td>
<td>Pass</td>
<td></td>
</tr>
<tr>
<td>Plate block shear</td>
<td>98.9 &gt; Vu    = 50.0</td>
<td>1.98</td>
<td>Pass</td>
<td></td>
</tr>
</tbody>
</table>
```

LRFD STRENGTH CHECKS USING STRENGTH RATIO
ASD STRENGTH CHECKS...

The strength check output is repeated below showing the utilization ratio instead of the strength ratio.
Minimum Design Actions

To ensure a certain minimum degree of robustness in a connection, design codes and connection models may specify minimum design actions. For shear and axial force it may be an absolute value in kN (metric) or kips (US units), while for bending, it may be specified as a percentage of the member capacity. Limcon permits input of a percentage of section capacity for all actions and an absolute value for shear.

In general, there is insufficient information available for Limcon to know member capacities, so section capacities are used with the specified percentages.

The File > Configure > Minimum Actions command displays a dialog box in which you may specify minimum actions. These values are part of Limcon’s configuration data and they are used for the current job, regardless of the values that were in effect when that job was last saved. This facilitates the review of any Limcon job against revised minimum design actions.

MINIMUM DESIGN ACTIONS

For many connections Limcon checks whether input loads are sufficient to satisfy the specified minimum actions and displays a warning where they do not. In versions prior to V3.5, Limcon automatically increased input loads to match specified minimum actions.

ANSI/AISC 360

This code has no specific rules on minimum design actions but Ref. 6 suggests that non-seismic end plate connections should be designed for at least 60% of the beam strength, while moment splices located at the point of minimum moment should be designed for at least 1/6 of the member strength. The ANSI/AISC 360 Commentary recommends a general minimum load of 10 kips (LRFD) or 6 kips (ASD), which is applicable to shear connections and truss (axial) connections. Beam load tables may be used to ensure that shear connections are designed for the maximum uniform load that can be supported by the beam.
CAN/CSA-S16
This code has no specific rules on minimum design actions. Beam load tables may be used to ensure that shear connections are designed for the maximum uniform load that can be supported by the beam.

BS 5950
This code has no specific rules on minimum design actions but Ref. 9 suggests that flange welds in moment connections should be full-strength. Beams that have to be designed for the structural integrity tying force must have the necessary strength (at the strength limit state) to resist an axial load of at least 75 kN. This requirement would ensure a substantial shear capacity.

EC3
This code has no specific rules on minimum design actions.

AS 4100 and NZS 3404
These codes mandate a minimum design shear of 40 kN and a minimum design moment of 50% of the member moment capacity (but 30% for splices). Splices are preferably located at points where bending moment is low. The apex connection in a portal frame should be classified as a moment connection requiring the 50% minimum, not as a splice requiring 30%.

As shown below, load dialog boxes allow you to right-click on load components and select the minimum load. Limcon then calculates the minimum action and inserts this value in the right-clicked grid cell.

![Setting Minimum Actions](image)

**SETTING MINIMUM ACTIONS**
Shear Connections

Axial Force
The most common shear connections (WSP, FEP, ACLT) may be checked for axial force as well as shear. The ASI models for these connections do not cover axial forces. Tension in these connections is checked according to American practice, as set out in Ref. 6.

When considering axial force Limcon assumes that the connection is concentric with the beam axis.

Bolt Groups
Bolt groups are checked for axial force except for compression in the flexible end plate connection (FEP).

Buckling
Buckling is considered when the web side plate connection (WSP) is in compression. It is assumed that the plate is fixed at the weld and at the first column of bolts with sidesway permitted. As the flexural stiffness of the plate is negligible compared to the weak axis flexural stiffness of the beam it is assumed that there is no eccentricity moment in the plate.

Buckling is not considered for angle cleat (ACLT) or flexible end plate (FEP) connections.

Beam Copes
Beams connected to the web of another beam may have single or double web copes to provide clearance to the flanges of the support beam. When connection to a beam web is specified clearance checks are automatically performed. No clearance checks are done for beams connected to a column flange. When the support is a column web Limcon warns if flange copes are necessary but they are ignored in capacity calculations and in the virtual reality view.

The limit state of coped web local buckling is evaluated according to the Cheng, Yura, Johnston method (Ref. 6, p. 9-6). This check is informative for BS 5950, AS 4100, and NZS 3404, because the British and Australian design models (References 10 and 34, respectively) specify geometric limits within which local buckling is deemed not to occur.

Structural Integrity Tying Force
When the axial force is a structural integrity tying force BS 5950-1:2000 Cl. 2.4.5.2 allows it to be checked independently of the shear force. For flexible end plate and double angle cleat connections any load case with axial tension only is checked in Limcon as a structural integrity condition using the large displacement analysis method of Ref. 10. It is the responsibility of the designer to include the structural integrity tying force if required – Limcon does not include it automatically.
Single Plate / Shear Tab / Fin Plate / Web Side Plate (WSP) Connection

Fillet Weld Size
Design models for this connection specify a minimum fillet weld leg dimension to ensure that the cleat yields before the weld fractures. Limcon uses the minimum weld sizes shown in the table below.

<table>
<thead>
<tr>
<th>Design Code</th>
<th>Minimum Fillet Weld Leg</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI/AISC 360</td>
<td>62.5% of plate thickness*</td>
<td>6</td>
</tr>
<tr>
<td>CAN/CSA S16</td>
<td>75% of plate thickness</td>
<td>8</td>
</tr>
<tr>
<td>BS 5950-1:2000</td>
<td>80% of plate thickness</td>
<td>10</td>
</tr>
<tr>
<td>AS 4100 / NZS 3404</td>
<td>75% of plate thickness*</td>
<td>35</td>
</tr>
</tbody>
</table>

* Weld of minimum size does not need to be checked.

Flexible/Rigid Support Condition
When a flexible support condition is specified it is assumed that the moment on the weld group is zero. Similarly, when a rigid support condition is specified it is assumed that the moment on the bolt group is zero. If the support condition is not specified it is assumed that the maximum bending moment acts on both the weld and the bolt group. While a column flange connection could be rigid and a beam web connection could be flexible, tests show that accurately predicting the eccentricity is not always possible.

SPECIFYING THE SUPPORT CONDITION
**Note:** When Limcon is configured for AS 4100 or NZS 3404 the support condition should be “not specified” because the ASI design model (Ref. 37) does not permit the distinction between flexible and rigid support conditions.

**Extended Plate**

When the distance from the face of the support to the first line of bolts exceeds a specified value (e.g. 3.5 in. for the AISC design model) a buckling check is performed on the plate. In accordance with the recommendations of Ref. 6, this is done using the Cheng, Yura, Johnston method for checking local buckling in a double-coped web.

**HSS Column**

Unlike other shear connections, this connection is available in Limcon with hollow structural section (HSS) columns. Punching shear of the plate is checked and without axial force in the beam it is not necessary to check for column face yielding (Ref. 25, p. 312). When axial force is present Limcon checks column face yielding assuming that the effect of compressive stresses in the column is negligible. This check may be performed by treating the connection as a single brace connection (BRAC), in which the additional column actions are taken into account. See “Hollow Structural Section Chord/Column Face Yielding” on p. 64.

**Rigid Connections**

**Analysis Method**

The distribution of forces between the flanges and web in BSPL, WSPL, BMEP, HBEP, and WBC connections is determined by the analysis method set with the File > Configure > General command. There are three different methods – these are simplified, elastic, and plastic. The analysis method selection does not affect the AISC moment end plate (MEPC) and flange plate (FPC) connections because the simplified method is intrinsic to these connection models.

The simplified method is a traditional approach for the design of splices in which the flange plates are assumed to resist all the moment and axial force while the web plates resist the shear (and the resulting eccentricity moment). This is the default method in Limcon.

The elastic method was recommended in Ref. 11 and it is optional in the updated ASI Connections Series (References 41-44). It is recommended for splices in the AASHTO 1999 Interim.

The plastic method is the only method giving a rational stress distribution when the factored loads are sufficient to cause yield. The other analysis methods may then produce flange forces that exceed the capacity of the flange.
Choosing either the elastic or plastic analysis method for a splice generally produces designs with smaller flange plates and larger web plates.

The choice of analysis method does not affect the checking of bolts in BMEP and HBEP connections. Even though the flange force varies with the analysis method, the bolts must be checked for forces that are statically equivalent to the design actions.

Web Fillet Welds

Web fillet welds in BMEP, HBEP, and WBC connections are checked using one of two methods.

1. Where the elastic or plastic analysis method is used the beam web weld is checked by the linear elastic method, which may be very conservative, leading to a required weld size exceeding the thickness of the web. Specifying web fillet welds with a size exceeding the thickness of the web is almost certainly wasteful.

2. Where the simplified analysis method is used the web weld is checked using the method from Ref. 18, in which the compression part of the web weld is assumed to resist all the shear while the tension part must have sufficient tension strength to match that of the beam web. This method is also used in References 19 and 41-44.

The welded splice (WSPL) web plate weld is always checked using the linear elastic method, taking into account the eccentricity of the shear force from the centroid of each weld group.

Section Bending/Axial Check

In general, a check on the section at the connection location could be considered to be part of the member design and therefore not necessary in the connection design context. For bolted splices (BSPL) and bolted flange plate connections (FPC), however, the section is checked in Limcon because of the presence of bolt holes. Checking the flanges is a convenient alternative to the application of code rules for determining section capacity in members subject to combined actions but the flange forces must be computed rigorously (i.e. with the plastic analysis method). A check with simplified analysis flange forces will certainly fail when the applied load approaches the section strength. In previous versions of Limcon such flange checks were made informative so that they did not govern the design.

For the bolted splice the critical location for the section bending/axial check is the outermost flange bolt row where the bending moment may exceed the specified design moment – see “Bolted Splice (BSPL)” on p. 56.
**Bolted Splice (BSPL)**

**Full Contact**
For the bolted splice, you may enter a value for the gap between the ends of the connected members. When this value is zero the members are considered to be prepared for full contact and compressive actions are resisted by bearing on contact surfaces. An additional condition must then be considered – the minimum force acting on plates and connectors. For this force AS 4100 adopts a value of 15% of the member capacity in compression. Limcon does not perform this check automatically. The requirement can be satisfied by an additional load case containing a tension force only.

**Friction Bolts**
A bolt slip check is performed with friction bolts only. For ANSI/AISC 360 the check may be at service loads or factored loads. For BS 5950 and EC3 the check is determined by the bolt category. For AS 4100 and NZS 3404 the check is usually at service loads. The strength ratio or load factor (LF) is used to determine the service load from the ultimate load. A typical value for LF is 1.5.

**Flange/Plate Net Section Rupture**
Flange and plates in tension are checked for rupture on the net section at the outer bolt row. Where the splice must be checked for high shear and moment concurrently, variation of the moment over the length of the splice could mean that the moment specified at the center is inadequate for the net section checks. By default, Limcon increases the moment for the net section checks by the product of the shear force and the distance from the center of the splice to the outer bolt row. There is an option in the General Configuration dialog box to avoid this behaviour – selecting it necessarily means that the input moment is the maximum that occurs over the length of the splice.

**Inner Flange Plates**
In the Plates dialog box there is an option to specify inner flange plates. For an I section this adds two identical plates of the same length as the outer plate. The flange force is apportioned in the ratio of the gross area of outer and inner plates and each plate connection is checked independently.

**Flange Plate Weld**
There is an option for the flange plates to be fillet welded and not bolted on one side of the splice. The detail shows one set of flange plate welds on each side of the splice; i.e. bottom left and top right flanges welded, bottom right and top left flanges bolted. Flange plates are located so that the welded end overlaps the flange by exactly the specified weld length. The dialog box for inputting the flange plate weld also permits the omission of the end welds. This allows the designer to avoid transverse welds, which in some situations may cause flange embrittlement or otherwise impair flange strength.
Shear Lag

Shear lag is checked when a tension flange plate is connected by longitudinal welds only. In this case Limcon enforces a minimum length of weld equal to the width of the plate (L/w = 1.0). Where the design code does not specify the shear lag coefficient the value from Ref. 25 is used – this varies from 0.75 when L/w is 1.0 to 1.0 when L/w is 2.0.

ASI Bolted Moment End Plate Connection (BMEP, HBEP)

Note: Moment end plate connections may be designed as a thin plate with strong bolts or a thick plate with weaker bolts. With “thin plate” behaviour bolt efficiency is reduced by bolt prying forces but with “thick plate” behaviour bolt prying forces are negligible. The transition from thin plate to thick plate behaviour is taken as the plate thickness at which plate yield strength exceeds bolt rupture strength by 11% (Ref. 18).

The bolted moment end plate (BMEP) and haunched bolted end plate connection (HBEP) were originally based on Ref. 11. This model used a simple 1-dimensional yield line analysis with prying assumed to add 30% to the bolt forces that would be necessary without prying. The model is widely regarded as excessively conservative because the necessary end plate thickness ensures minimal bolt prying forces. In fact, when end plates are connected to thin column flanges prying forces of the magnitude of those assumed in the model may exist, even when transverse stiffeners are present.

In 2009 the BMEP and HBEP connections were revised in accordance with the new ASI Connections Series (References 41-44), which replace Ref. 11. These new publications are based on the AISC Design Guide No. 4, Extended End Plate Moment Connections – Seismic and Wind Applications – 2nd Edition (Ref. 19), which requires thick plate/flange behaviour, and AISC Design Guide No. 16, Flush and Extended Multiple Row Moment End Plate Connections (Ref. 18), which does not. Thick plate behaviour is necessary in seismic design because the “strong column / weak beam” requirement demands that moment connections remain elastic under seismic excitation.
Limcon allows you to select thick plate/flange behaviour when required. Substantial economies may be achieved in non-seismic designs by not requiring thick plate/flange behaviour. For example, expensive welded flange doubler plates can sometimes be avoided if thick flange behaviour is not necessary.

As shown in the table below, the new BMEP and HBEP connections permit several new multiple bolt row arrangements, e.g. 2 bolts outside the tension flange with 4 or 6 inside. End plate stiffeners are permitted for two types of BMEP connection only.

<table>
<thead>
<tr>
<th>No. Bolt Rows</th>
<th>Outside Flange</th>
<th>Inside Flange</th>
<th>End Plate Stiffener</th>
<th>Ref.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>–</td>
<td>18</td>
<td>Flush, non-seismic*</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>2</td>
<td>–</td>
<td>18</td>
<td>Flush, non-seismic*</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>3</td>
<td>–</td>
<td>18</td>
<td>Flush, non-seismic*</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>–</td>
<td>18, 19</td>
<td>Extended, seismic</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Yes</td>
<td>18, 19</td>
<td>Extended, seismic</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>–</td>
<td>18</td>
<td>Extended, non-seismic</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>–</td>
<td>18</td>
<td>Extended, non-seismic</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Yes</td>
<td>19</td>
<td>Extended, seismic</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>–</td>
<td>–</td>
<td>Extended, non-seismic*</td>
<td></td>
</tr>
</tbody>
</table>

* Not included in ASI models.

The arrangement with a bolt row outside the flange and none inside is intended for small beams where there is insufficient space for a bolt row inside the flange. Snug-tightened bolts are not permitted with these connections.
AISC Moment End Plate Connection (MEPC)

The AISC Steel Design Guide 16 *Flush and Extended Multiple Row Moment End Plate Connections* (Ref. 18) sets out design models for both flush and extended end plate moment connections with multiple bolt rows. The models, which rely on 2-dimensional yield-line analysis, were verified by full-scale tests. Limcon implements all five unstiffened connections and the two stiffened extended end plate connections.

The applicability of the connection design models is specifically limited to I sections meeting certain geometric requirements. These limits significantly restrict the number of I sections with which the flush end plate may be used.

Only high-strength bolts may be used. It has been determined by tests on large moment end plate connections that the strength is not adversely affected by the use of snug-tightened bolts (Ref. 18). The design procedure permits use of snug-tightened Grade 8.8 and A325 bolts. Higher strength bolts must be fully tensioned.

**Note:** Snug-tightened bolts must not be used with this connection for dynamic loading or in areas of high seismicity.

**Axial Load Treatment**

The tests on which the connection design model is based did not include axial forces – this is primarily a flexural model. The connection is not suitable for checking of base plates because many of the limit states relevant to base plates are not checked.

Axial forces are permitted by use of the procedure recommended in Ref. 18 to "convert the factored axial load into an equivalent moment that will be added to the factored connection moment for axial tension or subtracted from the factored connection moment for axial compression". Limcon limits the axial load equivalent moment so that one flange remains in compression.

**Strength Limit States**

The diagram below shows a plot of the strength ratio for the example on p. 43 of Ref. 18 with the end plate thickness varied above and below the specified thickness of 9/16" (14.3 mm). The diagram shows the three possible failure modes predicted by the design model:

- A – End plate yield (thin plate behaviour).
- B – Bolt rupture with prying (intermediate plate behaviour).
- C – Bolt rupture without prying (thick plate behaviour).

When the plate thickness is such that mode A behaviour occurs, maximum prying forces exist but have no effect on the connection capacity because it is determined by plate yielding. With mode C behaviour there are no prying forces and the capacity of the connection is determined by the bolt strength. Throughout the range of plate thicknesses that lead to mode B behaviour, prying forces vary from a maximum at the A/B thickness to zero at the B/C thickness. The
connection capacity is adversely affected by the bolt prying forces in this range only.

The design model assumes the maximum prying force whenever prying exists and this accounts for the discontinuity in connection capacity at the B/C thickness, which would not occur in reality.

**STRENGTH RATIO VS. END PLATE THICKNESS**

Limcon can readily be used to optimize the connection design for either thinner end plate and larger bolts (end plate yield) or thicker end plate and smaller bolts (bolt rupture).

**Column-Side Checks**

In beam/column connections the column and stiffeners, if present, must be checked for limit states such as column flange bending and column web panel zone shear, to name just two.

Column-side checks were performed according to Ref. 11 (now obsolete) for BMEP, HBEP, and WBC connections only. With the introduction, in 2009, of the new ASI Connections Series (References 42, 43), column-side checks became available for all beam/column connections:

- BMEP, HBEP – bolted moment end plate connection
- WBC – welded beam/column connection
- MEPC – moment end plate connection
- FPC – bolted or welded flange plate connection

The latest AISC recommendation on column stiffening for welded connections are found in AISC Steel Design Guide 13, *Stiffening of*
Wide Flange Columns at Moment Connections: Wind and Seismic Applications (Ref. 20). These are adopted in Limcon for the WBC and FPC connections.

For bolted end plate connections there are more recent recommendations in AISC Steel Design Guide 4, Extended End Plate Moment Connections – Seismic and Wind Applications – 2nd Edition (Ref. 19). These are adopted in Limcon for the BMEP, HBEP, and MEPC connections. This publication contains two requirements that are not included in the superseded requirements of Ref. 20:

- Thin plate behaviour of the column flange is not permitted. If you elect to enforce thick plate behaviour Limcon will fail any BMEP, HBEP, or MEPC connection where thin plate behaviour is found to occur. To ensure thick plate behaviour of the column flanges you may choose a column with thicker flanges, or in the case of the BMEP and HBEP connections, you may add column flange doubler plates. When the thick plate model is not enforced prying is assumed to reduce bolt efficiency by 20%.

- Even though tension flange stiffeners (continuity plates) may be provided there is still a requirement to check column flange bending using a 2-dimensional yield line analysis. This check is performed in Limcon.

Column Web Doubler Plates

Web doubler plates may be used in beam/column connections “to enhance the capacity of the column web to resist compressive force from a beam flange or to resist shear force”. They are discussed in Ref. 11 on p. 194. It is stated that the column web doubler plate must extend beyond the flanges of the beam by a distance of at least the column depth or 12 times the column flange thickness.

The extension of the web doubler plate beyond the extremities of the connected beams envisages use of the web doubler without co-existing stiffeners adjacent to the beam flanges. Web doubler plates are commonly enclosed by top and bottom stiffeners adjacent to the beam flanges and do not extend past the beam flanges.

Limcon permits web doubler plates on one or both sides of the column as an alternative to shear (diagonal) stiffeners provided they are accompanied by top and bottom stiffeners. There is a full penetration butt weld all around the web doubler plate, either to column flanges or column flange doubler plates on the sides and stiffeners on the top and bottom. The length (height) of the doubler plate is computed by Limcon as the clear distance between top and bottom stiffeners less 12 mm.

Where there are no flange doubler plates, the width of the doubler plate is the depth of the column web between fillets. Where there are full-length flange doubler plates on one or both column flanges the web doubler plate width is computed as the lesser of the column web depth
between fillets and the clear distance between flange doublers less 6 mm for each full-length flange doubler.

When web doubler plates are used you should carefully consider the welds required at the side of each top and bottom stiffener. Although Limcon permits tension stiffeners with no side welds, this is not satisfactory if a web doubler plate is butt-welded to it.

### Column Flange Doubler Plates

For BMEP and HBEP connections doubler plates may be used to reinforce column flanges that would otherwise be too thin to resist flange bending. Limcon originally implemented column flange doubler plates in accordance with Ref. 11 but revised requirements in the new ASI Connections Series (References 41, 43) are now implemented. The old style flange doubler plates were butt-welded to the column web only but the new design model additionally requires fillet welds around the other edges of the doubler plates. Limcon assumes these to be 6 mm fillet welds for doubler plates up to 8 mm in thickness and 8 mm fillet welds otherwise.

Column flange doubler plates are not used with connections other than BMEP and HBEP connections.

### RHS Bolted Moment End Plate (TMEP)

These connections are available for RHS (and SHS) compact sections only. The design models, based on 2-dimensional yield line analysis, were developed in a recent Sydney University research project that included full-scale testing. See References 27 and 28 for detailed information about the design models and the testing programme.

Bolts must be high-strength tensioned bolts, such as 8.8/TB or A325PT. The design models are only valid for a compound butt/fillet weld of specified leg length all around the section. The fillet, which extends outside the face of the section by the leg dimension has an appreciable beneficial effect on the plate bending strength.

**Axial Load Treatment**

The tests on which the connection design model is based did not include axial forces – this is primarily a flexural model. Small axial forces are permitted by use of the procedure recommended in Ref. 18 to “convert the factored axial load into an equivalent moment that will be added to the factored connection moment for axial tension or subtracted from the factored connection moment for axial compression”. Limcon limits the axial load equivalent moment so that one flange remains in compression.
RHS Base Plates

Additional considerations are required if this connection is to be used to evaluate moment base plates for RHS columns:

- Some limit states relevant to base plates are not checked, e.g. concrete bearing failure.
- The TMEP model assumes high-strength tensioned bolts.
- For a thick plate the strength is determined by the bolts and the lever arm may be smaller than assumed in the TMEP model because the resultant compression could be inside the column flange.
- For a thin plate the strength is determined by the plate itself and the TMEP connection may be considerably stronger than a similar moment base plate (BASE) because of the two-dimensional yield line pattern and the presence of prying, which may not occur in base plates.

Thus, when the TMEP model is used to design a base plate it would be advisable to apply an additional strength reduction factor to account for the above effects. Calibrating the TMEP to a similar moment base plate (BASE) would be reasonable.
Hollow Structural Section Chord/Column Face Yielding

Truss chords and columns composed of hollow structural sections (HSS) need to be checked for face yielding, the development of a yield-line pattern where a plate or branch is welded to the chord or column. The face yielding strength is adversely affected by co-existing compressive stress in the chord or column and the formulae for face yielding strength contain an efficiency factor that is less than 1 when compressive stresses are present. In the CIDECT manuals and in Packer & Henderson (Ref. 25) this is \( f(n) \) for SHS/RHS and \( f(n') \) for CHS. ANSI/AISC 360 Chapter K uses the same values, referred to as the \( Q_f \) parameter.

The same method is used in Limcon for all connections in which face yielding is checked. These are the bracing connections (BRAC, KNG) and the HSS truss connections (TYT, TX, TKNG, TKNO). Single plate connections to an HSS column (WSP) should be checked for column face yielding if axial force is present in the beam. This check is not currently performed by Limcon but can easily be done by treating the single plate connection as a single brace connection, for which the necessary column compression and moment may be entered.

The items below are required for calculating face yielding efficiencies. See also, “Hollow Structural Section (HSS) Truss Connections” on p. 76.

\( \mathbf{N^{*op}} \)

When the chord is in compression on both sides of the joint \( N^{*op} \) is the smaller compression force (not negative). If the chord on either side of the joint is in tension \( N^{*op} \) is zero. It is required for checking face yielding in a CHS chord or column.

\( \mathbf{N^{*o}} \)

When the chord is in compression on both sides of the joint this is the larger compression force (not negative). If the chord is in compression on one side of the joint and in tension on the other, \( N^{*o} \) is the compression force. It is required for checking face yielding in an SHS or RHS chord or column.

\( \mathbf{M^{*o}} \)

Bending moment in chord at joint due to transverse loading (not negative). It is required for checking face yielding in an HSS chord or column.

\(^{*}\) Ref. 12 erroneously permits values of \( f(n) \) and \( f(n') \) exceeding 1.
Limcon performs design checks on a simple isolated bracing cleat (gusset plate) connection as specified in Ref. 11 and additional checks in accordance with Ref. 12, including checks on HSS bracing members and attached plates. In addition to the connection types in Ref. 11 there are four concentric connections, two with cover (splice) plates and two with fork plates. All types are shown in the table below:

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Attach. Plate</th>
<th>Cover Plates</th>
<th>Comp. Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Single angle bolted on long leg</td>
<td></td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>2</td>
<td>Single angle bolted on short leg</td>
<td></td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>3</td>
<td>Double angles bolted on long legs</td>
<td></td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>4</td>
<td>Double angles bolted on short legs</td>
<td></td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>5</td>
<td>Tie rod welded to plate</td>
<td>Yes</td>
<td></td>
<td>n/a †</td>
</tr>
<tr>
<td>6</td>
<td>Flattened HSS bolted to gusset plate</td>
<td>Yes *</td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>7</td>
<td>Slotted HSS bolted to gusset plate</td>
<td>Yes</td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>8</td>
<td>HSS tee end bolted to gusset plate</td>
<td>Yes</td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>9</td>
<td>I or C section, web bolted to gusset plate ×</td>
<td></td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>10</td>
<td>I section with single plate bolted to web</td>
<td>Yes</td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>11</td>
<td>I section with bolted web cover plates</td>
<td>Yes</td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>12</td>
<td>Slotted HSS with bolted cover plates</td>
<td>Yes</td>
<td>Yes</td>
<td>Cone.</td>
</tr>
<tr>
<td>13</td>
<td>I section with web plates &amp; claw angles •</td>
<td>Yes</td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>14</td>
<td>Slotted HSS with bolted fork plates</td>
<td>Yes</td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>15</td>
<td>HSS tee end with bolted fork plates</td>
<td>Yes</td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>21</td>
<td>Single angle welded on long leg</td>
<td></td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>22</td>
<td>Single angle welded on short leg</td>
<td></td>
<td></td>
<td>Ecc.</td>
</tr>
<tr>
<td>23</td>
<td>Double angles welded on long legs</td>
<td></td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>24</td>
<td>Double angles welded on short legs</td>
<td></td>
<td></td>
<td>Cone.</td>
</tr>
<tr>
<td>25</td>
<td>Slotted HSS welded to gusset plate</td>
<td></td>
<td></td>
<td>Cone.</td>
</tr>
</tbody>
</table>

* The flattened part of the HSS is checked as the attached plate.
× Flanges on one side of I section may be ground flush.
† The tie rod cannot be loaded in compression.
• Only available with maintenance.

**Terminology**

Limcon uses the following terms for the components of bracing connections:

*Gusset plate* – a rectangular plate to which the member or attached plate is connected. It is welded to the supporting member. Any corner intersected by a member is trimmed at right angles to the member axis.

*Cleat or simple cleat* – a gusset plate used for a single brace connection with its longitudinal sides parallel to the member axis.
Attached plate – a plate that is connected to the gusset plate and the member.

Cover plates – a pair of plates connecting a member or attached plate to a gusset plate.

HSS – any hollow structural section, CHS, SHS, or RHS. Some steel section libraries contain pipe sections – these are differentiated from round HSS (CHS) by their minimum specified yield strength of 35 ksi but are still classified as HSS by Limcon, using the correct Fy.

Rectangular Gusset Plate

By default, the cleat (gusset plate) for an inclined bracing member has sides parallel to the center-line of the bracing member. This arrangement simplifies the analysis of the cleat but the shape that is actually detailed may sometimes have one or two sides perpendicular to the support member, usually a column or truss chord.

There is an option button in the BRAC dialog box to change the simple cleat to a rectangular gusset plate (with a corner trimmed at right angles if it is intersected by the member). When this is done the connection is checked according to the conventional AISC method using the Whitmore section rather than the full width of the simple cleat. The weld to the supporting member is checked taking into account any moment applied by the gusset plate to the supporting member. The section through the gusset plate at the weld is also checked for yield under combined stresses using the interaction formula suggested by Astaneh-Asl (Ref. 29).

When the brace is in tension the rectangular gusset plate is checked for block shear using the same method as that used for a simple cleat. In addition, the rectangular gusset plate is checked for tearing to the edges, as shown in Ref. 25, p. 246.

Buckling Capacity

In computing the compression capacity of the bracing cleat connection determined by out-of-plane buckling of the plate or connected plates, Limcon takes compression and bending interaction into account rigorously according to the configured design code. Typical worked examples may be found in the AISC Hollow Structural Sections Connections Manual (Ref. 7). For ANSI/AISC 360 and CAN/CSA-S16 the k factor is 1.2 in accordance with Ref. 7, while for BS 5950, EC3, AS 4100, and NZS 3404 it is 1.0.

Unstiffened lapped plate connections (types 6, 7, and 8 in the above table) may be uneconomic as compression members. The compression capacity of similar concentric connections (types 12, 14, and 15 in the above table) is usually two or three times that of the eccentric connection. Bolts in the concentric connections work in double shear so it is often possible to use only one row of bolts, thereby making the connection shorter and stronger. Although the tee end with fork plates may be cheaper than the other concentric connections, it is not as strong in tension because of the non-uniform distribution of forces into the HSS walls.
In calculating the buckling capacity of an eccentric cleat it is necessary to determine the maximum moment acting on an equivalent column. The diagram below shows the bending moment resulting from a second-order analysis of a typical connection with lapped plates.

The bending moment is shared between the parts in the ratio of their stiffnesses. In this case, the eccentricity moment is shared almost equally between the gusset plate or cleat (lower) and the plate attached to the HSS member (upper). The moment is amplified about 50% by the p-delta effect. The amplified moment is used in the design code evaluation of the equivalent column.

For lapped plate connections Limcon assumes that 50% of the eccentricity moment is applied to the gusset plate. For connections with a member connected directly to the gusset plate or cleat it is assumed that 10% of the eccentricity moment is applied to the cleat. Theoretically, it would be possible to calculate the distribution of the bending moment between the parts of the connection in each case but this would require additional data. Strength values predicted by Limcon agree well with published design examples (Ref. 7) and the results of recent (2009) full-scale testing conducted by Albermani et al. at the University of Queensland.

The type 9 connection with a channel brace may have a simple cleat bolted to the front of the section if it is no wider than the straight part of the web. Otherwise, the cleat or gusset plate must be on the back of the section, where the eccentricity will be greater and the compression strength less. In this case, the Limcon output shows the placement of the cleat that was assumed in computing the compression strength.

This connection type with an I section brace must have the flanges ground flush on the back of the section if a simple cleat is wider than the straight part of the web or if a rectangular gusset plate is used. Limcon assumes that the removal of the flanges does not affect the eccentricity and has no effect on the strength of the connection.
SLOTTED HSS WITH BOLTED FORK PLATES

HSS TEE END WITH BOLTED FORK PLATES
KT Gusset Plate Truss Connection (KTG)

This is a compound connection comprising a rectangular gusset plate welded to a support member with two or three bracing members connected to the gusset plate. It may be used for checking truss connections and also the chevron bracing connection. Limcon performs certain checks on the compound connection and then checks each component connection as a single brace connection with a rectangular gusset plate, using parameters determined by the KTG connection data. Any of the single brace connection types may be used for the component braces.

Without loss of generality Limcon shows each connection in a standard orientation. Brace 1 is shown on the left and brace 2 on the right. With two braces either brace angle may be 90°, making an N connection. If brace 3 exists it is the center brace.

Gusset plate yield and buckling are checked using the Whitmore section. The Whitmore pattern consists of two lines radiating at 30° from the center of each outer bolt in the first bolt row to the Whitmore section, along the center-line of the last bolt row (closest to the connection working point). This pattern is shown in the detail diagram for each component brace. The Whitmore equivalent column lengths, L1 (center), L2 (upper), and L3 (lower) are also plotted. Limcon automatically checks that none of the lines in the Whitmore pattern intersects an edge of the gusset plate.

The primary checks include:
- A check on the slenderness of gusset plate unsupported edges. The default value for the maximum permissible b/t ratio is 28 – a different value may be entered by clicking on the Gusset plate “…” button.
- Strength of the weld to the supporting member using the resultant of all brace forces.
- Yield of the gusset plate under combined stresses on a section adjacent to the weld.
- HSS chord face plastification and punching shear.

Secondary checks are performed for each component brace with the procedure used for a single brace connection. These include:
- Block shear and corner tearout (tension only).
- Bolt shear and bearing.
- Bolt tearing (tension only).
- Welds to member.
- Gusset plate buckling (concentric or eccentric).
- Shear lag.

For gusset plate buckling the single brace effective length of the Whitmore equivalent column may be reduced if there is tension in an adjacent bracing member (see Effective Lengths, below).
Checks that are not relevant for the compound connection are omitted. These are:

- The check on the weld to the supporting member.
- The yield check on the section adjacent to the weld.
- HSS supporting member checks.

Effective Lengths

While buckling in single brace connections is checked using an effective length factor (k) of 1.0 or 1.2, the value used for a beam/column brace is typically half of that. This recognizes the restraint provided by adjacent members and transverse tension in the gusset plate.
Limcon uses an effective length factor for each component brace connection that is determined as the single brace value (1.0 or 1.2, depending on design code) reduced by up to 50%, depending on the direction of any adjacent member and the tension force in it. If a member lies within 45° of the direction of the brace under consideration and it has a tension force of at least the same magnitude as the compression force in the brace under consideration, the effective length factor is reduced by 50%. As the angular displacement of the nearer tension member increases the effective length reduction diminishes linearly to zero when the angle is 90°. Similarly, effective length reduction diminishes linearly to zero as the force in the nearer tension member decreases to zero. Effective length reduction is achieved by multiplying the k factor by an effective length modifier.

Where an effective length modifier is used it is shown at the beginning of the output.

Noding Eccentricity
Where the working point does not coincide with the member center-line there is a noding eccentricity that causes a moment for which the chord must be designed. The face of an SHS or RHS chord is unable to resist significant moment so it is desirable to minimize the eccentricity for these sections.

Steps to Input and Check a KTG Connection
• When you create a new KTG connection a dialog box is displayed with the default connection. The sections, the gusset plate, other data, and the loads have to be changed as required.

• The KTG connection consists of a chord or column (shown in the horizontal position) and two or three braces (or branch members). The default connection has two braces – check the Brace 3 box if you want three. Brace 1 is always shown on the left, Brace 2 on the right, and if Brace 3 exists it is between them. In an “N” connection either Brace 1 or Brace 2 is vertical and Brace 3 does not exist.

• Most brace details are changed by clicking a brace button – this displays a subsidiary dialog box for the particular brace in which you can change the brace section, connection type, bolt or weld details, etc.

• With the “Set all” option selected, bolt details shown in the KTG dialog box take precedence over bolt details in subsidiary dialog boxes – e.g. when you change the bolt size in the KTG dialog box it is automatically set to the same size in all subsidiary dialog boxes.

• The output window at the bottom of the dialog box usually shows the end of the design check report. If the connection passes all design checks a utilization ratio not exceeding 100% will be shown.

• The output window contains only an error message if there is a fatal geometry error – e.g. if a brace does not overlap the gusset plate sufficiently. This type of error can usually be fixed by clicking
arrow buttons in the KTG dialog box to interactively resize or move the gusset plate, or adjust the offsets of the braces from the working point (WP).

- When you click a brace button the brace is shown in a subsidiary dialog box for a single brace connection (BRAC). In this dialog box the brace is shown rotated 90º clockwise. This is so because the brace is checked as a BRAC connection in which the “column” is the KTG chord. Some checks performed for a single brace are skipped because they are not relevant – e.g. the weld between the column (chord) and the gusset plate does not need to be checked here because it is checked in the KTG dialog box for the resultant of all brace forces.

- The lines of the Whitmore pattern are shown in the BRAC dialog box. A fatal error results if any of these intersects a free edge of the gusset plate. Similarly, if any bolt hole is too close to an edge of the gusset plate a fatal error results:

  *** ERROR -- Gusset plate geometry error.  
  To fix this type of error you may interactively resize or relocate the gusset plate using the arrow buttons. When you click the OK button these changes will take effect in the KTG dialog box. You cannot change the gusset plate thickness in a subsidiary dialog box.

**Note:** In the standard version of Limcon, this connection type is only available with a current maintenance subscription.
Uniform Force Bracing Connection (UFBR)

This is a compound connection comprising a beam to column connection (ACLT) and one or two bracing members (BRAC), each connected to a gusset plate that is welded to the beam and bolted to the column. Any of the single brace connection types may be used for the component braces. The upper brace is referred to as Brace 1 while the lower brace is referred to as Brace 2.

The connection is evaluated using the uniform force method as described in the AISC Steel Construction Manual (Ref. 6). The essence of this method is that for each bracing connection the eccentricity must be negligibly small, so that there is no moment on the gusset/beam and gusset/column connections. The interactive “nudge” buttons in the Gusset Plate dialog box allow you to quickly adjust gusset plate dimensions to achieve the minimum eccentricity (see The Adjust Gusset Plate Dialog Box, below).

The beam/column connection is checked for the resultant shear and axial force. This is determined automatically from the input design actions, which are:

- \( V^* \) Beam shear.
- \( N^* \) Beam axial force (tension +ve).
- \( N^*1 \) Brace 1 axial force (tension +ve).
- \( N^*2 \) Brace 2 axial force (tension +ve).

Checks are also performed for each component brace, using the procedure for a single brace (corner) connection.

UFBR DIALOG BOX
Steps to Input and Check a UFBR Connection

- When you create a new UFBR connection a dialog box is displayed with the default connection. The sections, the gusset plate, other data, and the loads have to be changed as required.

- The UFBR connection consists of a beam and column with a bracing member in the upper or lower quadrant, or both. A checkbox indicates whether each brace is present.

- Brace details are changed by clicking the brace button – this displays a subsidiary dialog box in which you can change the brace section, connection type, bolt or weld details, etc.

- With the “Set all” option selected, bolt details shown in the UFBR dialog box take precedence over bolt details in subsidiary dialog boxes – e.g. when you change the bolt size in the UFBR dialog box it is automatically set to the same size in all subsidiary dialog boxes.

- The output window at the bottom of the dialog box usually shows the end of the design check report. If the connection passes all design checks a utilization ratio not exceeding 100% will be shown.

- The output window contains only an error message if there is a fatal geometry error – e.g. if a brace does not overlap the gusset plate sufficiently. This type of error can often be fixed by clicking the arrow buttons in the UFBR dialog box to adjust the offsets of the braces from the working point (WP).

- When you click a brace button the brace is shown in a subsidiary dialog box for a single brace connection (BRAC).

- The lines of the Whitmore pattern are shown in the BRAC dialog box. A fatal error results if any of these intersects a free edge of the gusset plate. Similarly, if any bolt hole is too close to an edge of the
gusset plate a fatal error results:
*** ERROR -- Gusset plate geometry error.
To fix this type of error you may interactively resize or relocate the gusset plate using the arrow buttons in the Plates dialog box (shown below). When you click the OK button in the subsidiary dialog box these changes will take effect in the UFBR dialog box.

The Adjust Gusset Plate Dialog Box
This dialog box is displayed when you click the top button in the Plates group box. It contains interactive “nudge” buttons that allow you to adjust each of the gusset plate dimensions until the eccentricity is minimized.

Limcon calculates and displays the eccentricity for each bracing connection. When this is zero, expression (13-1) in the AISC Steel Construction Manual, p.13-3 is satisfied. The warning exclamation mark is shown in the connection detail if the eccentricity exceeds 1” (25 mm). The process of minimizing the eccentricity involves the adjustment of the lengths of the horizontal (welded) and vertical (bolted) connections. These lengths are determined by the gusset plate dimensions shown in the dialog box; the width, height, and horizontal and vertical edge increments. A non-zero edge increment means that the corresponding free edge of the gusset plate is not parallel with the connected edge. It is often necessary to have one or both edge increments non-zero.

As you change the length of the column connection (vertical), the number of bolts is automatically adjusted. You may reduce the height of the connection until there are no bolts. This may be required for connections to a column web or when the elevation angle of the bracing member is small. In this configuration, the connection is categorized as Special Case 3 in the AISC Steel Construction Manual.

Note: In the standard version of Limcon, this connection type is only available with a current maintenance subscription.
Hollow Structural Section (HSS) Truss Connections

Three types of uniplanar HSS truss connection are available. These are the Y/T connection with one branch and the X and K/N connections with two branches. The K/N connection may be a gap connection or an overlap connection with different rules applying to each. The KT connection, with three branches, is not available in Limcon. Guidance is available from CIDECT (www.cidect.com) and Corus (www.corusgroup.com) on how to adapt K/N connection results for a KT connection.

Without loss of generality Limcon shows each connection in a standard orientation. In K/N connections brace 1 is shown on the left and brace 2 on the right. Either brace angle may be 90º, making an N connection. In K/N overlap connections brace 2 is always the overlapped brace.

To enter the design loads for an HSS truss connection the dialog box shown below may be used when there is a single load case. For multiple cases load components are entered into a data grid, one line for each load case.

The load components for a K/N gap connections are shown below.

The load components are shown below. See “Hollow Structural Section Chord/Column Face Yielding” on p. 64 for more information.
\( N^{*}\text{op} \)
The smaller chord compression force (not negative), zero if tension.

\( N^{*}\text{o} \)
The larger chord compression force (not negative), zero if tension.

\( M^{*}\text{o} \)
The bending moment in the chord at the joint due to transverse loading (not negative). Does not include moments caused by non-zero eccentricity, which may be ignored if connection geometric requirements are satisfied.

\( V^{*}\text{o} \)
For K/N gap connections only, this is the shear force in the gap region of the chord (not negative).

\( N^{*}\text{1} \)
\( N^{*}\text{1} \) is positive if tension and negative if compression. For K/N connections the brace forces must be of opposite sign. This value is also used for a section yield check.

\( N^{*}\text{2} \)
\( N^{*}\text{2} \) is positive if tension and negative if compression. For K/N connections the brace forces must be of opposite sign. This value is also used for a section yield check.
Base Plate (BASE)

**Pinned Base Plate**

The pinned base plate is implemented according to Ref. 11 and *Design of Pinned Column Base Plates* – G. Ranzi & P. Kneen – ASI – Steel Construction Vol. 36 No. 2 – Sep. 2002 (Ref. 30). Note that References 11, 12, and 30 all contain formulae derived from yield-line patterns that may not be correct when bolts are outside the column profile. In all such cases Limcon evaluates alternative yield-line patterns to determine the minimum strength.

**Moment Base Plate**

The moment base plate is implemented according to AISC Steel Design Guide 1, *Base Plate and Anchor Rod Design – 2nd Edition* (Ref. 22). This does not discuss simultaneous bending about both axes. It is handled in Limcon by evaluating bending about each axis independently and then using an elliptical interaction equation for combining these effects.

The model assumes a single row of tension bolts outside the column flange but Limcon permits multiple bolt rows between the column flanges as well. Thus, the tension capacity computed by Limcon for multiple bolt rows in tension will be conservative. If bolt tension or plate yielding at the tension flange is critical a thinner plate may be justified by checking as a similar BMEP or MEPC. Note that there are two important caveats to be observed when using a moment end plate model to check a base plate:

- The base plate should be thick enough for thick plate behaviour to govern. Because of the limited bearing strength of the foundation full prying action cannot be assumed to occur, so the required strength must be attained without prying.
- The lever arm between centers of tension and compression may be significantly smaller for a base plate. In the moment end plate connection the center of compression is assumed to be at the compression flange while in a base plate it is determined by the distribution of stress in the concrete and may be well inside the compression flange.

**Shear Analysis**

Shear on a base plate may be resisted by friction if the column is in compression, by a shear key, and optionally by the anchor bolts. It is assumed that the shear is resisted firstly by the available base plate friction. If there is a shear key it resists the balance of the shear force up to the available strength of the shear key. When shear is permitted on the anchor bolts they are checked for the balance of the shear force. In moment base plates it is assumed that only half the total number of anchor bolts can participate in resisting shear.
Bolt Group (BGP)

The bolt group, which may contain up to 6 columns and 12 rows, permits the omission of any bolt on the 6×12 grid. This allows bolt groups with a staggered pattern to be checked, providing every bolt lies on a grid point. Limcon may be configured to use either the elastic method or the instantaneous center method for determining the capacity of a bolt group when it is subjected to an in-plane eccentric force or moment.

Elastic Method

The elastic method is the default method for determining bolt group capacity when Limcon is configured for BS 5950, EC3, AS 4100, or NZS 3404. It is simple and generally regarded as being conservative. In-plane loads are resolved into horizontal and vertical forces acting at the bolt group centroid and a co-existing moment. Centroidal forces are shared equally on all bolts and moment bolt forces are assumed to be proportional to the distance of the bolt from the centroid.

Instantaneous Center Method

The instantaneous center method is the default method for determining bolt group capacity when Limcon is configured for ANSI/AISC 360 or CAN/CSA-S16. It uses the “weak bolt / strong plate” model, in which the location of the instantaneous center (IC) is determined assuming that the force in each bolt is not affected by bearing or tearing failure. The bolt group strength ratio is comparable with the elastic method bolt shear strength ratio and is usually about 10% greater. The bolt group capacity should agree with any value determined from the tabulated coefficients in the AISC Steel Construction Manual (Ref. 6).

Joint rotation is computed at the strength limit state assuming that the ultimate deformation of the bolt furthest from the IC is 0.34".

Bolt Bearing and Tearing Checks

Limcon automatically checks bearing and tearing on every bolt in the group by determining the forces on each bolt at the design loading and comparing each of these with bearing and tearing capacities computed according to the design code. Bolts in the outside rows and columns are checked for external tearing where a force component is directed towards an edge. Internal tearing checks are performed on each bolt in the direction of the force components. If there is no bolt at the adjacent grid position in the direction of the tearing force the internal tearing check is omitted. Bolt forces for bearing/tearing checks are determined by the elastic method.

Slip Check

A slip check is performed for in-plane loading where a friction bolting category is specified. The slip check may be performed at service or factored loads. Bolt forces for the slip check are always determined using the elastic method.
Out of Plane Bending

Out-of-plane moments on bolt groups are always analysed using a plastic method in which all tension bolts are assumed to resist the ultimate bolt tension. Using the Ref. 6 method with the neutral axis at the bolt group centroid (also used in Ref. 34) there can be only one non-zero out-of-plane moment. Behaviour is not defined for biaxial out-of-plane bending.

Bolt Groups in Other Connections

Other connections, such as the bolted splice, web side plate, and angle cleat connections have bolt groups that may be subjected to moment and shear. These bolt groups are checked using the above procedures, the analysis method being determined by the configuration setting in effect.

Note: The critical bolt is identified by row and column in the output results for a bolt group analysis. Rows are numbered from top to bottom and columns from left to right.

Weld Group (WGP)

Several types of weld group may be analysed by the linear elastic method as set out in Ref. 11. The instantaneous center method is less appropriate for weld groups than bolt groups because of the directional variability of weld element ductility. The IC method is not available in Limcon for any weld group.

Alternative Analysis

The alternative analysis option is available for some types of weld group composed of elements at right angles. Usually, all weld elements in a weld group are assumed to participate but with this option selected direct shear is resisted only by elements aligned with the shear force direction (see AS 4100 Cl. 9.8.2.2).
Lower and Upper Bound Theorems

The Lower Bound Theorem

If a set of bending moments can be found which satisfies equilibrium throughout the structure and which does not violate the yield condition anywhere, then the corresponding load is either less than or equal to the correct collapse load.

(Concrete Structures – Warner, Rangan, Hall, Faulkes – 1998.)

This theorem has great significance for connection design. For a ductile material like steel, it means that any convenient distribution of stresses that satisfies equilibrium and does not cause yield gives a computed strength not exceeding the true strength (i.e. it is conservative). Many design checks are justified by this theorem, e.g. the assumption in simplified section analysis that moment is resisted exclusively by the flanges and shear by the web.

The Upper Bound Theorem

The external load which is calculated from any assumed collapse mechanism is either greater than or equal to the correct collapse load.

(Concrete Structures – Warner, Rangan, Hall, Faulkes – 1998.)

This theorem is the basis for the yield line methods that are used for checking moment end plates and base plates. It means that an unconservative solution is obtained for an unrealistic assumed yield line pattern. It is therefore very important that yield line mechanisms be verified by testing before they are used for design.
Seismic Checks

There are four seismic connections in Limcon:
1. Welded flange plate (WFP)
2. Bolted flange plate (BFP)
3. Bolted unstiffened extended end plate (MEPC 4E)
4. Bolted stiffened extended end plate (MEPC 4ES)

When the configured design code is ANSI/AISC 360-05 each of these connection types may be checked for any of the seismic structure types, OMF, IMF, and SMF. The seismic rules are found throughout:

- Ref. 13 – FEMA-350
- Ref. 14 – SEAOC Commentary on FEMA-350
- Ref. 16 – ANSI/AISC 341-05 – Prequalified Connections
- Ref. 17 – AISC Seismic Design Manual

For seismic connections Limcon presents additional calculations at the end of the standard (non-seismic) report. These calculations follow through the design procedure laid out in one of the above reference documents. The seismic checks can be quite stringent and you might find it difficult to make the connection “work”. Seismic design is very interactive and not well suited to automatic sizing of the connection for compliance with all the rules.
Additional Checks

Connected Members
Limcon has insufficient information to perform comprehensive checks on the capacity of connected members. It is the designer’s responsibility to check that specified design actions can be sustained by the connected members.

Design checks are shown for the member where the connection design model includes them (e.g. WSP). In some connections section capacities are shown so that the design loads may be seen in context. This does not imply that the connection is safe for the section capacity. In hollow section connections, for example, the shear capacity in the connection may be substantially less than the theoretical section shear capacity because of the possibility of local buckling at the connection location.

Other Limit States
All limit states checked by Limcon are reported. It is the responsibility of the designer to consider whether there are other limit states that should also be checked.

Range Check on Input Values
Limcon checks many input parameters and displays a warning or error message when a parameter is outside a certain range of values. In some cases, it may be possible to enter untested or unusual values for a parameter. The designer should use engineering judgment to decide whether the input data is reasonable.

Welds
Specifying weld details is always the responsibility of the designer. Information concerning welds in Limcon output and details may not be sufficiently thorough for specification purposes.
Output References

A reference is shown in the rightmost column for many of the limit states reported in the Limcon output. It is usually a reference to a clause of the configured design code but there are also references to the notes in the table below.

<table>
<thead>
<tr>
<th>Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note 1</td>
<td>Flexural yield capacity ignoring section slenderness.</td>
</tr>
<tr>
<td>Note 2</td>
<td>Shear yield capacity ignoring slenderness.</td>
</tr>
<tr>
<td>Note 3</td>
<td>Tensile yield capacity of section.</td>
</tr>
<tr>
<td>Note 4</td>
<td>Compression yield capacity of section ignoring slenderness.</td>
</tr>
<tr>
<td>Note 5</td>
<td>Eccentricity moment shared 50% gusset plate, 50% attached plate.</td>
</tr>
<tr>
<td>Note 6</td>
<td>Eccentricity moment shared 90% gusset plate, 10% bracing member.</td>
</tr>
<tr>
<td>Note 7</td>
<td>Empirical factor representing increased buckling strength due to cover plates. Only permitted for two or more rows of tensioned bolts and effective length factor less than 1. It is the responsibility of the designer to determine whether this allowance is appropriate in the particular circumstances.</td>
</tr>
<tr>
<td>Note 8</td>
<td>Free length from end of brace to perpendicular yield line should be 2T for SCBF.</td>
</tr>
<tr>
<td>Note 9</td>
<td>Design code does not give shear lag factor for 1 bolt row.</td>
</tr>
<tr>
<td>Note 10</td>
<td>Shear capacity reduced by 20% with grout pad - see AISC SDG 1 p.29.</td>
</tr>
<tr>
<td>Note 11</td>
<td>Using elliptical interaction equation for combined shear and tension.</td>
</tr>
<tr>
<td>Note 12</td>
<td></td>
</tr>
<tr>
<td>Note 13</td>
<td></td>
</tr>
<tr>
<td>Note 14</td>
<td></td>
</tr>
<tr>
<td>Note 15</td>
<td></td>
</tr>
<tr>
<td>Note 16</td>
<td></td>
</tr>
<tr>
<td>Note 17</td>
<td></td>
</tr>
<tr>
<td>Note 18</td>
<td></td>
</tr>
<tr>
<td>Note 19</td>
<td></td>
</tr>
<tr>
<td>Note 20</td>
<td></td>
</tr>
</tbody>
</table>
References

1. ANSI/AISC 360-10 – Specification for Structural Steel Buildings
3. BS 5950-1:2000 – Structural Use of Steelwork in Building – Part 1:
   Code of Practice for Design of Rolled and Welded Sections.
7. Hollow Structural Sections Connections Manual
9. Joints in Steel Construction – Moment Connections
10. Joints in Steel Construction – Simple Connections
12. Design of Structural Steel Hollow Section Connections – Volume 1:
    Design Models – 1st Edition
13. Recommended Seismic Design Criteria for New Steel Moment-Frame
    Buildings – FEMA-350 – Chapter 3: Connection Qualification
14. Commentary and Recommendations on FEMA-350
15. ANSI/AISC 358-05 – Seismic Provisions for Structural Steel Buildings
16. ANSI/AISC 341-05 – Prequalified Connections for Special and
    Intermediate Steel Moment Frames for Seismic Applications
17. Seismic Design Manual
18. Flush and Extended Multiple Row Moment End Plate Connections
19. Extended End Plate Moment Connections – Seismic and Wind
    – Steel Design Guide 4
21. High Strength Bolts – A Primer for Structural Engineers – G.L Kulak
   – Steel Design Guide 17
22. Base Plate and Anchor Rod Design – 2nd Edition
23. Handbook of Structural Steel Connection Design and Details
   – G.L. Kulak & G.Y. Grondin
   – Canadian Institute of Steel Construction – 2002.
25. Hollow Structural Section Connections and Trusses – A Design Guide
   – J.A. Packer & J.E. Henderson
   – Canadian Institute of Steel Construction – 1997.
27. Design Model for Bolted Moment End Plate Connections Using Rectangular Hollow Sections
   – A.T. Wheeler, M.J. Clarke, G.J. Hancock, T.M. Murray
29. Seismic Behavior and Design of Gusset Plates
   – Abolhassan Astaneh-Asl
30. Design of Pinned Column Base Plates – G. Ranzi & P. Kneen
   – Australian Steel Institute
31. Gusset Plate Connection to Round HSS Tension Members
   – J.J. Roger Cheng & G.L. Kulak
32. The Design of Pins – R.Q. Bridge
   – S.T. Woolcock, S. Kitipornchai, M.A. Bradford
   – Australian Steel Institute – 1999.
34. Handbook 1 – *Design of Structural Steel Connections*
35. Design Guide 1 – *Bolting in Structural Steel Connections*
36. Design Guide 2 – *Welding in Structural Steel Connections*
37. Design Guide 3 – *Web Side Plate Connections*
38. Design Guide 4 – *Flexible End Plate Connections*
39. Design Guide 5 – *Angle Cleat Connections*
40. Design Guide 6 – *Seated Connections*
41. Design Guide 10 – *Bolted Moment End Plate Beam Splice Connections*
42. Design Guide 11 – *Welded Beam to Column Moment Connections*
43. Design Guide 12 – *Bolted End Plate to Column Moment Connections*
44. Design Guide 13 – *Splice Connections*
45. BS EN 1993-1-1:2005 – *Eurocode 3: Design of Steel Structures*  
46. BS EN 1993-1-5:2006 – *Eurocode 3: Design of Steel Structures*  
47. BS EN 1993-1-8:2005 – *Eurocode 3: Design of Steel Structures*  
   – N.S. Trahair, M.A. Bradford, D.A. Nethercot, L. Gardner  
50. *Designing Compact Gussets with the Uniform Force Method*
51. *Effective Length Factors for Gusset Plate Buckling*
52. *Hollow Structural Section Connections* – J.A. Packer, D.R Sherman,  
   M. Lecce – Steel Design Guide 24 – American Institute of Steel  
53. *Design Guide (1) for Circular Hollow Section Joints Under*  
   *Predominantly Static Loading* – J. Wardenier, Y. Kurobane,  


57. NCCI: Shear resistance of a fin plate connection

58. NCCI: Shear resistance of a simple end plate connection


5: DXF Output

General

Clicking on the DXF button in a connection dialog box outputs the connection detail to an AutoCAD-compatible DXF (Release 12). The detail is similar to the diagram of the connection displayed in the connection dialog box. Each time the DXF button is clicked a new DXF is created with a name of the form “Job name_connid.dxf”, where “Job name” is the job name and “connid” is the connection name input by the user (up to 20 characters). The DXF is saved to the data folder and a message box shows the path and name of the file written.

Any existing DXF for a particular connection will be overwritten the next time the DXF button is clicked while editing that connection.

The Header DXF

Drafting variables such as line types and dimension style are specified in the header DXF. This is a file called Limcon.dxf that is located in the Limcon library folder, normally ‘Limcon Lib’. The header DXF is, in effect, a prototype drawing to which the connection detail is added. It is read by Limcon, interpreted as required, and written to the output DXF. The Limcon.dxf file distributed with Limcon is compatible with AutoCAD Release 12. When the special version, Limcon_US.dxf, is available DXF units will be inches when US customary units are selected. It may be changed as required by editing with a text editor, such as MsEdit. Items that may be changed include layer names, colors, line types, and the dimensioning variables. To avoid the possibility of conflicts between the prototype drawing and the header DXF, it is recommended that your CAD program is configured for no prototype drawing.
You may select the **File > Configure > DXF** command to determine the layers for the various components of the drawing. The dialog box below shows the default layer names, each of which already appears in the header DXF (layer “0” is also included). Adding a new layer name necessitates the addition of a block of data for that layer in the header DXF.

The text style must also be included in the header DXF. The text height and dimension text height is determined by the value in the dialog box.
6: Editing the Section Library

General

Limcon refers to the current steel section library for information required for checking, and design of steel connections. The **File > Configure > Section Library** command allows you to select any available library as the current library. Using the method described below you may edit the library. Special section libraries may also be created.

Section Library

Limcon library files have the file name extension “lib” (e.g. Asw.lib, Uk2000.lib) and cannot be listed, printed, or edited. For each library file there is a corresponding source file, an ordinary text file having a file name extension “asc”. Library source files may be manipulated by the Section Library Manager.

**Section Name**

Each section has a unique section name with up to 15 characters. Blanks are not permitted. The section name must have one contiguous alphabetic group between 1 and 4 characters long. This is the **section mnemonic**.

**Section Mnemonic**

The section mnemonic is used in Limcon for identifying the section type. It is embedded in the section name and, apart from “X”, is the only part of the name that may be alphabetic. An “X” character contiguous with the section mnemonic is part of the section mnemonic. Apart from the section mnemonic, “X” characters with numeric characters before and after may be included in the section name.

Examples of valid section names are, “200UB25.4”, “88.9X2.6CHS”, “CTT380X100”, “100XX”, “XX100”, and “W14x311”. Invalid names include “200UB25.4H1” (two separate alphabetic groups), “CTT380X100X” (trailing X), “X200UB25.4” (leading X), and “XXBOX100” (mnemonic exceeds 4 characters).

When adding new sections to a library you may choose any suitable section mnemonic. A single character “E”, however, may not be used as
a section mnemonic because the section name would then be confused as a number in exponential format.

**Section Categories**

Each group of sections in the library is assigned a *section category*. Every section in a section category should have the same section mnemonic. The section category number is shown in the library source file under the heading SC. When choosing a section, you first choose the section category and Limcon then displays all the sections in the category. All sections within a category must have the same design type and section mnemonic.

**Design Type**

For design purposes each section is classified according to its *design type*. The design type number is shown in the library source file under the heading DT. The design type is used to interpret the section properties and it determines the applicable design code rules. The table below lists valid design types, together with some of the common section mnemonic codes for these types.

<table>
<thead>
<tr>
<th>DT</th>
<th>Mnemonic</th>
<th>Section Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TFB</td>
<td>Taper flange beam</td>
</tr>
<tr>
<td>2</td>
<td>UB, WB</td>
<td>Universal beam or welded beam</td>
</tr>
<tr>
<td>3</td>
<td>UC, WC</td>
<td>Universal column or welded column</td>
</tr>
<tr>
<td>4</td>
<td>RHS</td>
<td>Rectangular hollow section</td>
</tr>
<tr>
<td>5</td>
<td>SHS</td>
<td>Square hollow section</td>
</tr>
<tr>
<td>6</td>
<td>CHS</td>
<td>Circular hollow section</td>
</tr>
<tr>
<td>7</td>
<td>PFC</td>
<td>Parallel flange channel</td>
</tr>
<tr>
<td>8</td>
<td>BT, CT</td>
<td>Tee section</td>
</tr>
<tr>
<td>9</td>
<td>EA</td>
<td>Equal angle</td>
</tr>
<tr>
<td>10</td>
<td>UA</td>
<td>Unequal angle</td>
</tr>
<tr>
<td>11</td>
<td>DAL</td>
<td>Double angles, long legs together</td>
</tr>
<tr>
<td>12</td>
<td>DAS</td>
<td>Double angles, short legs together</td>
</tr>
<tr>
<td>16</td>
<td>STA</td>
<td>Starred angles</td>
</tr>
<tr>
<td>22</td>
<td>QAN</td>
<td>Quad angles</td>
</tr>
<tr>
<td>13</td>
<td>UBP</td>
<td>Universal bearing pile</td>
</tr>
<tr>
<td>17</td>
<td>TFC</td>
<td>Taper flange channel</td>
</tr>
<tr>
<td>18</td>
<td>ROD</td>
<td>Round</td>
</tr>
<tr>
<td>19</td>
<td>BAR</td>
<td>Rectangular bar</td>
</tr>
<tr>
<td>20</td>
<td>CTT</td>
<td>Double channels, toes together</td>
</tr>
<tr>
<td>21</td>
<td>CBB</td>
<td>Double channels, back-to-back</td>
</tr>
<tr>
<td>24</td>
<td>CA</td>
<td>DuraGal cold-formed angle</td>
</tr>
<tr>
<td>25</td>
<td>CC</td>
<td>DuraGal cold-formed channel</td>
</tr>
</tbody>
</table>
30  -  Section with analysis properties only  
33  UI  Unsymmetrical I section  
34  BOX  Box section  
35  C  Lipped cee  
36  Z  Lipped zed

**Steel Grades**

Limcon determines yield and ultimate tensile stresses from recognized steel grades. Up to three grades, G1, G2, and G3, may be included for each section. If there is only one grade available for a section, enter it as G1 and enter zero for G2 and G3. If there are two grades available, G3 must be zero.

**Residual Stress Code**

Limcon distinguishes welded sections from rolled sections by the residual stress code (“f” in the table below).

<table>
<thead>
<tr>
<th>f</th>
<th>Section Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Stress relieved</td>
</tr>
<tr>
<td>2</td>
<td>Hot-rolled</td>
</tr>
<tr>
<td>3</td>
<td>Cold-formed</td>
</tr>
<tr>
<td>4</td>
<td>Lightly welded</td>
</tr>
<tr>
<td>5</td>
<td>Heavily welded</td>
</tr>
</tbody>
</table>
Section Library Manager

Library source files may be manipulated by the Section Library Manager.

After you have selected the destination library, either an existing library source file or a new one, the dialog box below is displayed. A tree view of the destination library, empty if new, is shown on the right while all available library source files are shown on the left. Each library may be expanded to show the section categories and each of these may be expanded to show the sections contained in the category.

**SECTION LIBRARY MANAGER**

You may select any library, category, or section on the left and click the arrow button to send it to the destination library on the right. Double-clicking a section on the right will display a dialog box in which you may alter any value.

**Section Properties Dialog Box**

The properties of any section in the destination library may be displayed by right-clicking the section and choosing Section Properties on the pop-up menu. Double-clicking the section will also display the section properties dialog box. The dialog box shows all the values stored in the library for the section. Any values that are not disabled in the dialog box may be changed. Click the button at the top and then click on any item for help. Clicking the Compute button computes all derived values from the current dimensions. The Restore button sets all edit boxes back to their original values.
SECTION PROPERTIES DIALOG BOX FOR I SECTION

The G1, G2, and G3 boxes show the grades in which the section is available. Only grades recognized by Limcon should be used – see “Steel Grades” on p. 39. No more than three grades are permitted and unspecified grades must be zero. If one grade is specified it must be G1 and if two are specified they must be G1 and G2.

Section property dialog boxes for some sections have an **Ax, Ay** button, which computes shear areas. Shear areas are not used by Limcon.
Compiling a Library

When you click the Save button Limcon offers to compile the new library file. Click Yes in the dialog box below to do this.

![Dialog box for compiling library](image)

**COMPILING THE LIBRARY**

The library compiler reads and interprets the library source file and writes a Limcon library file. The value of any section property value input as zero is computed automatically provided sufficient dimensions for the calculation have been input. When compilation has finished successfully a report is displayed, as shown below. This report lists any errors or inconsistencies detected in the input data. The library report for the current library may be displayed from the Limcon File > Configure menu.

All section property values are computed from the section dimensions and where the corresponding input value differs by more than 1%, a warning message results. Section properties are computed only approximately for some taper flange sections and warnings for these sections may not be valid.

**Note:** Microstran and Limcon libraries are compatible.

![Library content window](image)
Web Side Plate / Single Plate / Fin Plate Connection

This is the design example from p. 76 of *Design of Structural Connections*. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box. Many different styles of printout may be obtained by adjusting parameters in the Page Setup dialog box (**File > Page Setup** command).
**Limcon V3.5**

**Connection: WSP - Web Side Plate**

**Plate:** 180x8x210 Gr.250

**Weld:** 8 Fw480/Sp to support B/S

**Bolts:** 6-M20 8.8/S/N in 2 cols.

**Beam:**
- Hard=21
- Section=410UB33.7
- Grade=300
- Span=5000 mm

**Dimensions:**
- D = 401 mm
- Root rad. = 11.4 mm
- fty = 350 MPa
- g = 27.5 mm
- Area = 6.090E+03
- fty = 350 MPa
- 7b = 10.3 mm
- Sx = 1.060E+06
- fu = 440 MPa
- Tz = 7.6 mm

**Copw dimensions:**
- Top: Not copped
- Bottom: Not copped

**Plate:**
- Size=8x210 Gr./fy=fw=480/250/410 MPa

**Bolts:**
- 6-M20 8.8/S/N in 2 cols. at 70 pitch.
- Support 6 at column 50, horizontal spacing between columns 70.

**Weld:**
- 8 Fw480 MPa/Sp to support.

**Support:**
- Hard=21
- Section=500x266.2
- Grade=300
- D = 500 mm
- Root rad. = 11.4 mm
- fty = 350 MPa
- g = 27.3 mm
- Area = 8.900E+03
- fty = 350 MPa
- 7b = 7.7 mm
- Sx = 1.060E+06
- fu = 440 MPa

**Connection to column flange:**

**Minimum shear force check**

Limcon [V3.5]
Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if the shear force is less than the specified minimum (40 kN) for all load cases.

Shear force exceeds specified minimum in at least one load case.

**Shear, V**: 100.0 kN

**Axial, N**: 0.0 kN

Using ASt 2007 model...

**Centricity**: 90.0 mm

**Centricity moment, N**: 14.2 kNm

**GEOMETRY CHECKS...**

**CHECK 1 - Details:**

Ref. 34: Steel Connections Design Guide 5 - Web Side Plate Connection

Australian Steel Institute - 2007

Plate fillet weld size: 8.0 >= 6.0 Pass

Bolt diameter: 20.0 <= 20.0 Pass

Bolt ultimate strength: 550 <= 530 Pass

N. bolt row: 3 >= 2 Pass

Bolt spacing, sp: 70.0 <= 50.0 Pass

Bolt gauge: 70.0 <= 50.0 Pass

Plate unsupported length: 55.0 <= 50.0 Pass

Plate thickness: 250 <= 250 Pass

Plate depth: 210.0 <= 200.0 Pass

Plate vertical edge distance: 35.0 >= 20.0 Pass

Clearrance to support: 20.0 <= 20.0 Pass

N. bolt row: 3 >= 2 Pass

N. web thickness: 320 <= 320 Pass

N. horizontal edge distance: 35.0 <= 30.0 Pass

**DESIGN CAPACITY CHECKS...**

Capacity ratio: 1.0

Design action: +/- Design capacity: Pass

**CHECK 2 - Welds:**

Weld length (each side): 210 mm

Weld penetration: 109.4 <= 200.0 Pass

Weld capacity: 100.0 >= 100.0 Pass

**CHECK 3 - Bolts:**

Bolt shear: 92.6 > V <= 66.1.1.40 Pass

Bolt bearing: (critical bolt row, column): 166.9 <= V <= 66.1.2.04 Pass

Bolt group int. tearing (Vert.): 114.4 <= V <= 66.1.82.97 Pass

Bolt group int. tearing (Horiz.): 171.2 <= V <= 66.1.93.82 Pass

Bolt group int. tearing (Horiz.): 174.6 <= V <= 66.1.4.15 Pass

**CHECK 4 - Plates:**

Shear capacity: 221.7 <= V <= 100.0.1.40 Pass

Plate moment capacity: 247.0 <= V <= 100.0.1.40 Pass

Plate block shear capacity: 405.7 <= V <= 100.0.2.4 Pass

---

Limcon [V3.5]
CHECK 3 - Beam Shear:
Sheet capacity (non-slender web) . . . . . . . . . . 529.3 > V' = 100.0 x 2.94 Pass

CHECK 6 - Beam Block Shear:
Beam not copped - check not necessary.

CHECK 7 - Coped Beam Bending:
Beam not copped - check not necessary.

CHECK 8 - Beam Rotation:
Rotation for UDL (rad.) . . . . . . . . . . . 0.020 <= 0.020 FAIL Inoperative
Rotation for contact (rad.) . . . . . . . . . . . 0.999
Contact rotation capacity . . . . . . . . . . . . . 605.8 > V' = 100.0 x 3.36 Pass
Max. bolt shear deformation . . . . . . . . . . . . . 1.0 <= 1.0 Pass

CHECK 9 - Coped Beam Buckling:
Beam not copped - check not necessary.

CHECK 10 - Support Member:
Supporting column flange - check not necessary.

CRITICAL LIMIT STATE . . . . Weld capacity
UTILIZATION RATIO . . . . . . 94
CAPACITY RATIO, a.R/8', . . . . 1.150 Pass
Flexible End Plate Connection

This is the design example from p. 58 of Design of Structural Connections. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Limcon V3.5**

**Engineering Systems Development**

**AX FE P.0—Connection FEP**

**Flexible End Plate Design Example**

"Design of Structural Connections" p. 58

---

**CONNECTION: FEP - Flexible End Plate**

- **End plate:** 150x8x210 Gr 250
- **Weld:** 6 Fw/480 SP to beam (B/S)
- **Bolts:** 6 M20 8.8/S/N of 90 gauge 70 pitch

---

**Top cope = 66x120**

---

**Limcon V3.5**

**29-JUN-07**

**15:12:03**

---

**Connection: FEP**

**Type:** Flexible End Plate

**Country:** Australia

**Units:** Metric

**Design code:** AS 4100 (RSH 2007)

**Beam:** Hardw=1 Section=410UB33.7 Grade=300 Span=5000 mm
- **D =** 403 mm Root rad. = 11.4 mm f_yf = 350 MPa
- **s =** 275 mm Area = 6.1996E+02 f_yw = 320 MPa
- **7e =** 10.9 mm Ez = 1.0600E+06 fu = 440 MPa

**Cope dimensions:** Top: Depth = 65 Length = 120

**Bottom:** Not cope

**Support:** Hardw=2 Section=I00UB30 Grade=300
- **D =** 602 mm Root rad. = 14.0 mm f_yf = 350 MPa
- **s =** 223 mm Area = 1.3008E+04 f_yw = 320 MPa
- **7e =** 14.3 mm Ez = 1.9080E+06 fu = 440 MPa

**Connection to beam web:**

**End plate:**
- 210x150x8 Gr./f/f=250/320/410 MNa
- Weld 6 Fw/480 MPa/6 to web of beam.
- Bolts 6 M20 8.8/S/N in 3 rows at 70 pitch and 90 gauge.

**MINIMUM SHEAR FORCE CHECK**

Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if the shear force is less than the specified minimum [40 KN] for all load cases.

* Shear force exceeds specified minimum in at least one load case.
INPUT DESIGN ACTIONS
Shear, V' .......................... 200.0 kN
Axial, N' ................................ 9.0 kN

Using ASI 2007 model...

GEOMETRY CHECKS...
CHECK 1 - Details:
Ref: 3E; Steel Connections Design Guide 6 - Flexible End Plate Connection
Australian Steel Institute - 2007
Plate fillet weld size ...................... 6.0 => 6.0 Pass
Bolt diameter ............................. 20.0 => 20.0 Pass
Bolt ultimate stress ...................... 840 => 830 Pass
N.B. Bolt twist ............................ 3 => 3 Pass
Bolt gauge, eg .......................... 90.0 => 72.0 Pass
Plate fy .................................. 80.0 <= 112.0 Pass
Plate thickness ........................... 9.0 => 8.0 Pass
Plate depth ................................ 220 => 200 Pass
Plate bottom edge distance ............... 30 => 30 Pass
Plate horizontal edge distance .......... 30 => 30 Pass
Beam fy ................................... 320 => 200 Pass
Beam thickness ........................... 240 => 400 Pass

DESIGN CAPACITY CHECKS...

<table>
<thead>
<tr>
<th>Capacity ratio</th>
<th>Design action</th>
</tr>
</thead>
</table>

CHECK 2 - Welds:
Weld length (each side) ......... 210 mm
Weld shear capacity .............. 410.6 > V' = 200.0 2.05 Pass

CHECK 3 - Bolts:
Bolt shear capacity ........................ 555.0 > V' = 200.0 2.78 Pass
Plate concrete bearing capacity .... 1231.6 > V' = 200.0 5.67 Pass
Plate concrete shear capacity ....... 600.0 > V' = 200.0 3.00 Pass

CHECK 4 - Plates:
End plate shear capacity ........... 433.4 > V' = 200.0 2.17 Pass
Plate block shear capacity .......... 446.3 > V' = 200.0 2.17 Pass

CHECK 5 - Beam Web at End Plate:
Beam web shear capacity at end plate .... 275.0 > V' = 200.0 1.37 Pass

CHECK 6 - Beam Shear:
Coped web shear capacity ............ 387.3 > V' = 200.0 1.94 Pass

CHECK 7 - Coped Beam Bending:
Section bending capacity .............. 97.2 kN/m
Estimated max. cope length ........... 400 mm

CHECK 8 - Beam Rotation:
Rotation for CDD (rad.) .............. 0.028
Rotation for contact (rad.) .......... 0.043
Contact rotation capacity ............. 440.6 > V' = 200.0 2.20 Pass

CHECK 9 - Coped Beam Buckling:
NOTE: Coped beam must be restrained against lateral torsional buckling.
Top cope depth .......................... 88.0 <= 200.8 Pass
Web yield stress, fyw .................. 320 N/mm²
Web slenderness, fyw/G 320 N/mm² <= 320.0 Pass
Max. to/d for cope length ≤ D .... 50.0
Max. cope length ........................ 340 mm
Top cope length ........................ 120 <= 344.7 Pass

At above geometric requirements are satisfied, the coped web does not have to be checked for buckling.

Buckling check to ASCE 1990 p.3.7 (Cheng, Y. and Johnstone...)
Critical stress, fcr ................... 661 N/mm²
Critical stress, fcr <= fyw .......... 320 N/mm²
Examples Limcon V3.5

Engineering Systems Development

Contribution FEP

Flexible End Plate Design Example

"Design of Structural Connections" p 58

- 104 -

Limit State V3.5

Single coped web buckling capacity . . . . . 203.3 > V* = 200.0 2.52 Pass Informative

Estimated max. cope length . . . 310 mm

CHECK 10 - Support Members:

Support beam local shear capacity . . . . . 2205.3 > V* = 200.0 11.0 Pass

Shear capacity - beam both sides . . . . . 2205.3 > V* = 400.0 5.51 Pass Informative

Support beam web bearing capacity . . . . . 411.9 > V* = 200.0 2.04 Pass

Bearing capacity - beam both sides . . . . . 411.9 > V* = 400.0 4.70 Pass Informative

Support beam web tearing capacity . . . . . 1460.8 > V* = 200.0 7.35 Pass

Tearing capacity - beam both sides . . . . . . 1460.8 > V* = 400.0 9.65 Pass Informative

CRITICAL LIMIT STATE . . . Beam web shear capacity at end plate

Utilization Ratio . . . . . . . . 729

CAPACITY RATIO, n,Ru/S* . . . . . . . . . . 1.970 Pass
Bolted Flange Plate Connection

This example illustrates the additional design checks carried out for seismic connections. Seismic design capability is enabled only when the design code is ANSI/AISC 360.
106 • 7:Examples

Limcon V3.5

Engineering Systems Development
Job: VTP - Connection EFF.3

Connection: EFF.3
Type: Flange Plate Connection
1. All bolted
2. Plate Flange
3. All 4 Bolts

Beam: W250 10.90 lbs/in

Flange plate:
9"x10.75" 0.375" Gr.60 (36.6/64.0/68 ksi)

Flange plates:
16"x10.75" 0.375" Gr.60 (36.6/64.0/68 ksi)

Plate to column welds:
CJPWB for 70 ksi top flange plate
CJPWB for 70 ksi bottom flange plate

Limcon V3.50b
**Limcon V3.5**

Engineering Systems Development
Job UFP7-5157 - Connection E07-3

---

**Bolts:**

- 2-1/2" A490PT X each flange, 4" gauge 3/4" spacing.
- 2-1/2" A490PT X shank plate at 3/4" spacing.

**Stiffeners:**

- Gr.70/Fy=Fw=36.0 ksi, Weld for 70 ksi
- 2/3.15 x 20.25" top, 2.25" Fw across ends.
- 2/3.15 x 20.25" bottom, 0.25" Fw and across ends.

**Web doubler plates:**

- 16.42x11.40x70.3125 Gr.70/Fy=Fw=36.0 ksi
- No. web doubler plate = 4
- Weld OFF/Fw=70 ksi all around.

**MINIMUM ACCURACY CHECKS:**

- Specified minimum design actions:
  - Bending: 30% of 400 ksi = 120.4 kip
  - Stress: 9.0 kip
  - Tension: 90% of 400 ksi = 360 kip
  - Compression: 10% of 400 ksi = 40 kip

**NOTE:** Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if any design action is less than the specified minimum for all load cases.

**INPUT DESIGN ACTIONS:**

- Moment, Mx: 2088.0 kip-m
- Shear, Vx: 42.9 kip
- Axial, N: 0.0 kip

**Using AISC 2005 model...**

**GEOMETRY CHECKS:**

**For Special Moment Frames:**

- AASHTO/AISC 341-05 (Seismic Provisions) rules:
  - Beam flange b/r ratio: 5.0 <= 7.2: Pass A-341 5.2b
  - Beam web b/r ratio: 44.7 <= 55.0: Pass A-341 5.2b
  - Column flange b/r ratio: 7.1 <= 7.2: Pass A-341 5.2b

**FEMA-350 prequalification rules:**

**NOTE:** FEMA recommendations do not permit use of this connection type for IM or SNF.

**Beam depth:**

- 10.92 <= 31.0: Pass

**Beam depth:**

- 16.75 <= 6.0: Pass F-350 T3-10

**Beam depth:**

- 16.75 <= 0.75: Pass F-350 T3-10

**Beam depth:**

- 60.0 <= 60.0: Pass F-350 T3-10

**Column depth:**

- 14.70 <= 14.00: Pass F-350 T3-10

**Column depth:**

- 50.0 <= 50.0: Pass F-350 T3-10

**Flange plate yield stress:**

- 50.0 <= 50.0: Pass F-350 T3-10

**Flange plate yield stress:**

- 50.0 <= 50.0: Pass F-350 T3-10

**Flange plate yield to column:**

- 5.00 <= 0.75: Pass F-350 T3-10

**Flange plate yield to column:**

- 5.00 <= 0.75: Pass F-350 T3-10

**Flange plate yield to column:**

- 5.00 <= 0.75: Pass F-350 T3-10

**Flange plate yield to column:**

- 5.00 <= 0.75: Pass F-350 T3-10

**Flange plate yield to column:**

- 5.00 <= 0.75: Pass F-350 T3-10

**Flange plate yield to column:**

- 5.00 <= 0.75: Pass F-350 T3-10

**Calculated strength checks...**

<table>
<thead>
<tr>
<th>Strength ratio</th>
<th>Design strength</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam:</td>
<td></td>
</tr>
<tr>
<td>Flexural strength [tensile rupture]</td>
<td>2983.2 &gt; Hu = 2985.0 1.00 Pass</td>
</tr>
<tr>
<td>Shear Plates:</td>
<td></td>
</tr>
<tr>
<td>Shear strength of bolts</td>
<td>123.0 &gt; Vu = 42.0 2.91 Pass</td>
</tr>
<tr>
<td>Torsion strength of plate</td>
<td>117.0 &gt; Vu = 42.0 2.85 Pass</td>
</tr>
<tr>
<td>Shear strength of web</td>
<td>126.4 &gt; Vu = 42.0 3.10 Pass</td>
</tr>
<tr>
<td>Torsion strength of web</td>
<td>120.0 &gt; Vu = 42.0 2.67 Pass</td>
</tr>
<tr>
<td>Shear yield strength</td>
<td>72.6 &gt; Vu = 42.0 1.74 Pass 76-3</td>
</tr>
<tr>
<td>Shear rupture strength</td>
<td>55.1 &gt; Vu = 42.0 1.21 Pass 94-4</td>
</tr>
<tr>
<td>Block shear strength</td>
<td>62.0 &gt; Vu = 42.0 1.65 Pass 94-3</td>
</tr>
<tr>
<td>Tension Flange Plate:</td>
<td></td>
</tr>
<tr>
<td>Bolt design force</td>
<td>159.6 kip</td>
</tr>
<tr>
<td>Shear strength of bolts</td>
<td>444.3 &gt; Fyf = 159.6 2.88 Pass</td>
</tr>
<tr>
<td>Torsion strength of plate</td>
<td>1038.0 &gt; Fyf = 159.6 8.65 Pass</td>
</tr>
</tbody>
</table>

Limcon (V3.50b)
**Limcon V3.5**  
**Engineering Systems Development**  
**Job: UFP/Unit - Connection EFF3.3**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tearing strength of plate</td>
<td>1248.8 &gt; Pfu  = 159.6  7.00 Pass</td>
</tr>
<tr>
<td>Tearing strength of flange</td>
<td>707.9 &gt; Pfu  = 159.6  6.64 Pass</td>
</tr>
<tr>
<td>Tearing strength of flange</td>
<td>774.7 &gt; Pfu  = 159.6  6.25 Pass</td>
</tr>
<tr>
<td>Plate design force</td>
<td>140.3 kip</td>
</tr>
<tr>
<td>Tension yielding strength</td>
<td>435.9 &gt; Pfu  = 149.3  2.92 Pass 3D-1</td>
</tr>
<tr>
<td>Tension rupture strength</td>
<td>266.1 &gt; Pfu  = 149.3  2.00 Pass 3D-2</td>
</tr>
<tr>
<td>Block shear strength of plate</td>
<td>758.9 &gt; Pfu  = 149.3  4.04 Pass 3A-4</td>
</tr>
<tr>
<td>Block shear strength of flange</td>
<td>324.2 &gt; Pfu  = 149.3  2.19 Pass 3A-4</td>
</tr>
</tbody>
</table>

**Compression Flange Plate:**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate design force</td>
<td>140.3 kip</td>
</tr>
<tr>
<td>Effective strength (kip)</td>
<td>1.20 in.</td>
</tr>
<tr>
<td>Compression strength of flange plate</td>
<td>435.9 &gt; Pfu  = 149.3  2.92 Pass 3D-1</td>
</tr>
</tbody>
</table>

**SEISMIC DESIGN PROCEDURE...**

**References:**

F-350  -  FFM-350: Recommended Seismic Design Criteria for New Steel Moment Frame Buildings
SEAC - Commentary and Recommendations on FFM-350 - January 2002
A-341 - AISC/AISC 318-05: Seismic Provisions for Structural Steel Buildings
A-351 - AISC/AISC 350-05: Seismic Connections for Special and Intermediate Steel Moment Frames for Seismic Applications

**Peak strength coefficient, C_{ps}**  
F-350  3-3

**Beam yield ratio, PoM**  
A-341  1-6-1

**Probable plastic moment at hinge, M_{pr}**  
F-350  3-1

**Span (col/bracket), L**  
F-350  3-1

**Plastic hinge offset, D**  
A-341  1-6-1

**Distance between plastic hinges, D**  
F-350  3-1

**Nimet at column face, MF**  
F-350  3-1

**Moment at column centerline, Mo**  
F-350  3-1

**Coefficient, C_{sym}**  
F-350  3-1

**Steel moment at column face, Mf**  
F-350  3-3

**Column load ratio, Mf/M**  
A-341  1-6-1

**Panel zone thickness, t**  
F-350  3-4

**Flange plate thickness, t_{ps}**  
F-350  3-4

**Hinge for shear failure of bolts**  
F-350  3-4

**Flange plate thickness, t_{ps}**  
F-350  3-4

**Flange plate thickness, t_{ps}**  
F-350  3-4

**Flange plate yield stress**  
F-350  3-4

**Bolt hole elongation force (flanges)**  
F-350  3-4

**Bolt hole elongation force (bolts)**  
F-350  3-4

**Hinge for elongation of bolt holes**  
F-350  3-4

**Nimet at column centerline, Mo**  
F-350  3-4

**Moment at column face, Mf**  
F-350  3-4

**Flange plate yield stress**  
F-350  3-4

**Flange plate yield stress**  
F-350  3-4

**Hinge for yield failure**  
F-350  3-4

**Seismic design shear**  
F-350  3-5

**Design factors**  
F-350  3-5

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shear strength of bolts</td>
<td>177.7 &gt; Wv = 82.2  2.16 Pass</td>
</tr>
<tr>
<td>Bearing strength of plate</td>
<td>145.6 &gt; Wv = 82.2  2.16 Pass</td>
</tr>
<tr>
<td>Tearing strength of plate</td>
<td>145.6 &gt; Wv = 82.2  2.16 Pass</td>
</tr>
<tr>
<td>Tearing strength of web</td>
<td>145.6 &gt; Wv = 82.2  2.16 Pass</td>
</tr>
<tr>
<td>Bearing strength of plate</td>
<td>145.6 &gt; Wv = 82.2  2.16 Pass</td>
</tr>
<tr>
<td>Tearing strength of plate</td>
<td>145.6 &gt; Wv = 82.2  2.16 Pass</td>
</tr>
<tr>
<td>Bearing strength of plate</td>
<td>82.1 &gt; Wv = 82.2  2.16 Pass</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical load state</td>
<td>Flexural strength (tensile rupture)</td>
</tr>
<tr>
<td>Utilization ratio</td>
<td>100%</td>
</tr>
<tr>
<td>Strength ratio</td>
<td>1.004 Pass</td>
</tr>
</tbody>
</table>
Bolted Moment End Plate Connection

This is the design example from p. 115 of Design of Structural Connections. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Limcon V3.5**

Page 1 of 3
31 Dec 2006
9:16 PM

**Connection: BMEP - Bolted Moment End Plate**

- End plate: 260x250x6.4 Gr 250
- Flange weld: F6W/480/SP
- Web weld 6 F6W/480/SP

**Bolt:** 6 M24 II BS/N in 2 cols. at 140 gauge

---

**Geometry Check:**

- ***W260x100*** -- End plate side edge distance < 1.6 x dia.
  - 0 fixtures
  - 1 warning

**LIMCON V3.5**

31 OCT 06

**Connection: BMEP**

Type: Bolted Moment End Plate Connection

- End plate square to beam

**Units:** Metric

**Design code:** A5 4100 (AAS 2006)

**Beam 1:**

- Section: 410W35.7
- Grade: 250
- Angle: 0.0 deg.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth (D)</td>
<td>403 mm</td>
</tr>
<tr>
<td>Root Rad.</td>
<td>11.4 mm</td>
</tr>
<tr>
<td>fy</td>
<td>320 MPa</td>
</tr>
<tr>
<td>Area</td>
<td>6,988.8E+0</td>
</tr>
<tr>
<td>fyw</td>
<td>320 MPa</td>
</tr>
<tr>
<td>Tw</td>
<td>10.4 mm</td>
</tr>
<tr>
<td>Ex</td>
<td>1.040E+06</td>
</tr>
<tr>
<td>fu</td>
<td>440 MPa</td>
</tr>
<tr>
<td>Tv</td>
<td>7.4 mm</td>
</tr>
</tbody>
</table>

**Column:**

- Section: 410CU39.7
- Grade: 250

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth (D)</td>
<td>260 mm</td>
</tr>
<tr>
<td>Root Rad.</td>
<td>14.9 mm</td>
</tr>
<tr>
<td>fy</td>
<td>280 MPa</td>
</tr>
<tr>
<td>Area</td>
<td>6,988.8E+0</td>
</tr>
<tr>
<td>fyw</td>
<td>280 MPa</td>
</tr>
<tr>
<td>Tw</td>
<td>17.2 mm</td>
</tr>
<tr>
<td>Ex</td>
<td>1.030E+06</td>
</tr>
<tr>
<td>fu</td>
<td>440 MPa</td>
</tr>
<tr>
<td>Tv</td>
<td>10.4 mm</td>
</tr>
</tbody>
</table>

**End plate:**

- 54x400x15 Gr./fy/=350/250/410 MPa
- Beam to end plate angle, e = 90,000 deg.

**Beam welds:**

- F6W fy=480 MPa/SP flanges.
- 6 F6W fy=480 MPa/SP web.

Limcon (V3.50b)
Limcon V3.5

Engineering Systems Development
Job: BMEP p.115 - Convac EBP
Bolted Moment End Plate Design Examples
*Design of Structural Connections* p. 115

Bolts:
- 4-H4 0.75/5/8 top flange, 140 gauge at 130 spacing.
- 2-H4 0.75/5/8 top flange, 140 gauge.

Frying factor = 0.50

Stiffeners:
- 2/4 x 6 top. 8 FW access ends.
- 2/4 x 6 bottom. 6 FW full length and access ends.
- 2/4 x 6 sheet, 5 FW 155 above midpoint and across ends.

**MINIMUM ACTION CHECK**

**Specified minimum design actions:**
- Bending: 10% of 66.3 ft lb (305.5 kN-m) = 30.6 kN-m
- Shear: 10.0 kN
- Axial: 40.0 kN

**Tension**
- 0% of 66.3 kN = 0.0 kN

**Compression**
- 0% of 66.3 kN = 0.0 kN

**NOTE:** Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if any design action is less than the specified minimum for all load cases.

**INPUT DESIGN ACTIONS**

Beam 1:
- Moment, M = 210.0 kN.m
- Shear, V = 180.0 kN
- Axial, N = 0.0 kN
- Column:
- Moment, M = 0.0 kN.m
- Shear, V = 0.0 kN
- Axial, N = 0.0 kN

**Using AAS 1994 model...**

**ANALYSIS REPORT**

**Elastic analysis:**

Beam 1...
- M = 435.6 kN-m
- N = 0.0 kN
- W = 39.2

**Plastic analysis:**

Beam 1...
- M = 424.5 kN-m
- N = 0.0 kN
- W = 43.5

**Simplified analysis:**

Beam 1...
- M = 538.6 kN-m
- N = 0.0 kN

**NOTE:** Elastic analysis results used.

**DESIGN CAPACITY CHECKS**

<table>
<thead>
<tr>
<th>Capacity ratio</th>
<th>Design action</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Flanges:**

- Flange tension capacity = 588.0 > N ft = 435.6 kN-ft = Pass
- Flange compression capacity = 588.0 > N ft = 435.6 kN-ft = Pass

**Flange welds:**

- Using full penetration butt weld, f = 40 ksi
- Flange FBE tension capacity = 588.0 > N ft = 435.6 kN-ft = Pass
- Flange FBE compression capacity = 588.0 > N ft = 435.6 kN-ft = Pass

**Web:**

- Shear capacity (non-sleender web) = 0.970 x V = 150.0 kN = Pass

**Web welds:**

- Web bending moment = 39.2 kN-m
- Using 6 fillet weld, f = 40 ksi, both sides
- Web fillet weld capacity = 0.970 x V = 0.333 kN-ft = Pass

**Bolts:**

- M24
- Bolt UD = 0.93 > 0.27 = Pass

**M385:** Bolts must be tensioned.

**Tensile strength** = 234.4 kN

Beam 1

- Bolt group tension = 539.4 kN

Limcon V3.5

Limcon V3
Bolt group shear force ....... 180.0 kN
Bolt group tensile capacity (incl. paying) 711.0 > N / f_c = 555.6 1.30 Pass
No. bolts in compression region 2
Bolt shear capacity ......... 266.0 > V_t = 150.0 1.78 Pass
Plate bearing capacity ......... 1417.0 > V_b = 150.0 7.44 Pass
Column flange bearing capacity ......... 1022.0 > V_b = 150.0 7.02 Pass
End plate:
546x209x25 - Scr./f_y=250/250/410 MPa
End plate flexural capacity ......... 558.9 > M / f_y = 558.6 1.00 Pass
End plate shear capacity ......... 1125.0 > V_t = 150.0 7.50 Pass
Column stiffening...
Tension flange - top
Unstiffened capacity ......... 586.7 > N / f_y = 555.6 1.04
Stiffener required due to overlapping stress regions.
Compression flange - bottom
Unstiffened capacity ......... 457.4 > N / f_y = 555.6 0.82
Stiffener required due to overlapping stress regions.
Shear stiffening
Column design shear ......... 435.6 kN
Unstiffened capacity ......... 408.0 > N / f_y = 425.6 0.94
Using two 9/16 stiffeners, f_y = 345 kN
Using two 3/4 stiffeners f_y = 54.3 kN
Using 5 fillet welds, 3/4 x 30 deg.
Welding middle 1/2 on both sides of each stiffener...
Stiffener yield capacity ......... 407.9 > N / f_y = 54.3 7.67 Pass
Stiffener buckling capacity ......... 308.1 > N / f_y = 54.3 5.60 Pass
CRITICAL LIMIT STATE ....... End plate flexural capacity
Utilization Ratio ....... 0.54
Capacity Ratio, e-Rod's ....... 1.04 Pass
Multiple Row Flush End Plate Moment Connection

This is the design example from p. 24 of Ref. 18, *Flush and Extended Multiple-Row Moment End Plate Connections*. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Limcon V3.5**  
Engineering Systems Development  
Job: MEPC P.44 – Connection P.44  
Flash Moment End Plate Connection Design Example  
AISC Steel Design Guide 18 p. 24

**Connection: P.44**  
**Type:** Frame End Plate Connection  
**Flash end plate:** 2 4 bolt unstiffened  
**Country:** CA  
**Unit:** SI customary  
**Design Code:** AISC-ASD 89-95 (LRFD)

**Beam:** W14x325  
**Section:** W14x325  
**Grade:** A500  
**Depth:** 19.00 in.  
**Moment of inertia:** 4.40E+10 in.  
**Web:** 6.35 in.  
**Area:** 7.33E+10 in.  
**Thickness:** 0.25 in.  
**Fu:** 50.0 ksi  
**Fy:** 36.0 ksi  
**Tf:** 0.25 in.  
**Zx:** 4.63E+01  
**Zw:** 0.00  
**Wx:** 0.00

**End plate:**  
**Flange weld:** 0.315" Fw/Fw = 0.94  
**Web weld:** 0.315" Fw/Fw = 2.755" gauge

**Bolts:**  
**W14x325/H top flange:** 2.755 gauge at 3.046 spacing.  
**W14x325/H bottom flange:** 2.755 gauge.

**MINIMUM ACTION CHECK**

**Specified minimum design actions:**

**Sway:** 10% of影响力 2000.49 = 224.1 kip/in  
**Shear:** 9.0 kip  
**Tension:** 0% of影响力 394.9 = 0.0 kip  
**Compression:** 0% of影响力 394.9 = 0.0 kip

**NOTES:** Input design actions are not automatically increased if they are less than the

Limcon V3.5
specified minimum actions. Minimum actions may be set in any load case. This check
verifies if any design action is less than the specified minimum for all load cases.

**MINIMUM Design shear force is less than specified minimum.**

**INPUT DESIGN ACTIONS**
- Moment, Mx: 783.8 kip-in
- Shear, Vx: 0.0 kip
- Axial, N: 0.0 kip

Using AISC 2000 model...

**GEOMETRY CHECKS...**
- Bolts: 3/8"
  - Bolt MTS: 115 kip
  - Tensile strength (AISC model): 120 kip
  - Specified minimum tension: 50 kip
  - Assumed tension (Sec. 19): 120 kip

Table 3-6 - Torsional parameter ranges:
(Ref. "Torsion and Extended Multiple Row Moment End Plate Connections"
I.M. Murray & R.L. Spielvogel
American Institute of Steel Construction - 2002)
- pf: 1.00 to 1.01
- pd: 1.00 to 1.01
- g: 1.00 to 1.01
- h: 1.00 to 1.01
- tp: 1.00 to 1.01
- tf: 1.00 to 1.01

DESIGN STRENGTH CHECKS...
- Strength ratio (design strength / allowable strength)
- End plate yield line analysis:
  - End plate yield strength: 1082.4 kip
  - Bolt rupture strength (no gusset): 780.0 kip
  - Bolt rupture strength (gusset included): 780.0 kip

Flanges:
- Flange tension strength: 44.1 kip
- Flange compression strength: 44.1 kip
- Flange weld design force: 44.1 kip

Flange fillet weld tension strength: 44.1 kip
Flange fillet weld compression strength: 44.1 kip

Web shear:
- Web shear between flanges: 17.80 in
- Web depth for shear resistance: 8.75 in
- Beam web shear strength: 49.2 in

Web welds:
- Weld depth for shear resistance: 6.75 in
- Using 0.315" fillet welds: 6.75 kip/in

**Web weld design force**:
- 6.75 kip/in

Limcon V3.5
7:Examples • 115
End plate ply bearing strength ........ 51.1 > Vu = 0.0 0.00 Pass

CRITICAL LIMIT STATE . . . Bolt rupture strength (no plying)
UTILISATION RATIO . . . . 100%
STRENGTH RATIO . . . . . 0.999 Pass
4-Bolt RHS Moment End Plate Connection

This is Design Example 1 from Ref. 27, *Design Model for Bolted Moment End Plate Connections Using Rectangular Hollow Sections.*

The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.

The Ref. 27 design model uses a “plate design stress”, which is a function of yield and ultimate stresses, rather than the yield stress used throughout Limcon for evaluation of strength limit state capacities. If Limcon used this value (416 MPa) instead of the correct yield stress (340 MPa), the bolt failure and plate failure capacities obtained would be 23.0 kN.m and 26.8 kN.m, respectively. These compare favourably with the published values of 22.2 kN.m and 25.9 kN.m. The values in the Limcon output below, 20.6 kN.m and 21.4 kN.m, both exceed the design moment capacity of the section, 19.0 kN.m. The connection is shown as failing the design checks only because the design moment of 22.2 kN.m was chosen to match the capacity in the published design example.
Limcon V3.0 13-DEC-02

Connection: R745-1
Type: RHS bolted moment end plate
Design code: AS4100/NZS3404

Member: Hmat=81  Section=125x75x4.00x8  Grade=C450
D = 125.0  Area = 1.480x10^3  fy = 400
b = 75.0  Sx = 6.030x10^4  fu = 500
T = 4.0

End plate:
265x135x16  Gcr/fy/fu=350/340/480

Bolt:
4 CBF/480/SF all around section.

Input design actions:
Moment  22.2
Shear  6.0
Axial  6.0

Minimum design actions:
Bending  0% of a.Ms (21.7) = 0.0 kN.m
Shear  0.0 kN
Tension  0% of a.Ms (532.8) = 0.0 kN
Compression  0% of a.Ms (532.8) = 0.0 kN

ANALYSIS RESULT

Final design actions:
Moment  22.2
Shear  0.0
Tension  0.0

Limcon [V3.00.00]
Tested parameter ranges:
Depth of beam section .................................. 125.0 <= 400.0 Pass
Section slenderness plasticity limit ............... 30.0
Section slenderness yield limit ..................... 40.0
Section slenderness .................................... 11.2
Compactness = C = Pass

Horiz. distance from web to bolt, c .............. 0
Vert. distance from flange to bolt, so .......... 40

Yield line analysis:
Mode 1 failure moment ............................... 22.7
Mode 2 failure moment ............................... 22.7
Mode 3 failure moment ............................... 36.2
Plate equivalent width ................................ 155.0

Bending:
Bolt tension failure capacity ....................... 20.6 < M* = 22.2 FAIL
End plate failure capacity ............................ 21.4 < M* = 22.2 FAIL

Bolts:
Shear capacity of compression bolts .............. 118.6 > V* = 80.0 Pass
End plate ply bearing capacity ..................... 707.8 > V* = 80.0 Pass

Serviceability limit states:
Bolt yielding serviceability capacity .............. 19.1 > M = 14.8 Pass
Plate yielding serviceability capacity ............ 20.6 > M = 14.8 Pass

NOTE: Specified combination fillet/butt weld does not require checking.

Critical limit state: Bolt tension failure capacity
φS.ua/S** = 6.929 Phil. ****
8-Bolt RHS Moment End Plate Connection

This is Test 7 from Ref. 28, *Design Model for Bolted Moment End Plate Connections Joining Rectangular Hollow Sections Using Eight Bolts*. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
Limcon V3

Engineering Systems Development
Job: TMEPS #10 -- Connection: 7
8-Bolt RHS Moment End Plate Connection Design Example
University of Sydney C.A.E. Research Report Test 7

---

Limcon V3.0

Connection: 7
Type: RHS bolted moment end plate
Design code: AISI80/EN23546

Member: HSB-61 Section=150x150x9.00 RHS Grade=C350
D = 150.0 Area = 4.4005x10^{-3} fy = 350
R = 150.0 My = 2.400x10^{-5} f_u = 430
T = 9.0

End plate: 260x260x16 Gr./fy=fu=350/340/480

Grip: 8 CTR/480/6F all around section.

Bolts: 8-M20 0.6/6/M edge dist. 30 gauge 35

Input design actions:
Moment 78.1
Shear 0.0
Axial 0.0

Minimum design actions:
Bending 0% of s.Ms ( 78.1) = 0.0 kN.m
Shear 0.0 kN
Tension 0% of s.Ms ( 1512.0) = 0.0 kN
Compression 0% of s.Ms ( 1512.0) = 0.0 kN

ANALYSIS RESULT

Final design actions:
Moment
Shear
Tension

---

Limcon [V3:00.00]
### Limits

<table>
<thead>
<tr>
<th>Tested parameter ranges:</th>
<th>Value</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth of beam section</td>
<td>150.0</td>
<td>&lt;= 400.0 Pass</td>
</tr>
<tr>
<td>Section slenderness plasticity limit</td>
<td>30.0</td>
<td></td>
</tr>
<tr>
<td>Section slenderness yield limit</td>
<td>40.0</td>
<td></td>
</tr>
<tr>
<td>Section slenderness</td>
<td>17.4</td>
<td></td>
</tr>
<tr>
<td>Compactness</td>
<td>C</td>
<td>Pass</td>
</tr>
<tr>
<td>Horiz. distance from web to bolt</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Vert. distance from flange to bolt, so</td>
<td>25</td>
<td></td>
</tr>
</tbody>
</table>

### Yield line analysis:

- **Mode 1**: 0.0
- **Mode 2**: 158.4
- **Mode 3**: 111.4

### Bending:

- **Thick plate capacity**: 95.0 > H* = 78.1 Pass
- **Intermediate plate capacity 1**: 118.2
- **Intermediate plate capacity 2**: 105.5
- **Intermediate plate capacity**: 105.5 > H* = 78.1 Pass
- **Thin plate capacity**: 163.3 > H* = 78.1 Pass
- **Bolt tension yield capacity**: 103.6 > H* = 78.1 Pass
- **Section yield capacity**: 78.1 > H* = 78.1 Pass
- **Punching shear failure**: 105.4 > H* = 78.1 Pass

### Bolts:

- **Shear capacity of compression bolts**: 370.5 > V* = 0.0 Pass
- **End plate ply bearing capacity**: 1769.5 > V* = 0.0 Pass

**NOTE:** Specified combination fillet/butt weld does not require checking.

### Critical limit state: Section yield capacity

- c_Wu/N* = 1.800 Pass

---

Limcon [V3.00.00]
Bolted Splice

This is the design example from p. 142 of Design of Structural Connections. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Limcon V3.5**

Engineering Systems Development
Job: ESPM 442 - Connection ESPM
Bolted Splice Design Example
"Design of Structural Connections" p. 142

---

**Geometry Check:**

**WARNING** - Plate width > beam flange width.
0 errors, 1 warning

**Limcon V3.5**
Date: 31-Oct-06

**Connection:**
- **Type:** Bolted Splice
- **Country:** Australia
- **Grade/Steel:** A4 410 (AISI 201)
- **Design code:** AS1163
- **Member:**
  - **Diameter:** 31.8 mm
  - **Length:** 600 mm
  - **Grade:** 410
  - **Design code:** AS 1163
  - **Sides:** 6
  - **Columns:** 2
  - **Rows:** 2
  - **Pitch:** 50 mm
  - **Distance:** 100 mm

**Flange:**
- **Type:** Plate
- **Thickness:** 20 mm
- **Length:** 1200 mm
- **Width:** 1200 mm
- **Grade:** 410
- **Design code:** AS 1163

**Web:**
- **Type:** Plate
- **Thickness:** 10 mm
- **Length:** 1200 mm
- **Width:** 1200 mm
- **Grade:** 410
- **Design code:** AS 1163

---

**MINIMUM ACTION CHECK:**

- **Bending:**
  - Minimum bending moment:
  - Sides: 80 kN.m
  - Design: 80 kN.m

- **Tension:**
  - Minimum tension:
  - Sides: 80 kN
  - Design: 80 kN

---

Limcon [V3.5]
Limcon V3.5

Engineering Systems Development
Job ESPR 142 - Convection ESPR
Biflap Spine Design Example
"Design of Structural Connections" p. 142

Convergence 0% of NFE : 1944.011 = 0.0 Kf

NOTE: Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if any design action is less than the specified minimum for all load cases.

DESIGN CHECK SUMMARY

<table>
<thead>
<tr>
<th>Case</th>
<th>Mx</th>
<th>Vy</th>
<th>Nt</th>
<th>LF</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>80</td>
<td>80</td>
<td>0</td>
<td>1.59</td>
<td>63%</td>
</tr>
<tr>
<td>2</td>
<td>31.6</td>
<td>60</td>
<td>0</td>
<td>1.45</td>
<td>63%</td>
</tr>
</tbody>
</table>

INPUT DESIGN ACTIONS FOR CASE NO. 2

Mx = 31.6 kN.m
Vy = 60 kN

Axial, Nt = 0.0 kN

Using ASI 1994 model...

ANALYSIS RESULT

Elastic analysis:
- Mf = 180.0 kNm
- Nf = 190.0 kN
- Vf = 40.0 kN
- Mv = 17.1 kNm

Plastic analysis:
- Mpf = 186.2 kNm
- Npf = 196.0 kN
- Vpf = 40.0 kN
- Mvp = 19.0 kNm

Simplified analysis:
- Mfs = 233.4 kNm
- Nfs = 239.4 kN
- Vfs = 40.0 kN
- Mvs = 18.9 kNm

NOTE: Elastic analysis results used.

Flanges and web derived design actions...

Flange forces:
- Due to axial forces Mf = 0.0 kNm
- Due to bending Mbf = 190.0 kNm

Total flange forces = Mbf = 190.0 kNm

Web forces:
- Axial, N = 0.0 kN
- Shear, Vw = 40.0 kN

DESIGN CAPACITY CHECKS...

Capacity ratio ________ Design action ________ Design capacity ________

--- Design action ________ --- Design capacity ________

Flanges:
- Flange tension capacity ________ 491.6 > Mf = 190.0 kNm Pass
- Flange compression capacity ________ 685.0 > Mbf = 190.0 kNm Pass

Flange plates:
- Flange plate tension capacity ________ 505.4 > Mf = 190.0 kNm Pass
- Flange plate compression capacity ________ 505.4 > Mbf = 190.0 kNm Pass

Flange bolts:
- Shear capacity (plate tension) ________ 370.6 > Vf = 40.0 kNm  Pass
- Shear capacity (plate compression) ________ 370.5 > Vbf = 190.0 kNm Pass

Flange bearing capacity ________ 1105.0 > Vbf = 190.0 kNm Pass

Bolt bearing capacity ________ 672.4 > Vbf = 190.0 kNm Pass

Flange coating capacity ________ 1133.6 > Vbf = 190.0 kNm Pass

Flange coating capacity ________ 621.2 > Vbf = 190.0 kNm Pass

Web plates:
- Shear yield capacity ________ 59.9 > Vw = 40.0 kNm Pass
- Tension yield capacity ________ 510.1 > Vbf = 40.0 kNm Pass

Web bolts (right-hand group):
- Moment capacity ________ 572.6 > Vbf = 0.0 kNm Pass
- Compression capacity ________ 646.7 > Nbf = 0.0 kNm Pass
- Moment-tensile capacity ________ 58.9 > Nbf = 18.9 kNm Pass
- Moment-axial capacity ________ 58.9 > Nbf = 18.9 kNm Pass

Limcon V3.5
7:Examples ● 125
Web checks...
Bolt shear (critical bolt row, column)... 
Bolt shear: 188.0 > Vres = 81.6 2.27 Pass
Bolt bearing (critical bolt row, column)... 
Bolt bearing: 117.4 > Vbh = 81.0 1.48 Pass
Bolt group ext. tearing (left)... (4.1) 174.6 > V* = 10.0 17.5 Pass
Web plate checks...
Bolt shear (critical bolt row, column)... 
Bolt shear: 188.0 > Vres = 81.6 2.27 Pass
Bolt bearing (critical bolt row, column)... 
Bolt bearing: 117.4 > Vbh = 81.0 1.48 Pass
Bolt group ext. tearing (left)... (4.1) 174.6 > V* = 10.0 17.5 Pass
CRITICAL LOAD CASE... 
CRITICAL LOAD STATE... Bolt group ext. tearing (left)
UTILIZATION RATIO... 2.09
CAPACITY RATIO, d.45°... 1.440 Pass

Limcon V3.5
Bracing Cleat

This is the design example from p. 6-21 of Design of Structural Steel Hollow Section Connections. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Connection**: Compression - Bracing Cleat

Type: BS - HSS welded to tee and brace

Bracing member: BR 65x6x5x5.8 HSS Gr C450

Bolts: M20, 8.8/SN at 70° pitch

*Note: Refer to the full documentation for detailed calculations.*
**Limcon V3.5**

**Engineering Systems Development**

**Job Ex 06.21 — Connection Compression**

**Brazing Credit Design Example**

"Design of Structural Steel Hollow Section Connections" p. 6-21

---

**MINIMUM DESIGN CHECK**

**Specified minimum design actions:**

- **Tension:** 0.6 kN
- **Compression:** 0.6 kN

**NOTE:** Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if any design action is less than the specified minimum for all load cases.

**INPUT DESIGN ACTIONS**

- **Axial, N:** 70.0 kN (comp.)

**WARNING:** This connection type may not be suitable for short compression members.

Using ASI 1974/1996 model...

**DESIGN CAPACITY CHECKS — Compression**

<table>
<thead>
<tr>
<th>Capacity ratio</th>
<th>Design action</th>
<th>Design capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Brazing members:**

- **Section compression capacity:** 446.6 N > N = 70.0 N Pass

**Bolts:**

- **Bolt group shear capacity:** 155.3 N > N = 70.0 N Pass

**Bracing clear (pierces):**

- **Clear bearing capacity:** 472.3 N > N = 70.0 N Pass
- **Clear internal bearing capacity:** 426.0 N > N = 70.0 N Pass
- **Clear weld capacity:** 229.7 N > N = 70.0 N Pass

**Attatched plate (pierces plate):**

- **Plate bearing capacity:** 472.3 N > N = 70.0 N Pass
- **Plate internal bearing capacity:** 426.0 N > N = 70.0 N Pass

**Welded tee and cap — compression:**

- **Cap plate bearing on NSS end:** 292.6 N > N = 70.0 N Pass
- **Cap plate to NSS weld capacity:** 140.8 N > N = 70.0 N Pass
- **Attatched plate to cap plate weld:** 146.8 N > N = 70.0 N Pass

**Evenly distributed plates:**

- **Effective width:** 90.0 mm
- **Effective thickness:** 10.0 mm
- **Centricity:** 0.08
- **Effective length (w=1.0):** 255 mm

**Equivalent column compression capacity:**

- **Equivalent column section bending capacity:** 126.3 kN
- **Equivalent column section moment capacity:** 0.53 kN

**Axial eccentric clear capacity:**

- **Centre of moment:** 0.50 kN
- **Moment amplification factor:** 1.28
- **Maximum axial bending moment:** 227.7 kN
- **Clear compression capacity:** 126.3 kN
- **Section moment capacity:** 0.53 kN
- **Reduced section moment capacity:** 0.40 kN
- **In-plane clear moment capacity:** 0.32 kN
- **Capacity of eccentric clear (Ref. 4):** 49.9 N > N = 70.0 N Fail 9.4.1.2
- **Capacity of eccentric clear (Ref. 12):** 112.1 N > N = 70.0 N Fail 9.4.1.2
- **Yield capacity of eccentric clear:** 220.6 N > N = 70.0 N Fail 9.4.1.2

**HSS support members:**

- **HSS support member wall shear capacity:** 421.8 N > N = 70.0 N Pass
- **HSS column face yielding capacity:** 197.6 N > N = 70.0 N Pass

**CRITICAL LIMIT STATE — Capacity of eccentric clear (Ref. 4):**

- **Utilization Ratio:** 140%
- **Capacity Ratio:** m.R/R = 0.73 Fail ****

---

Limcon V3.5
This is the design example from p. 162 of *Design of Structural Connections*. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Limcon V3.5**

Engineering Systems Development
Job: BASE.p.62 - Connection: BASE
Base Plate Design Example:
"Design of Structural Connections" p. 162

---

**connection: BASE - Base Plate**
Column: COL.533x80 6 x 200
Base plate: 2300x2000x64.0 250 - Weld: 5 F3/F4/50/S6

---

**Foundation:** 900 dia x 600 deep - 40 thick grad pad
HD Bolts: 4xM24 4.6/SN - 250 embedment

---

**Limcon V3.6**

Date: 31-Oct-04

---

**Connection:** BASE

**Type:** Base Plate

**Material:**
- ULT: Pinned base plate
- Units: Metric

**Design Code:** AS 4100 (AS 2004)

**Column:**
- Section: 530x80
- Grade: 460
  - D = 533 mm
  - Root rad. = 14.6 mm
  - fy = 300 MPa
  - fy = 320 MPa
  - fG = 1.40
  - S = 2.9704E+06
  - fo = 440 MPa
  - fy = 10.2 mm

**Base plate:**
- 80x30x800
- Sydney 400 MPa
- 5 F3/SN/F4/50/250/410 MPa

**Width:**
- 5 F3/SN/F4/50/250/410 MPa

**Bolts:**
- M24 4.6/S anchor bolts.
- No. bolts ov = 4
- No. bolts outs. = 2

**Spacing of anchor bolts:**
- 200 in FF direction.
- 400 in TF direction.

**Embedment length:** 150, no hook.

**Shear capacity of bolts** NOT considered.

**No shear key.**

---

Foundation:

Limcon [V3.5b]
Foundation strength f = 29 kN/m
Grout thickness = 40
Circum. dia. = 900
Min. bolt edge distance = 29.7
Coeff. friction between base plate and foundation = 0.80

MINIMUM ACTION CHECK
Specified minimum design actions:
Bending 30% of abs = 699.39 = 930.9 MN
Tensile 0% of abs = 0.0 MN
Compression 0% of abs = 0.0 MN
NOTE: Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if any design action is less than the specified minimum for all load cases.

WARNING: Design bending moment is less than specified minimum.

INPUT DESIGN ACTIONS
Axial, N = 3000.0 MN (comp.)
Shear, Vx
Shear, Vy
Moment, Mx
Moment, My

NOTE: Bending moment is ignored.

DESIGN CAPACITY CHECK...

Capacity ratio ---------
Design action -->
Design capacity -->

NOTE: Capacity of section is not checked.

Using ASI 1994 model...

Compression analysis:
Concrete confinement ratio ... 1.49
Concrete friction capacity ... 2444.4 > P = 90.0 27.1 Pass
Plate constant counter lever capacity ... 679.5 > P = 90.0 69.0 Pass
Fringing plate thickness ... 20.0 > D = 24.0 0.97 Fail Informative
Modified Driven plate capacity (Ref. 3B) ... 522.5 > P = 90.0 5.95 Pass
Column weld shear capacity (full contact) ... 150.9 > V = 39.0 59.3 Pass

Shear analysis:
Coefficient of friction ... 0.80
Concrete cohesion ... 80.0 MN
Available base plate friction ... 55.6 MN
Design shear less friction (N) ... 5.0 MN
Design shear less friction (V) ... 0.0 MN

TOTAL SHEAR CAPACITY (N) ... 66.6 > V = 25.0 2.64 Pass

CRITICAL LIMITE STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)

CRITICAL LIMIT STATE ... Total shear capacity y)
Moment Base Plate

**Limcon V3.5**

**Engineering Systems Development**

Job: BASE IDS1 examples - Connection Ex.4.7

---

**CONNECTION: Ex.4.7 - Base Plate**

- **Column**: Column W12X66 or A302
- **Base plate**: 20" x 20" x 3/4" A36 - Welded 3/4" FW/70H6

---

**Foundation**: 40" x 40" x 24" deep - 1-1/2" thick grout pad

HD bolts: 0.1/12 A327A - 16" embedment

---

**Geometry Check:**

- **WASHERS**: Edge distance < minimum - check sp and di.
- **Conclusion**: 1 warning

---

**Connection: Ex.4.7**

- **Type**: Base Plate
- **Country**: US
- **Units**: US customary

**Design code**: ASD/UBC 1990-95 (BPUD)

**Column**: Matr=M615, Service=W12X66, Grade=A302

<table>
<thead>
<tr>
<th>D</th>
<th>12.70 in.</th>
<th>Df</th>
<th>6.61 in.</th>
<th>fyf</th>
<th>50.0 ksi</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>12.00 in.</td>
<td>Area</td>
<td>2.0520 x 10^4</td>
<td>ksf</td>
<td>50.0 ksf</td>
</tr>
<tr>
<td>T</td>
<td>0.75 in.</td>
<td>Ex</td>
<td>1.4700 x 10^12</td>
<td>in</td>
<td>45.0 ksi</td>
</tr>
</tbody>
</table>

**Base plate**: 20" x 20" x 3/4" Gr./fy=430/24ksi 16" embedment

**Welds**: 0.75" FW fy=70 ksf all around column.

**Bolts**:
- 6-1/2" A327/N anchor bolts
- 6 No. bolt rows = 2
- 3 No. bolt rows = 3
- Spacing of outer bolts, sp = 1" in XE direction
- Spacing of outer bolts, sp = 1" in YE direction
- Embedment length = 1", no hook
- Shear capacity of bolts NOT considered

---

**Limcon (V3.5.0b)**
No shear kwy.

Foundation:
- Foundation strength: $f_c = 4.00$ ksf
- Grout thickness: 1.5" (1.25"
- Rectangular: $D = 40"$, $B = 40"$
- Min. bolt edge distance: 11.0"
- Coef. friction between base plate and foundation: 0.68

MINIMUM ACTOR CHECK
- Specified minimum design actions:
  - Bending: 30% of $f_{cs}$ = 0.615 ksi = 1956.7 kip-in
  - Shear: 9.0 kip
  - Tension: 0% of $f_{cs}$ = 0.0 kip
  - Connection: 0% of $f_{cs}$ = 0.0 kip

NOTE: Input design actions are not automatically increased if they are less than the specified minimum actions. Minimum actions may be set in any load case. This check warns if any design action is less than the specified minimum for all load cases.

WARRANT: Design shear force is less than specified minimum.

INPUT DESIGN ACTIONS
- Axial, $N$ = -376.0 kip (comp.)
- Shear, $V_{ax}$ = 0.0 kip
- Moment, $M_{xy}$ = 0.0 kip

DESIGN STRENGTH CHECKS...

<table>
<thead>
<tr>
<th>Strength ratio</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Bldg. strength</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design strength</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE: Capacity of section is not checked.

Using AISI 2006 model...

Compression + moment analysis:
- Concrete confinement ratio: 1.00
- Bending strength, $M_{cd}$: 4.22 ksf
- Foundation compressive strength: 1765 ksf
- Bending strength: 8.57 in.
- Critical eccentricity: 1.67 in.
- Large moment - bolts in tension: 80.400 kip/in
- Bending strength per unit length: 80.400 kip/in
- Concrete bending force: 80.400 kip
- Bending force: 80.400 kip
- Single bolt tension strength: 59.6 kip
- Single bolt yield strength: 62.1 kip
- Base plate yield strength: 62.1 kip
- Base plate yield (tension) strength: 62.1 kip
- Column weld strength: 14.705 kip
- Column weld strength: 14.705 kip
- Column weld strength: 14.705 kip
- Column weld strength: 14.705 kip

CRITICAL ASSESS STATE: Column weld strength

UTILIZATION RATIO: 94%

STRENGTH RATIO: 1.047 Pass
HSS Cap Plate Connection

This is the design example from p. 4-7 of *Design of Structural Steel Hollow Section Connections*. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
Limcon V3.0 13-DEC-02

Connection: TCAP p.4-7
Type: SEHS cap plate connection
Design code: AS1180/BS5400

Member: Mark=COL Section=100X100X5.0895 Grade=C450
D = 108.0 Ar = 1.818E+03 Fy = 408
B = 168.0 Br = 6.350E+04 Fu = 508
T = 5.0

Cap plate:
130x220x12 Gr./fy/fu=250/260/410
Weld:
6 GTW/400/6P all around.
Bolts:
4-M16 8.8/SK gauge 160 pitch 70
Design action N* = 130.0k

ANALYSIS RESULT
Check validity ranges...
Valid plate thickness range . . . . . . . . 12.0 >= 12.0 Pass
Valid plate thickness range . . . . . . . . 12.0 <= 26.0 Pass
Component...
Minimum plate thickness . . . . . . . . 12.0 >= 11.1 Pass
Maximum plate thickness . . . . . . . . 12.0 <= 14.6 Pass
Design capacity of plate . . . . . . . . 260.1 > N*ct = 130.0 Pass
Weld...
Weld tension capacity . . . . . . . . . . 195.5 > N*ct = 130.0 Pass
Bolts...
Prying factor . . . . . . . . . . . . . . . 0.233
Bolt tension capacity . . . . . . . . . 358.2 > N*ct = 130.0 Pass
Critical limit state: Weld tension capacity
σ,Ed/E*; 1.904 Pass
This is the design example from p. 10-9 of Design of Structural Steel Hollow Section Connections. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
Limcon V3

Engineering Systems Development
Job: KNEE p.10-9 – Connection: KNEE p.10-9
Mitek Kne Design Example
"Design of Structural Steel Hollow Section Connections" p. 10-9

LIMCON V3.0
12-DEC-02 19:14:28

Connection: KNEE p.10-9
Type: SSHS mitered knee connection
Design code: AS4100/B2294

Column: Mark=COL Section=150X100X5.0 RHS Grade=C350
D = 150.0 Are = 2.3105+03 fy = 350
B = 100.0 Sx = 1.1505+05 fu = 430
T = 5.0

Rafter: Mark=SM Section=150X100X5.0 RHS Grade=C350
D = 150.0 Are = 2.3105+03 fy = 350
B = 100.0 Sx = 1.1505+05 fu = 430
T = 5.0

Angle between column and rafter = 95.00

Stiffening plate:
245x130x10 Gr./fy=fu=250/260/418

Weld:
4.2 throat CW/689/SF around end of member.

Input design actions:

<table>
<thead>
<tr>
<th>Column</th>
<th>Rafter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moment</td>
<td>25.0</td>
</tr>
<tr>
<td>Shear</td>
<td>15.0</td>
</tr>
<tr>
<td>Axial</td>
<td>-32.0C</td>
</tr>
</tbody>
</table>

ANALYSIS RESULT

Minimum design actions - column:
Bending 50% of Mx = 36.2 = 18.1 kN.m
Shear 15% of Vx = 256.1 = 38.4 kN - governs
or 48.0 kN

Minimum design actions - rafter:
Bending 50% of Mx = 36.2 = 18.1 kN.m
Shear 15% of Vx = 256.1 = 38.4 kN - governs

Limcon [V3.00.00]
Final design actions:

<table>
<thead>
<tr>
<th></th>
<th>Column</th>
<th>Rafter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moment</td>
<td>25.0</td>
<td>25.0</td>
</tr>
<tr>
<td>Shear</td>
<td>48.0</td>
<td>45.0</td>
</tr>
<tr>
<td>Axial</td>
<td>-32.0°</td>
<td>-29.0°</td>
</tr>
</tbody>
</table>

Check validity ranges...

- **Section widths**: 100.0 ≤ 100.0, Pass
- **Angle, theta**: 95.0 ≥ 90.0, Pass
- **COLUMN**: Thickness, t1: 5.0 ≤ 2.0, Pass
- d2/b1: 1.50 ≥ 0.33, Pass
- **Section slenderness plasticity limit**: 30.0
- **Section slenderness yield limit**: 49.0
- **Section slenderness**: 21.3
- **Cohortress - C**: Pass

- **RAPER**:
  - Thickness, t2: 5.0 ≤ 2.0, Pass
  - d2/b2: 1.50 ≥ 0.33, Pass
  - **Section slenderness plasticity limit**: 30.0
  - **Section slenderness yield limit**: 49.0
  - **Section slenderness**: 21.3
  - **Cohortress - C**: Pass
  - d2: 10.0 ≤ 10.0, Pass

Combined moment and axial load...

- **COLUMN**: Sum of capacity ratios: 0.734 ≤ 1.000, Pass
- **RAPER**: Sum of capacity ratios: 0.718 ≤ 1.000, Pass

**Shear**...

- **COLUMN**: 0.5 x Shear capacity: 128.0 > \( \psi \times 1 = 48.0 \), Pass
- **RAPER**: 0.5 x Shear capacity: 128.0 > \( \psi \times 2 = 45.0 \), Pass

**Held**...

- **COLUMN**: Column weld capacity per unit length: 0.977 > \( \psi \times e = 0.760 \), Pass
- **RAPER**: Rafter weld capacity per unit length: 0.977 > \( \psi \times e = 0.808 \), Pass

**Critical limit state**: Rafter weld capacity per unit length
\( e \times S / S^* \): 1.299, Pass
HSS Y or T Connection

This is the design example from p. 11-19 of *Design of Structural Steel Hollow Section Connections*. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Limcon V3**

**Engineering Systems Development**
**Job: TYT p.11-19 — Connection: TYT p.11-19**
**Y or T Connection Design Example**

"Design of Structural Steel Hollow Section Connections" p. 11-19

---

**Connection: TYT p.11-19**
**Type: SHEX 1/2 connection**
**Design Code: AAS 4100**

**Chord: Section=100x180x6.000G Grade=C450**
- **D = 100.0**
- **Area = 2.132E+03**
- **Ey = 400**
- **B = 100.0**
- **Sx = 7.358E+04**
- **Fu = 500**
- **T = 6.0**

**Brace: MKS=BR Section=75x75x5.000G Grade=C450**
- **D = 75.0**
- **Area = 1.318E+03**
- **Ey = 400**
- **B = 75.0**
- **Sx = 3.300E+04**
- **Fu = 500**
- **T = 5.0**

Angle between brace and chord = 45.00

**Weld: 4.2 throat CW/480/SP around end of brace.**

**Design actions:**
- **Axial force** $N_a = -250.00$
- **Axial preload in chord** $N_{cp} = 125.0$
- **Bending moment in chord** $M_o = 4.0$

**ANALYSIS RESULT — Compression**

Minimum design action ................. 101.5

Design axial load in chord (derived) ........ 300

**Configuration: SHEX chord...**

(a) $b/6$ for SHEX brace ................. 0.75 $>$ 0.25 Pass
(b) $b/6$ for SHEX brace ................. 0.75 $<$ 0.85 Fail
(c) $b/6$ for SHEX chord ................. 15.0 $<$ 35.0 Pass
(d) $b/6$ for SHEX chord ................. 15.0 $<$ 35.0 Pass

$N_a$ = chord face yielding capacity ........ 343.9 $>$ $N_a$ = 250.00 Pass
$N_a$ = weld capacity for specified throat ... 280.8 $>$ $N_a$ = 250.00 Pass
Critical limit state: $M_b$ = weld capacity for specified throat $e_p/A_p$ = 1.122 Pass

Limcon [V3 beta 17.01]
HSS X Connection

This is the design example from p. 12-19 of Design of Structural Steel Hollow Section Connections. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
**Limcon V3**

**Engineering Systems Development**

**Job:** TX.p.12-19  **Connection:** TX.p.12-19  
**SSHS X Connection Design Example**

"Design of Structural Steel Hollow Section Connections" p. 12-19

---

**Connection:** TX.p.12-19  
**Type:** SSHS X connection  
**Design code:** AS4100/NS3368  
**Chord:** Section=150x100xS5.6  **Grade=C350**  
- D = 150.0  
- Areq = 2.31003  
- Cy = 350  
- E = 1.152003  
- Gxx = 430  
- F = 5.0  

**Brace:** Section=65x65xS5.6  **Grade=C350**  
- D = 85.0  
- Areq = 1.152003  
- Cy = 350  
- E = 3.656004  
- Gxx = 430  
- F = 5.0  

**Angle between chord and chord:** 45.00  

**Mold:**  
- 1.2 throat C480/SF around end of brace  

**Design action:**  
- \( M^* = 200.0t \)  

**ANALYSIS RESULT - Tension**  
**Minimum design action:** 108.7  
**Design axial load in chord (derived):** 141  

**Configuration:** RHS chord...  

- \( b/t \) for RHS/SMS brace: 0.89 >= 0.25  
- \( h/t \) for RHS/SMS brace: 0.25 >= 0.25  
- \( h/t \) for RHS/SMS brace: 1.00 >= 0.50  
- \( h/t \) for RHS/SMS brace: 1.00 <= 2.00  
- \( h/t \) for RHS/SMS brace: 20.0 <= 35.0  
- \( h/t \) for RHS/SMS brace: 30.0 <= 35.0  
- \( h/t \) for RHS/SMS brace: 25.4 <= 35.0  
- \( h/t \) for RHS/SMS brace: 35.0 <= 35.0  

**Effective width:** 63.4  
**Nc = brace effective width capacity:** 356.7 > \( M^* = 200.0t \)  
**Np = punching shear capacity:** 506.0 > \( M^* = 200.0t \)  
**Nh = chord side wall / face capacity:** 516.0 > \( M^* = 200.0t \)  
**Mg = chord side wall shear failure:** 449.0 > \( M^* = 200.0t \)  
**Length of weld:** 344  
**Nh = weld capacity for specified throat:** 322.0 > \( M^* = 200.0t \)  

**Critical limit state:**  
- \( s/Ru/S = 1.664 > 1 \)  

Limcon [V3.00.00]
HSS T or K Gap Connection

This is the design example from p. 13-21 of Design of Structural Steel Hollow Section Connections. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
LIMCON V3.0 23:24:14

Connection: TKNG p.13-21
Type: SSHE K/N gap connection
Design code: MP1100/MS3491

Chord: Section=350X100X5.0SHS Grade=C350
D = 150.0 Ares = 2.310X+03 fy = 350
B = 100.0 Sz = 1.150X+03 fu = 430
\( \tau \) = 5.0

Brace 1: Mark=BR1 Section=75X5.0SHS Grade=C450
D = 75.0 Ares = 1.310X+03 fy = 400
B = 75.0 Sz = 3.360X+04 fu = 500
\( \tau \) = 5.0
Angle between brace and chord = 40.00

Brace 2: Mark=BR2 Section=75X5.0SHS Grade=C450
D = 75.0 Ares = 1.310X+03 fy = 400
B = 75.0 Sz = 3.360X+04 fu = 500
\( \tau \) = 5.0
Angle between brace and chord = 40.00

Gap = 20 mm

Held:
4.2 throat CW/480/3P around end of brace.

Design actions:
Axial force - brace 1 \( \mathbf{N}^*1 \) = -250.0c
Axial force - brace 2 \( \mathbf{N}^*2 \) = 200.0c
Axial preload in chord \( \mathbf{N}^*op \) = 0.0
Bending moment in chord \( \mathbf{M}^*o \) = 10.7
Axial force in chord \( \mathbf{N}^*o \) = 300.0
Shear force in chord \( \mathbf{V}^*o \) = 16.0

ANALYSIS RESULT
Minimum design action - brace 3 . . . . . . . 141.5
Minimum design action - brace 2 = 141.5

Configuration: RHS chord...

A = bL/(2 \times \sin\theta) = 58.34
B = b2/(2 \times \sin\theta) = 58.34
C = (\sin\theta \times \sin\theta)/\sin\theta = 0.42
D = h0/2 = 75.80

Bocentricity, e = -17.66

(a) x1/h0 for RHS/SHE brace 1
   0.75 > 0.30 = Pass

(b) x1/h0 for RHS/SHE brace 2
   0.75 > 0.30 = Pass

(c) x2/h0 for RHS/SHE brace 2
   0.75 > 0.30 = Pass

(d) x for RHS/SHE braces
   0.75 > 0.35 = Pass

(e) x1/t1 for RHS/SHE brace 1
   15.0 < 28.0 = Pass

(f) x2/t2 for RHS/SHE brace 2
   15.0 < 35.0 = Pass

(g) x/t0 for RHS chord
   25.0 < 35.0 = Pass

(h) x/t0 for RHS chord
   30.0 < 35.0 = Pass

(i) x/t for RHS chord
   0.20 > 0.12 = Pass

(x) x/h0 for RHS chord
   20.0 > 10.0 = Pass

(x) x/h0 for RHS chord
   -0.12 > -0.25 = Pass


W1 = RHS chord face plastification cap. = 267.0 > N* = 250.0 = Pass
W2 = RHS chord face plastification cap. = 267.0 > N* = 250.0 = Pass
W3 = RHS chord shear capacity = 524.6 > N* = 250.0 = Pass
W4 = RHS chord shear capacity = 524.6 > N* = 250.0 = Pass

Effective width = 32.8

W5 = brace effective width capacity = 475.6 > N* = 250.0 = Pass

W6 = brace effective width capacity = 475.6 > N* = 250.0 = Pass
W7 = RHS chord punching shear capacity = 565.0 > N* = 250.0 = Pass

Length of weld - brace 1 = 388
Length of weld - brace 2 = 388

W1 = weld capacity for specified throat = 301.2 > N* = 250.0 = Pass

W2 = weld capacity for specified throat = 301.2 > N* = 250.0 = Pass

Critical limit state: W1 = RHS chord face plastification cap.
   \phi R_u/S* = 1.068 = Pass

Limcon [V3.00.00]
HSS T or K Overlap Connection

This is the design example from p. 14-15 of *Design of Structural Steel Hollow Section Connections*. The printed output on the following pages is obtained by clicking the Print button in the connection dialog box.
Limcon V3.5

Engineering Systems Development
Job: TANO-14-15 – Connection TANO-14-15
SS49 T or K Overlap Connection Design Example
"Design of Structural Steel Hollow Section Connections" p. 14-15

![Diagram of connection]

Geometry Check:

*** WARNING -- Weld throat exceeds 89% thickness.
0 error
0 warning

Lincon V3.5

17-MAR-08
3112394

Connection: TANO-14-15
Type: SS49 T or K Overlap Connection

Country: Australia

Unit: Metric

Design code: AS 4100

Chord:
Section: EN10210-1 S355J2H Grade C350

D = 125 mm
Area = 2112
f_y = 350 MPa

B = 128 mm
Sx = 1.9300E+04
fs = 480 MPa

T = 8 mm

Section bending capacity: 63.4 kN.m

Section shear capacity: 110 kN

Section axial capacity: 727.7 kN

Brace 1:
Section: EN10210-1 S355J2H Grade C350

D = 75 mm
Area = 710
f_y = 400 MPa

B = 75 mm
Sx = 1.3000E+04
fs = 500 MPa

T = 4 mm

Section bending capacity: 10.2 kN.m

Section shear capacity: 72.9 kN

Section axial capacity: 410.4 kN

Angle between brace and chord = 40.0 deg.

Brace 2:
Section: EN10210-1 S355J2H Grade C350

D = 100 mm
Area = 1110
f_y = 400 MPa

B = 100 mm
Sx = 6.8500E+04
fs = 500 MPa

T = 8 mm

Section bending capacity: 22.9 kN.m

Section shear capacity: 122.6 kN

Section axial capacity: 685.1 kN

Angle between brace and chord = 40.0 deg.

Overlap: 70 mm

Brace 1 overlaps brace 2.

Weld:
4 chord G=460 MPa/99 around end of brace.

MINIMUM ACTIONS NOT CHECKED

INPUT DESIGN ACTIONS:

Axial force = brace 1, N=1 = 150.0 kN (tens.)
Axial force = brace 2, N=2 = 200.0 kN (comp.)
Axial preload in chord, N=ap = 0.0 kN

Limcon V3.5 7:Examples
**Limcon V3.5**

**Engineering Systems Development**

**Section:** 14.4

**Design of Structural Steel-Hollow Section Connections**

**Page 5 of 2**

17-May-03

09:23:12 PM

---

**Max. axial force in chord, N = 0.9 kN**

*Breaking moment in chord, M = 0.05 kNm*

Using ASI 1996 notes...

**SECTION CHECKS...**

Chord section yield capacity ....... 77.7 kN = M = 0.05 kNm Pass

Brace 1 section yield capacity ....... 99.6 kN = M = 200.0 kNm 63% Pass

Brace 2 section yield capacity ....... 49.1 kN = M = 300.0 kNm 66% Pass

**BRANCH CONFIGURATION CHECKS...**

Chord normal force 1 ....... 122.0 kN

Chord normal force 2 ....... 122.0 kN

Out of balance normal force % ....... 50%

Chord axial force 1 ....... 253.0 kN

Chord axial force 2 ....... 253.0 kN

Total chord axial force ....... 253.0 kN

Brace 1 strength ....... 1.801 kN/mm

Brace 2 strength ....... 1.001 kN/mm

**NOTE:** Fall circumference of brace 1 must be faired to chord.

**GEOMETRY CHECKS...**

Configuration: RHS/RHS chord...

\[ a = \frac{h}{2} \times \sin(B) \]
\[ b = \frac{h}{2} \times \sin(B) \]
\[ c = \left( \frac{h}{2} \times \sin(B) \right) / \sin(B) = 0.42 \]

\[ d = h/6 \]

\[ E = 35 \text{ mm} \]

Overlap % ....... 55

<table>
<thead>
<tr>
<th>Brace 1</th>
<th>Brace 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.69</td>
<td>0.28</td>
</tr>
<tr>
<td>0.72</td>
<td>0.25</td>
</tr>
<tr>
<td>0.79</td>
<td>0.23</td>
</tr>
<tr>
<td>0.80</td>
<td>0.25</td>
</tr>
<tr>
<td>0.81</td>
<td>0.25</td>
</tr>
<tr>
<td>0.82</td>
<td>0.25</td>
</tr>
<tr>
<td>0.83</td>
<td>0.25</td>
</tr>
<tr>
<td>0.84</td>
<td>0.25</td>
</tr>
<tr>
<td>0.85</td>
<td>0.25</td>
</tr>
<tr>
<td>0.86</td>
<td>0.25</td>
</tr>
<tr>
<td>0.87</td>
<td>0.25</td>
</tr>
<tr>
<td>0.88</td>
<td>0.25</td>
</tr>
</tbody>
</table>

**DESIGN CAPACITY CHECKS...**

**Utilization ratio**

<table>
<thead>
<tr>
<th>Design capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>200.0 kN</td>
</tr>
<tr>
<td>300.0 kNm</td>
</tr>
</tbody>
</table>

**NOTE:** Weld checks are based on some simplifying assumptions. Please see Limcon User Manual or on-line help for details.

See Ref. 2 p.14-32.

**Brace 1 Weld:**

- Weld length for 100% overlap .... 300 mm
- Weld length for 100% overlap .... 132 mm
- Interpolated weld length .... 310 mm
- Weld capacity for specified threat .... 200.0 kN = M = 200.0 kNm 63% Pass

**Brace 2 Weld:**

- Weld force for 100% overlap .... 300.0 kN
- Weld force for 100% overlap .... 300.0 kN
- Interpolated weld force .... 330.0 kN
- Effective weld length .... 411 mm
- Weld capacity for specified threat .... 330.0 kN = M = 330.0 kNm 66% Pass

**CRITICAL LIMIT STATE...**

- Weld capacity for specified threat

**utilization ratio:**

- 1.06

Limcon V3.5axd
User-Defined Steel Grades

The grade of steel is selected for sections and plates from the drop-down list of a Grade combo box, see “Steel Grades” on p. 39. The grades available in the list depend on the Country setting in the General Configuration dialog box but all grades may be included by checking International. If you wish to include a grade that is not in the list you may define up to 10 user grades. These will be shown at the end of the list of grades and are distinguished by an asterisk in front of the grade name.

User-defined grades are specified in a file called User_grades.txt, which must be in the \Limcon\Lib folder. The format rules for the file are shown in the sample file, above.
User-Defined Bolt Categories

The bolt category is selected from the drop-down list of a Categ. combo box, see “Bolts” on p. 41. The bolting categories in the list depend on the Country setting in the General Configuration dialog box but all categories may be included by checking International. If you wish to include a bolting category that is not in the list you may define up to 10 user categories. These will be shown at the end of the list of bolt categories and are distinguished by an asterisk in front of the category name.

User1 0 0 830 664 560 560 375 375 1000 1000
User2 1 1 830 664 560 560 375 375 1000 1000

FORMAT FOR BOLTS.TXT FILE

User-defined bolt categories are specified in a file called User_bolts.txt, which must be in the \Limcon\Lib folder. The format rules for the file are shown in the sample file, above.

This facility has been used to define bolts with particular properties, e.g. anchor bolts with strength reduced by corrosion.
Index

4
4E 3
4ES 3

A
AASHTO 54
ACLT 1
Analysis method 19
Angle cleat 1
ANSI/AISC 360 6, 56, 66
AS 4100 6, 56, 66
AS/NZS 3678 40
AS/NZS 3679.1 40
Aspect ratio 20
Assumptions 46
ASTM 40
Attached plate 66
Auto check 19
Axial force 52

B
BAS 1
BASE 4, 130, 133
Base plate 4, 130, 133
Bearing pad 2
BFP 3, 105
BGP 6
Bitmap 25
BMEP 2, 54, 61, 109
BMEP B 2
BMEP C 2
Bolt bearing 79
Bolt category 18, 41
Bolt column 80
Bolt group 6, 79
Bolt row 80
Bolt tearing 79
Bolted angle seat 1
Bolted flange plate connection 3, 105
Bolted moment end plate 2, 109
Bolted splice 3, 56, 123
Bolts 19
BPAD 2
BRAC 4, 65, 127
Bracing 69, 73
Bracing cleat 4, 65, 127
BS 5950 6, 44, 56, 66
BSPL 3, 54, 56, 123
Butt weld 45

C
CAN/CSA-S16.6
Cap plate 5, 136
Check Version 28
Cheng, Yura, Johnston 52, 54
Chevron 69
CJPGW 45
Cleat 65
Color depth 14
Colors 10
Configuration 17
Connection name 8
Connections List menu 35
Connections menu 34
Copes 52
Cover plates 66

D
Data folder 15
Default data 39
Demand/capacity ratio 19
Design code 6, 18
Design type 92
Detailed output 20
Directional strength of fillet welds 45
Directories 15
Double-click 17
Doubler 61
DXF 89

E
EC3 18
Eccentricity 71
Edit menu 32
Edit section library 22
Effective length factor 70
Effective length modifier 71
Index

Elastic analysis 54
Elastic method 79
E-mail 29
Exclamation mark 9
Explorer 17
Extended moment end plate 3, 59
Extra bolts 19

F
f(n) 64
f(n') 64
Face yielding 64
Factored loads 48
FEMA-350 82
FEP 1, 101
File menu 31
File type 17
Fin plate 1, 53
Flange plate connection 3, 105
Flange plate weld 56
Flexible end plate 1, 101
Flush moment end plate 2, 59, 113
Folders 15
Fonts 16
FPBW 45
FPC 54, 105
Friction bolts 41, 43, 56
Full contact 56

G
GDI+ 20
GP 45
Grade 19, 39, 95
Groove weld 45
Gusset 65, 69
Gusset plate 65

H
Hardware lock 16
Haunched beam end plate 2
HBEP 2, 54, 61
Help About dialog box 29
Help menu 36
Hot-links 29
HSS 66
HSS 64, 76
HSS truss connections 76
HTML help 26

I
IC method 79
Installation 15
Instantaneous center method 79
Internet 29

J
JIS B 1186 42
JIS G 3101 40
JIS G 3106 40
Job menu 34
JPG image 11

K
K/N gap 5, 145
K/N overlap 5, 148
KNEE 5, 138
KTG 4, 69

L
Launch 17
Library 91
Library compiler 96
Library folder 15
Limcon website 29
Linear method 79
Linedraw.ttf 16
List All command 12
LmcReset 18
Load factor 48, 56
Logo 23, 24

M
M*o 77
M*op 77
Main toolbar 36
Maintenance 29
MEPC 2, 3, 54, 59, 113
MEPC axial load 59
Metric bolts 41
Metric units 21
Minimum actions 47, 50
Minimum loads 47, 50
Mitred knee 5, 138
Moment base plate 4, 133
MS LineDraw 16
Multiple load cases 47
Multiple row end plate 59
N
N*op 77
National annex 18
NZS 3404 56
NZS 3404 6, 27, 66

O
On-line help 26
OpenGL 10, 14, 20
Output detail level 20
Overlap 76

P
Page Setup 23
Pixel format 20
Plastic analysis 54
Pop-up help 26
Prequalified connections 82
Print preview 22
Printing in Limcon 22
Program folder 15
Prying 59

Q
Q235 40
Q345 40
Qf parameter 64

R
Registry 18
RHS bolted moment end plate 5, 62, 117, 120

S
S235 40
Screen resolution 14
SEAO 82
SEAT 6
Section category 92
Section library 19, 22, 91
Section Library Manager 94
Section mnemonic 91
Section name 91
Section properties 94
SEI/ASCE 7 48
Seismic checks 82
Seismic design checks 105
Seismic provisions 82
Serial number 29
Service loads 48
Shear lag 57
Shear tab 53
Shortcut 17
SI units 21
Sign convention 8
Simplified analysis 54
Single plate 1, 53
Size button 8
Slip critical bolts 41, 43
SP 45
Splice outer bolt row check 19
Split button 8
Steel grade 13, 19, 39, 93
Stiff seat 6
Stiffened connection 59
Stiffeners 61
Strength limit states 59
Strength ratio 48
Structural integrity tying force 52
Support 29

T
TCAP 5, 136
Technical support 29
Text file 91
Text height 90
Text size 36
Thick plate behaviour 59
Thin plate behaviour 59
TKNG 5, 145
TKNO 5, 148
TMEP 62
TMEP axial load 62
TMEP4 5, 117
TMEP8 6, 120
Tooltip 16
TX 5, 143
TYT 5, 141

U
UFBR 4, 73
Units 18, 21
US customary units 21, 41
User-defined bolt categories 152
User-defined steel grades 151
Utilization ratio 19, 48

V
V*o 77
View menu 32
Virtual reality 9, 10, 14, 20, 46

W

WAS 1
WBC 2, 54, 61
Web doubler plates 61
Web side plate 1, 53, 97
Web update 28
Website 29
Weld group 6
Weld matching 46
Welded angle seat 1
Welded beam/column 2
Welded flange plate connection 3
Welded splice 3
Welds 45
WFP 3
WGP 6
Whitmore 69
WSP 1, 53, 97
WSPL 3, 54

X

X connection 5, 143

Y

Y/T 5, 141
Yield line analysis 62
Yield stress 19